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Dear Reader,
What you are holding is the first issue of a new magazine devoted to digital photography 
and imaging. You might be thinking “Big deal—aren’t there enough magazines on the
newsstands already?” Let us explain what is different about this one, and why we feel it is
indeed a big deal.

First of all, c’t magazine has a history. Published by the Heise Media Group in Hanover,
Germany, c’t has the biggest subscriber base of all digital technology journals in Europe. 
We have built this enormous following on 25 years of thorough, unbiased, and independent
journalism. We don’t broadcast industry news but we do trust our own research, knowledge,
and experience to separate the signal from the noise and to get “our” news and reports out to
our readers. 

c’t has always covered imaging technology, and was one of the first magazines to focus on
the rapidly evolving field of digital photography. This emphasis soon led to the birth of 
c’t Digital Photography, a spin-off devoted exclusively to digital imaging and photography.
Starting out as a bi-annual magazine, c’t Digital Photography is now a trusted quarterly source
of relevant news articles, thorough equipment tests, and in-depth tutorials on cutting-edge
imaging technology applications—all geared toward both aspiring and accomplished
photographers.

For us, the next logical step was to make c’t Digital Photography a truly international 
journal—we are writing about an international market, so why not offer our expertise to an
international readership?

We have entered into a partnership with Rocky Nook—an innovative U.S. publisher dedicated
to publishing books on the developments in photography that really matter. 
Heise Media Group and Rocky Nook are convinced that their mission goes beyond just
reporting, and both are dedicated to promoting creativity, quality, and efficiency in today’s
technology-driven world.

This first issue of c’t Digital Photography is packed with valuable information that is hard to
find anywhere else, whether online or in print. Interested in new ways to use efficient LED
light sources for your small studio assignments? Want to give your images the look and feel of
good old Kodachrome 64, or the distinctly grainy monochrome look of Kodak Tri-X or Ilford
HP5? Considering a low cost alternative to Photoshop for your image editing jobs? You’ll find
answers to all these questions and more in c’t Digital Photography. You can browse it like a
magazine or study our in-depth tutorials and get the whole story by reading it like a book.

We hope that this first c’t Digital Photography will inspire you to come back and see what we
have to offer in future issues. You can get the next issue at newsstands or order it online at
www.ct-digiphoto.com

Gerhard Rossbach

Publisher, Rocky Nook
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Portfolio
Enno Kapitza has completed assignments 
for many well-known publishers and has won 
a number of prizes for his work. His portfolio 
includes both analog and digital images.

8 Enno Kapitza Portfolio

Architectural Photography 
The sheer size and immobility of buildings makes 
taking pictures of them different from other types 
of photography. Architectural photography basics 
can benefit all photographers, from advanced 
amateurs to vacation snapshooters.

18 Photographing Buildings

19 Equipment

24 Perspective Basics

26 Shooting Techniques

34 Image Processing

Perfect Portraits
Art director Thomas Saur uses detailed examples to 
give important tips on portrait lighting and composition.
He also discusses ways to get the most out of the
relationship between photographer and model.

36 Portrait Composition

40 Creating Texture with Light

42 Different Aspects of a Subject’s Personality

High-end Lenses: 
Manual versus Autofocus
Autofocus lens performance is not keeping pace with
advances in camera and image sensor technology, giving
manual focus lenses an unexpected new lease of life. 
We test a range of new and used manual lenses and
compare them with current autofocus offerings.

48 Using Manual Focus Lenses with DSLRs

54 Lens Test: Zeiss and Leica versus Canon

69 Reasons to “Go Manual”

Analog Style
Use Photoshop Lightroom to create your own individual
looks, or simply choose from the 100+ Develop Presets
included on this issue’s free DVD. We also test software
that promises to give your digital images the authentic
look of analog Ilford, Kodak, or Orwo films.

72 Create Your Own Looks in Photoshop Lightroom

84 100+ Exclusive Film Look Presets

90 Test: Analog Film Emulation Software

What’s New in Photoshop CS5 
Adobe describes the introduction of CS5 as the most
important update in the company’s history and is calling
the event a “milestone”. We grabbed a copy of the new
Photoshop release and took a look at what it can and
can’t do, and who it is aimed at. 

102 Photoshop CS5 – More than Just an Update

Analog Style   72Perfect Portraits   36
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Unleash Photoshop Elements 
Photoshop Elements 8 can do much more than you think.
There are many ways to enhance its functionality, 
whether you want to use layers, 16-bit processing, 
or additional plug-ins. And all these extras are free!

110 Get the Most from Elements 

115 SmartCurve and Elements+

119 Plug-ins for Photoshop Elements

LED Flashlight Mini-Studio
LED flashlights are the best choice if you want to set up 
a flexible and reasonably priced tabletop photo studio.
They don’t need cords, they don’t radiate heat, and they
are bright and affordable. Perfect for shooting images 
for online auctions.

122 Build Your own LED Mini-Studio

About the Magazine

3 Editorial
130 About Us

Free DVD
The free DVD includes a four-hour Photoshop
Elements video tutorial to go with the article in this
issue, and the eBook Take Your Photography to the
Next Level—From Inspiration to Image, which is full
of ideas to help you analyze and improve your
photographic technique. There are also more than
30 programs and plug-ins for you to try out and
keep, including a special c’t version of PhotoAcute
Studio 2.70. We have also included sample images
from our high-end lens test and more than 100
exclusive Lightroom Presets to get you started
creating your own analog-style film looks.

6 DVD Contents

7 DVD Highlights

5

Photoshop CS5    102High-end Lenses   48
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Special Edition

PhotoAcute Studio 2.70

Video Tutorial

Adobe Photoshop Elements 8

PDF eBook

Take Your Photography to the Next Level –
From Inspiration to Image

Image Processing Tools

Windows

Artweaver Free 1.1

Contrast Balance 1.0

Displacement Map 1.0

DragonFly’s Sinedots Shader

Eraser Genuine 1.01

Flat Median 1.3

Fotomatic 1.3v

Free Plug-ins 1.9

Gimp 2.6.10

Gimp Portable 2.6.10

Gimpshop 2.2.8

GML Matting 0.3

Harry’s Filters 3.01

HeliosPaint 1.4.3

HSL Plus 1.0

Luce 1.9a

Magic Enhancer Lite 1.0

Noise Shampoo 1.0

Outliner 2.0

PaintStar 2.70

PSPI 1.0.7

ShiftN 3.5

Sinedots II 1.03

SmartCurve 2.2

The Works Plug-In Filters 3.1v

Xero Freeware Plug-ins 5

Mac

Free Plug-ins 1.4

Gimp 2.6.10

Gimpshop 2.2.11

HeliosPaint 1.4.3

Linux

Gimpshop 2.2.11

Photo Tools

Windows

AutoStitch 2.2

AvPicFaceXmpTagger 1.7

CombineZP

FastStone Image Viewer 4.2

FastStone Image Viewer Portable 4.2

Hugin 2009.4.0

i-Fun Viewer 8.0

Image Inc. 1.2

MobaPhoto 1.42

Panorado Flyer 1.2.1.19

Photomapper 0.7

PhotoRec 6.11.3

PhotoWipe 1.20

Mac

Hugin 2010.0.0

PhotoRec 6.11.3

Linux

Hugin 2010.0.0

PhotoRec 6.11.3

Sample Images 

Manual Lens Test: c’t Studio Test Images

Manual Lens Test: Sample Outdoor Images

Film Looks

100+ Film Look Presets
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DVD Contents

One way to significantly reduce digital
image noise is to take multiple shots 

of your subject and to merge them into a
 single, lower-noise image or to a single 
image with higher resolution than the original
pictures. The program can also produce still
images from multiple video frames.

The program is easy to use: Simply drag
your source files to the program window, click
the Start button, and choose which  functions
you want to apply.

You can choose between reducing noise,
 increasing resolution, or aligning and cropping
your images for processing using a  different
HDR program. The program also  includes
 options for focus stacking, removing unwanted
moving objects, and adjusting the degree to
which images are rotated and  cropped during
alignment.

PhotoAcute also corrects lens distortion for
a wide range of cameras and lenses. Once you
have selected the appropriate settings, you can
output the results to JPEG or DNG files. 

The manufacturer is offering a 15 percent
discount if you purchase the latest version of
the program before 12/31/2010. The license
 includes updates for a 12-month period. (keh)

Author George Barr has been taking photos
for over 40 years. This book is the cream

of over 500 articles written during that time on
the process of becoming a photographer.

Barr recommends honing your seeing skills
by studying the work of exceptional photo -
graphers. He discusses the individual elements
of an image, and goes on to discuss more than
a dozen of his own shots, detailing why he
chose a subject and the kind of emotional
 impact he wanted to achieve. The book also
deals with finding subjects and choosing the
ideal viewpoint. The author analyzes a real
shoot, and shows us some of the intermediate
results that led to a final print. 

The section on composition uses sample
images to detail the process of finding the right
lines and pinpointing the center of interest.
Barr is convinced that you should spend just as
much time framing as you do composing your
image. 

The author concludes by discussing how to
analyze your level of skill and your results, and
offers specific advice on how to improve
those skills. He also gives tips on where to find
expert advice and forums for exchanging
 information. (keh)

The tutorial begins by showing you how to
import, save, organize, and retrieve image

files using the program’s built-in tools. 
The bulk of the tutorial concentrates on

optimizing and adjusting images using 
the Organizer, Quick Fix mode, and Full 
Edit mode. The individual sections detail 
highlight and shadow correction, noise
 reduction, and lens error corrections. There is
also a section on working with Layers, and
 detailed tips on workspace configuration and
image resizing.

The tutorial discusses the principles and
practicalities of RAW image processing, inclu-
ding white balance, color, and tone adjust-
ments. The Photomerge Panorama, Group
Shot, and Scene Cleaner tools are also discus-
sed in detail. A further section deals with using
filters, layer effects and layer styles.

The final section covers the program’s out-
put options, which include printing, mailing,
and sharing on the Web. Users also learn how
to publish their creations in a photo book and
how to create custom frames. 

The Flash-based tutorial is Windows and
Mac-compatible and includes material for
 playback on iOS and GP3-based devices. (keh)

PhotoAcute Studio
2.70 Special Edition

PhotoAcute Studio 2.70 creates 
low-noise, high-resolution (HDR)
images from multiple source images,
removes unwanted objects from
panorama overlaps, and corrects
various types of lens distortion.

Take Your Photography
to the Next Level

Don’t just take a picture of a truck.
Make an image of a truck!“ From
inspiration to image—George Barr’s
book helps advanced photographers
find ways to improve their technical
and aesthetic skills. 

Video Tutorial:
Photoshop Elements 8

This four-hour video tutorial
by video2brain explains the
entire image manipulation
and management workflow
using the Adobe Photoshop
Elements software package. 

DVD Highlights
The DVD’s many highlights include a c’t special edition of PhotoAcute
Studio 2.70, a four-hour video tutorial on Photoshop Elements 8, 
and the PDF eBook Take Your Photography to the Next Level.
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Portfolio

Portfolio 

Enno Kapitza
Born in 1969 to German/Japanese parents, Enno Kapitza grew up in
Japan and Germany. His multi-ethnic background strongly influences
the aesthetics of his photographic work.

He began his career as a freelance photographer in 1995 after
graduating from the State Academy for Photo Design in Munich. 
Since then, numerous jobs for noted magazines and various prizes have
proved that he made the right career choice. Although he grew up in
the analog era, Kapitza risked a mid-career switch to digital shooting.
His portfolio includes both digital and analog images.

Enno Kapitza lives with his wife and two children near Munich.



This image was taken in a tiny pool at a health
spa in Tuscany. The muddy brown water contrasts
wonderfully with the little girl’s skin.
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I took this shot of a shelf full of silicon dolls in the apartment of a certain Mr. Tabo—a doll fetishist who owns more than
50 such “toys”. Each is life-sized and costs about $5,000. When I first entered the apartment, I felt as if I was walking into
a morgue. The floor was slippery from the baby oil Mr. Tabo uses to keep his dolls supple.
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This is Bernhard Hane, who is the chief development officer at Playmobil, the manufacturer of the famous toy figures.
This opportunity presented itself while we were touring the company’s warehouse—I simply couldn’t resist using all the
toys that were lying around to frame my portrait.



An Interview with

Enno Kapitza

Thomas Saur: What role does technology play
in your photography?

Enno Kapitza: Professional creative work that
utilizes cameras and artificial light sources
 requires you to be thoroughly familiar with
the capabilities and limits of your equipment.
Now that analog film is all but dead, photo-
graphers have to know how to use RAW
 converters and image processors (such as
Photoshop) to achieve their aims.

Saur: How has the switch to digital media
 affected your day-to-day work?

Kapitza: The rapid developments that have
taken place in the digital world in the last
two or three years represent an enormous
challenge. I spent more than a decade wor-
king exclusively with analog equipment and
developed most of my color prints in my
own darkroom. Today, I realize that my tech-
nique and my visual language were both

heavily influenced by the nature of the
 medium. Composing an image in your mind
is a much broader-based and more self-suffi-
cient creative process than checking a tiny
monitor image on the back of a camera. Back
then, the image editing process began in my
memory before the processed films came
back from the lab but now, my daily routine
of editing images and meeting client dead-
lines feels as if it has accelerated ten-fold.
Clients simply assume that I will use all the
technical aids available to save time and
money—a situation that is compounded by
the additional assumption that, because
they are “digital”, these processes don’t actu-
ally cost anything. I spend much more time
and money producing digital images than 
I ever did producing analog work. Only a few
of my customers genuinely appreciate and
honor the costs of producing high-quality
 digital images.

But the digital medium has advantages too. I
no longer have to make time-consuming
scans of analog images, and I save a lot of
money on film when I am working on my
own projects. And I can now change ISO
speeds from one shot to the next without
 having to swap out the entire roll of film.

Saur: Which shoots have made the most
 lasting impressions on you? 

Kapitza: I was lucky enough to be granted a
private audience with the Dalai Lama together
with a journalist friend during a job documen-
ting Tibetan medicine in India. His entourage
was of the opinion that enough photos of him
already exist, and that I should limit myself to
using up just two minutes of his precious
time—if His Holiness was prepared to be pho-
tographed at all. In the end, the Dalai Lama’s
interest in technology made it possible for me
to take an unusual photo of him: I had a ring
flash attached to my camera, and he asked me,
“What type of flash is that? I think I will have to
take my glasses off so that it doesn’t cause
 reflections.” A year later, I had a second chance
to photograph His Holiness, this time for GEO
magazine, and I was very impressed and flatte-
red to find that he remembered me from our
previous meeting.

Saur: You have enormous experience of photo-
graphing famous people. Which key aspects of
your work would you most like to share with
our readers?

Kapitza: The most important thing is to use
the available time effectively, and to remain
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Portfolio

The pianist Lang Lang at the 
Steinway piano showroom in Munich

The comedian Gerhard Polt, photographed in his apartment 
in Schliersee, Bavaria. He thought I was working for the 
local “What’s On?” magazine but in fact, I was shooting for
Volkswagen’s customer quarterly.



self-confident but polite while trying to
 respect the wishes of the person you are
 photographing. It is important to prepare
thoroughly for opportunities that often last
only a few minutes, so take time to speak to
your subject’s PR people, to find the right
 location, and to set up your gear properly.
During a shoot, it is important to keep cool,
to adapt to the mood of the moment, and to
improvise if necessary.

Saur: I found the photos of the former child
 soldier, the comedian Gerhard Polt, and the
Mongolian boy the most striking in your  port -
folio. What are the stories behind these images?

Kapitza: I came across the  former child sol-
dier in northern Uganda, sitting in the shade
of a tree at midday. The ambient light was
fantastic, and I used my medium format
 camera and a standard lens to get up close. I
was using 6x7 film and I set my 110mm lens
to f2.8. My reflection makes his pupils look
like cat’s eyes.

I photographed Gerhard Polt using available
light. I was shooting in winter, but the snow
outside reflected the sunlight evenly throug-
hout the room. There was very little contrast
between his face and the window behind

him, so I used a wide aperture to emphasize
the contours in his face against a blurred
background.

I took the picture of the Mongolian nomad
boy during a shoot for Stern magazine. I was
due to photograph the Mongolian president,
so I had my portable flash kit with me. I used
a translucent umbrella to create a film-like
scene that shows little contrast between the
subject and his surroundings..

Saur: Tell me about one of your more 
difficult jobs.

Kapitza: I was shooting a story about the love
life of the Japanese for Stern. I spent two
weeks in Tokyo with a journalist and an inter-
preter shooting day and night. It took us a
long time to find the right subjects, and we
ended up taking all of the most  important
photos in the final two days of the shoot,
 including the ones of Mr. Tabo and his dolls.

Saur: What do you like most about your job?

Kapitza: I like the independence and the
 opportunity to meet people and get into new
situations, whether I am shooting portraits or
for a documentary job. My camera is like a
magic key to the world.

Saur: And what do you dislike?

Kapitza: My job is personally fulfilling and
enriching, so negative feedback hits hard.
The field of photography in general is
changing too fast at the moment.

Saur: What makes a great photo?

Kapitza: A great photo is moving and awa-
kens your curiosity. If you are working to a
specific brief, a great image is one that fulfills
that brief.

Saur: To finish, please give us a short rundown
of your career.

Kapitza: I only started taking photographs
once I had finished my national service, but
from then on everything developed very
quickly. I finished my studies at the Academy
in Munich in 1995 and immediately started
work for various magazines, including Stern,
GEO, Sueddeutsche Zeitung, and Monocle, 
as well as for a number of industrial clients.
You can also find my work in various books
including Taschen’s Contemporary German
Photography and Made in Germany and my
 latest coffee-table book documenting a
recent tour by the punk band Die Toten Hosen.
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Portfolio

A morning shot in the Mongolian steppe. The nomads often allow themselves to
be pulled along by their horses, which is why their boots are curved like skis.

Four synchronized swimmers from Uzbekistan at 
a contest in Liechtenstein. I got them to perform
one of their moves on dry land and tried my best
to capture their infectious good mood.
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Portfolio

I spent two days in the wilds of the Mongolian steppe during a shoot for Stern
magazine. I used my portable flash kit to take this portrait with its film-like feel.

This man used to be a child soldier. I found him sheltering
from the midday sun under a tree in northern Uganda. 

The ambient light was wonderful and I used a medium format
camera fitted with a standard lens to get up close.
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Portfolio

I took this portrait of the Dalai Lama during a private audience in Dharamsala 
in India in 1998. His Holiness had just finished giving a public audience to 
300 people. His presence is formidable and made this a fantastic moment for
me, both personally and professionally.
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This is the key photo in a documentary job covering Tokyo Narita airport 
for Greenpeace magazine. The image shows a Boeing 767 flying over a Shinto
shrine while coming in to land. This shrine is the last stronghold of protest
against the building of a new runway.
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Adrian Schulz

Photographing

Buildings
The sheer size and immobility of buildings makes taking pictures of them fundamentally
different from all other types of photography. A successful architectural photo depends
just as much on the photographer’s creativity and visual interpretation as it does on the
building itself. Knowledge of the basics of architectural photography can be of just as
much benefit to advanced amateurs as it can to snapshot photographers on vacation.



Choosing a System

Your personal priorities will influence your
choice of camera system. Some photogra-
phers prefer to use a light, portable camera,
some spare no expense in their search for op-
timum image quality, and some are simply
not prepared to spend excessive amounts of
money on a hobby.

Due to the significant costs involved, we
won’t discuss digital backs for medium for-
mat and specialty cameras. This article cen-
ters on the fast-evolving, full-frame digital (or
“FX”) format, which is the most flexible soluti-
on for demanding architectural photogra-
phers. The format’s large image sensors pro-

vide a broad dynamic range and allow you to
use the full image circle of ultra-wide-angle
and tilt/shift lenses designed for use with
35mm analog cameras.

For those on a more limited budget, DSLRs
with smaller image sensors are also capable of
producing high-quality architectural images.
Many analog enthusiasts still use 35 mm, me-
dium format, or expensive-to-run, large format
cameras. 

Neither analog nor digital compacts are
suitable for architectural photography due to
their limited wide-angle capabilities, non-in-
terchangeable lenses, and often inadequate
image quality especially at the edges of the
frame.

Lenses

The lens you use determines the angle of
view, the depth of field, the image sharp-
ness you can capture, and the minimum
shutter speed you can use. Lenses also pro-
duce various types of optical errors. The
most important aspects of lens performance
in an architectural context are image quality
and focal length. 

Image Quality

Lens manufacturing processes have changed
to meet the demands of digital image sensor
technology, but even the most expensive

19c’t Digital Photography 1 (2010)

Architectural Photography | Equipment

Equipment 19 

Perspective 24

Shooting Techniques 26 

Image Processing 34

Contents

Typically, this compact camera’s limited dynamic range causes 
burned out highlights in the sky that cannot be corrected during 
image processing

Cameras with broader dynamic range can capture high-contrast
situations in a more balanced fashion, and provide you with tonal 
value reserves for making subsequent image adjustments

Equipment
Great photographers require only simple cameras to make great images,
and using complex, expensive technology doesn’t automatically produce
great results. Nevertheless, making sure your equipment suits your
individual style will make your work easier and will help you to produce
satisfying results.



lenses nevertheless produce some optical
 errors. Many camera/lens combinations can
automatically compensate for some types 
of lens errors, but others remain visible in 
the final image. The most common types 
of image error are vignetting, chromatic
aberrations, distortion, and edge blur (see the
illustrations above). 

Architectural photos generally require you
to stop your aperture down (see the section
on Camera Settings below), making lens per-
formance at wide apertures less of an issue.
Small apertures also reduce the prevalence 
of many common lens errors, but it is difficult
to completely avoid producing chromatic
aberration or edge blur. Color smears can
usually be effectively eliminated during
image processing, but the edges of an image
often remain less sharp than its center. This
effect is especially prevalent in images shot
using ultra-wide-angle or cheap lenses.

Lens-based distortion occurs indepen-
dently of the selected aperture, and pin-cus-
hion and barrel distortion are especially pre-
valent at the extreme ends of a zoom's range.

This makes it important to leave enough free
space around your subject for subsequent
correction of potential distortion problems.

Remember: high-quality lenses with high-
end error correction are usually expensive. An
expensive lens on a cheap camera will usually
produce better results than an expensive
 camera used with a mediocre lens.

Focal Length

In order to capture the widest possible angle
of view, architectural photographers usually
use only wide-angle or ultra-wide-angle
 lenses—i. e., those with an equivalent focal
length of 24 mm or less and a diagonal angle
of view of more than 84 degrees

If all buildings simply stood on open
ground, you could move freely around them
and use a single, mid-range wide-angle 
lens to photograph them. In reality, we are
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Typical optical errors—Top left: vignetting (circular shadows at the edges of the frame). Top right: chromatic aberrations cause color smears 
at the edges of shadows. Below left: this enlarged detail displays obvious edge blur. Below right: this image shows obvious barrel distortion.

Ultra-wide-angle lenses such as this 
Canon EF 14mm f/2.8 L USM cost 
around US$ 2,000 and are perfectly 
suited to architectural applications



 limited in our choice of camera positions 
by the other buildings and infrastructure
that surround our subjects. In urban situ -
ations, we can only position our camera on 
the streets or plazas that surround the  target
building. The best potential camera positi-
ons are usually unreachable and street 
signs, street lamps, or cars often spoil 
the composition. The only way to remain
 flexible is to get nearer to a building and use
an appropriately short lens. Lenses with

equivalent focal lengths of between 20 mm
and 35 mm are generally suitable for exte-
rior shots, while lenses in the range between
14 mm and 24 mm are best for shooting
 interiors.

Tilt/Shift Lenses

These special lenses are capable of shifting
the optical axis in relation to the image
 sensor plane and thus help you to adjust

perspective during shooting. Such lenses
are a useful, but not essential, addition 
to any architectural photographer’s equip-
ment. They help you to avoid producing
converging lines in your photos, which in
turn reduces the need for subsequent image
processing, with its associated loss of image
quality.

Shifting the optical axis of normal lenses
would lead to obvious vignetting effects.
Shift lenses produce a larger image circle
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Focal length range: exterior shots are best taken
using lenses with focal lengths between 20 mm and
35 mm. Wider lenses (between 14 mm and 24 mm)
are better for photographing interiors.

Views shot using various shift lenses and lens attachments, from left to right:  17 mm shift lens, 24 mm shift lens, 
35 mm medium format lens with a shift adapter, 55 mm medium format lens with a shift adapter. All of these images
were shot using a full-frame DSLR and each was shot from a different position in order to produce similar-sized results.



and can allow you to shift the optical axis by
as much as 12 mm without causing adverse
effects in the resulting image. The con-
struction of tilt/shift lenses makes it impossi-
ble to incorporate autofocus mechanisms,
but this is not a major disadvantage. 

They also make composing your image
easier, as you can frame your image more
precisely from the start. Shift lenses are 
also useful for making multi-shot panorama
images (see the section on Shooting Techni-
ques on page 26)

Medium format lenses, with their large
image circles and wide mounting flanges,
are a useful alternative to conventional shift
lenses and can be attached to normal DSLRs
using special adapters. But here, too, there
are limits to the range of lens movements
you can make and the camera’s mirror box
will always impinge on the image at some
point.

Camera Settings

Shutter speed plays a secondary role in
 architectural photos due to the static nature
of the subject. As long as you shoot using a
tripod, you can use just about any shutter
speed you like. 

We recommend using small apertures to
help reduce the effects of lens errors in your
images. If you select an aperture value that 

is too large, you run the risk of producing
blur due to refraction in the light path.
 Aperture values between f8 and f11 usually
produce  satisfactory results. Due to the com-
bination of wide-angle lenses and long sub-
ject distances, selective focus effects (produ-
ced using large apertures) are seldom used
in architectural photos, but they can never-
theless be used to deliberately focus or
 defocus specific parts of a building for artistic
reasons.

Shooting using low ISO values helps keep
image noise to a minimum while producing
maximum dynamic range, which provides
you with more creative headroom when pro-
cessing your images later on. Always shoot in
RAW format if you can.. 

Accessories

Using a tripod is the best way to take
 advantage of the static nature of buildings.
A tripod allows you to use virtually any
 shutter speed and also to take your time
composing your image. You can also choose
exactly the right moment to release the
shutter once any clouds, people, cars, or
other image elements are in suitable positi-
ons inside or outside the frame. You can, 
of course, shoot architectural shots hand-
held, but a tripod nearly always makes
things easier.

Use a heavy tripod with excess load capa-
city—this helps to avoid camera shake due
to wind or other external influences. This is
especially important if you are making multi-
ple shots for HDR or panorama images, as
here, the smallest unintentional changes in
composition can spoil your results.

The tripod head is just as important as the
tripod itself. There are various types available,
including ball heads, three-way tilt heads, and
fluid heads. Ball heads can be adjusted quickly
and universally with a single movement, while
tilt head settings are easier to fine-tune. The
system you choose will depend on your per-
sonal taste and working methods, but avoid
using a cheap tripod at all costs. There is not-
hing more frustrating than discovering later
that your tripod head shifted a millimeter or
two while you were shooting. 

A quick-release plate attached to your
camera makes mounting and unmounting
your camera quick and easy. Nowadays, most
quality tripods have their own built-in quick-
release mechanisms. The Arca-Swiss quick-
 release system has established itself as the de
facto standard in professional photographic
circles. If you like to shoot in portrait format, it
is worth investing in a high-quality L-plate
that ensures that the center of gravity of 
your camera remains directly above the
 tripod head, even when it is rotated through
90 degrees.
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A medium format lens attached to a
conventional DSLR using a shift adapter

A quality L-plate is not
cheap, but ensures that the
camera’s center of gravity
remains located directly
above the tripod head



Creative Tips

One way to creatively enhance your archi-
tectural shots is to convert them digitally to
black-and-white. Monochrome images offer
more room for creative interpretation and can
be made to appear more abstract, as different
colors can appear identical when they are
converted to grayscale. Architectural images,
with their broad surfaces and fine textures,
are perfect for experimenting with this type of
effect. Black-and-white images are becoming
increasingly popular due to their exclusive
look, which can be further enhanced by ad-
ding grain effects. Grain effects are often used
deliberately as an artistic device in both ana-
log and digital images. And by the way: most
home printers produce better black-and-
white prints than online print services.

Lensbabies are specially designed for
creative use. Their flexible lens barrels allow
you to create various selective focus effects in
a similar way to a tilt/shift lens. This way, you
can select a specific focus “sweet spot” within
your image, leaving the rest of the frame

blurred. Lensbabies are squarely aimed at the
artistic market, and are not constructed with
high optical quality in mind.

Fixed focal length lenses are not as flexi-
ble as zoom lenses, especially considering
that their major advantage lies in their wide
maximum apertures—a feature that only
plays a secondary role in architectural photo-
graphy. However, using just one or two fixed
focal length lenses forces you to consider
your camera position and composition more
carefully and turns a shoot into an interesting
challenge. Many adapters are available for at-
taching older, manual focus lenses to today’s
digital cameras.

Neutral Density filters reduce the
amount of light entering the lens, allowing
you to artificially extend your shutter speed.
You can use this effect to create deliberate
motion blur in your architectural shots, even
in bright ambient light—this is useful for re-
ducing the prominence of cars or people in
your images. Moving objects also help to
make images of otherwise static subjects look
more dynamic and artistic.
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“Real” analog or digital black-and-white effects emphasize shapes and textures,
giving an image a highly individual feel

A neutral density filter extends shutter
speeds and helps to portray people, 
cars, or other moving objects in a blurred,
abstract fashion—even in bright light

Architectural Photography | Equipment



Perspective

A photograph transforms and projects three-
dimensional space into a two-dimensional
image according to the rules of perspective.
A photo generally presents us with a natural-
looking image by following the rules of vanis-
hing point perspective. 

Camera position and camera angle alone
determine perspective, and the only way 
to alter the spatial relations within an image
is to alter the camera position. Many people
assume that the focal length of the lens 
also affects perspective, but this is simply
not true.

Vanishing Points

Vanishing points play an important role in
the portrayal of architectural (i. e., geometri-
cal) forms. All parallel lines that meet in the
distance will intersect at the so-called “vanis-
hing point” in a two-dimensional image. If
you point your camera directly at the horizon,
all the vertical lines within the frame will ap-
pear vertical in your image. This is an effect
that we often utilize when photographing
buildings. 

The number of vanishing points in an
image has a significant effect on its appea-
rance. In the case of one-point perspective, all
third-dimension parallel lines converge to a
single point in the center of the horizon. This
effect is nicely illustrated by the image of the
Reichstag building in Berlin (top right). 

You need to stand directly in front of
your subject and position your camera hori-
zontally (and pointing at the horizon) to
take pictures like this. This means that the
front wall of the building you are photo -
graphing remains parallel to the image
 sensor plane, which keeps all the parallel
lines within the building’s façade parallel in
your image. This type of photo is pleasing
but unspectacular, and doesn’t adequately
illustrate a building’s huge, three-dimensional
volume.

Two-point perspective, which furnishes an
image with two separate vanishing points on
the horizon, is equivalent to photographing
a building from a corner rather than head-on.
Here too, the camera has to be positioned
horizontally, but in this case, only vertical
lines appear parallel in the resulting image.

Two-point perspective images have a vivid,
dynamic appearance that clearly illustrates
the volume of a building but isn’t necessarily
suitable for all situations.

Images shot from a frog’s-eye perspective
(from below) or from a bird’s-eye perspective
(from above) usually have three vanishing
points. Here, the camera is no longer pointed
at the horizon but instead at an imaginary
point above or below the horizon. These
types of perspective come into play when
conventional camera positions no longer
allow you to capture the entire subject wit-
hout tilting your camera. In this type of
image, vertical lines also converge to a point
above or below the horizon.
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Perspective Basics
Geometrical forms are more prevalent in photographs of buildings than 
in any other type of image. This makes basic knowledge of perspective
essential if you want to shoot successful architectural photos.

Two-point perspective (here shot from a corner of the building) produces more dynamic results

One-point perspective, with its central vanishing point, produces harmonious-looking images



Converging Lines

Converging lines don’t bother us when 
we are walking along a street, due to the
close cooperation between our sense of
 balance and our visual perception. However,
things look different when we view  con -
verging lines in two-dimensional images, as
our brain immediately signals that some-
thing is wrong. Converging lines, such as the
ones in the image of a glass-walled courty-
ard on the next page, tend to confuse the
viewer and produce a jarring impression of
the building. This effect sometimes makes
buildings look as if they are tipping over
backwards. n unwritten rule dictates that ar-
chitectural photographers generally try to
keep vertical lines vertical in their images.
Converging lines can nevertheless be used
deliberately to add drama or artistic impact
to an image.

Camera Position and 
its Effects on Perspective
Different camera positions produce images
with differing effects. For example, if 
multiple objects are all positioned a long
way from the camera, the distance between
the objects themselves will appear foreshor-
tened. The partially demolished (former)
East German Palace of the Republic illustra-
ted here appears to be located directly 
next to the Berlin cathedral (on the right). 

In reality, these two buildings are a large
 distance apart.

If the camera is positioned very close to
the subject, objects in the foreground will
 appear much larger than they actually are 
in relation to objects in the background.
 Spatial relations appear stretched. Experi-
enced photographers use these types of

 effects deliberately to emphasize certain
aspects of a building’s construc tion. A building
looks static and solid if it is pho tographed
from further away, but can appear much
more dramatic if it is photographed from
close-up. The three images here show clearly
how different a building can look when shot
from distances that only vary a little.
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Frog’s-eye and bird’s-eye perspectives are
used to photograph buildings that cannot
otherwise be captured in their entirety. 
The result is strongly converging lines.

Large subject distances compress perspective. 
The two buildings shown here are, in reality, a long way apart.

Human visual perception compensates for converging lines when we
view buildings in the real world. Converging lines can, however, spoil
the effect of a two-dimensional image. Correcting the image digitally
produces a pleasing, realistic-looking effect.



It is important to develop a feel for the
 spatial relations between objects when you
are photographing buildings. You can save
yourself a lot of time and trouble if you 
are able to estimate which shooting angle
will produce the best results before setting
up your gear. Grass-roots photographic
knowledge is essential, especially if you
want to avoid producing images with
 converging lines.

How to Avoid Converging Lines

Increase the subject distance: if the
 situation allows, simply move back and use
a longer lens to reframe the subject. This
simple measure can help to partially or even
completely eliminate converging lines if 
you are careful to point the optical axis 
of your lens directly at the horizon. You can
fine-tune any remaining anomalies later on
your computer. Unfortunately, there is often
not enough space near a building to get 
far enough away. The greater the distance
between camera and subject, the greater
the risk of other objects getting in the way
and spoiling your composition. Increasing
the subject distance also compresses
 perspective.

Use a raised camera position: a camera
position halfway up the subject helps to stop
vertical lines from converging. Make sure
your camera’s image sensor is set up parallel
to the front of the subject building. You will,
of course, need access to a bridge, a pedestal,
or the upper floors of a building in the vicinity
to make use of this technique.

Use a short lens and shoot in portrait
format: if you have to shoot from extremely
close, it can help to use a wider-angle lens
than would otherwise be required to make
your shot. Simply set your camera up in
 portrait format parallel to the ground. The

 resulting photo will not contain any conver-
ging lines, but the subject will appear at the
top of the frame and large portions of the
ground in front of the building will be visible
in the lower part of the image. This imbalance
is  easily corrected by cropping the image
later, but produces a smaller finished image
with a non-standard format.

Digital perspective correction: a simple
technique for correcting converging lines is
to deliberately distort your image using
image processing tools. You can correct con-
verging vertical lines by stretching the upper
corners of your image outwards to form a tra-
pezoid and then stretching the entire image
upwards to counteract the compression ef-
fects this produces. This technique requires
the computer to create artificial image data
in the upper portion of your image and
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Shooting Techniques
Once you have developed a feel for situations and their characteristics,
you will be able to start taking exceptional photos. Some photographers
find it quite easy to pick the most interesting shooting angle, while others
start a shoot with a specific idea of the required result in mind. Whatever
your level of expertise, you can always improve your ability to see the
photographic potential in a scene. The following sections offer a few tips
and tricks to help you get the most out of your architectural photo shoots.

It is important to have an idea of
your ideal camera position before

you start to set up your gear. I had
to walk several hundred yards to 

get into position for this shot 
of the television tower and
Oberbaum Bridge in Berlin. 



quickly reaches its technical limits if the lines
you want to correct converge too strongly. It
is always preferable to avoid shooting con-
verging lines by using the other techniques
described above.

Use a tilt/shift lens: this is the best, but
also the most expensive way to produce ori-
ginal images without converging lines. If you
have access to a tilt/shift lens, you will have
less fine-tuning to do at the post-processing
stage.

How to Use a Tilt/Shift Lens

Proper use of shift lenses requires some
know-how. We recommend the following
method: position your camera with its image
sensor exactly parallel to the front of the buil-
ding and set focus with your lens in a neutral
shift position. Here, loupe and live view
functions are helpful (if your camera has
them). You should also meter exposure at
this stage, as your camera’s metering system
will no longer deliver accurate results once
you have shifted the optical axis of the lens.
Alternatively, if your camera allows, you can
also judge exposure using the live view
function with the mirror locked up. You can
now shift the optical axis upward, making
parts of the subject that were previously out-
side the upper edge of the frame visible in
the viewfinder.

The camera and lens remain in a hori -
zontal position. This technique produces an
image with no converging lines and can be
performed in exactly the same way in the
opposite direction (i. e., moving the optical
axis downward in order to photograph
lower portions of a building). Most shift
 lenses also allow you to shift the optical axis
sideways.

Using shift lenses always produces a cer-
tain amount of vignetting and corner blur at
the extreme ends of the shift range, so avoid
using the maximum shift settings if you can.
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Shooting with a shift lens: The camera
is positioned parallel to the building

at a neutral shift setting. Shifting the
optical axis upward moves the horizon

downward and includes previously
hidden details in the top of the frame.

Using a shift lens is the most elegant,
but also the most expensive way to

avoid shooting converging lines



If your lens doesn’t provide sufficient shift,
you can also tilt the camera slightly to increa-
se the shift effect, which keeps digital cor-
rections—with their inherent loss of image
quality—to a minimum.

You can also use a shift lens to create
 panorama images by taking a sequence of

shots at different shift settings. If you do this,
make sure that you shoot sufficient overlap
at the edges of each image to allow you to
merge them effectively later on. Popular
 panorama formats include two landscape
 format images merged to form a 5:2 “wide -
screen” image and three portrait format

images next to each other, producing a 4:3
result. You can also shoot more complex
 sequences by rotating the shift mechanism
through 30 degrees during shooting, i.e., you
shoot top left and bottom right, rotate, and
then shoot the top right and bottom left
images, producing a 3:2 image.  Merged
images not only increase your angle of view,
but also dramatically increase the resolution
of the final image.

Converging Lines 
in Indoor Scenarios
Converging lines are less of a problem in inte-
rior scenes, as image height and the height of
the space you are photographing are usually
more similar than they are outdoors. In in-
door situations, there are usually no signifi-
cant details to be found above the upper
edge of the frame, making it easier to keep
the camera parallel to the floor, and to avoid
converging verticals. Converging lines in in-
terior shots are even more unsettling than
they are in outdoor scenes.

Selecting Your Camera Position

The ideal shooting position depends on the
type of building you are photographing, its
size, and the nature of its immediate surroun-
dings. Your own concept for the finished
image will also play a role in your choice of
camera position. The position of the church
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The simplest way to avoid shooting converging lines is to increase the distance between
camera and subject. This is, of course, easier said than done in urban situations.

Here, a raised camera position and horizontally-oriented camera have produced 
a pleasing image with no converging verticals

Using an over-wide lens in portrait format
also eliminates converging vertical lines,
but produces an unbalanced composition
that requires subsequent cropping



between skyscrapers in the photo on page 29
is a good example of an effective composition.

If the depth of the space you are portray-
ing is important to the end result, position
your camera as close to the subject as possi-
ble. If, on the other hand, you want to produ-
ce a realistic-looking, documentary shot, you
will need to shoot from further away in order
to avoid producing extreme perspective ef-
fects.

Extreme subject distances can produce
unrealistic perspective effects or cluttered
images, but can nevertheless produce dyna-
mic-looking images if used deliberately as a
compositional tool. 

The rule of thumb for exterior architectu-
ral shots recommends a shooting distance of
one to three times the height of the building.

In order to produce realistic-looking
images in indoor situations, you will often
have to shoot backed up against a wall 
or from a suitable passageway. The most
 effective interior shots portray space in a
tactile fashion and often include views into
other rooms.

The Relation between Focal
length and Camera Position
Focal length and your choice of camera posi-
tion are closely related, but are still a matter
of personal taste. Some photographers choo-
se a specific camera position and then select
a suitable focal length lens, while others pre-
fer to use a particular lens and then move the
camera in order to achieve their desired com-
position. The latter approach is not usually a
problem if you are shooting alone, but can
cause friction if you are on vacation with a
partner! Zoom lenses make it possible to ad-
just your angle of view without changing
your position.

Long lenses are not often appropriate for
photographing entire buildings, but their
narrow angles of view do produce blurred
backgrounds that effectively emphasize de-
tail in the structure of a building, or accent
textures against a uniform background, such
as the sky. 

Telephoto lenses can also be used to
make buildings that are a long way apart 
to appear closer together than they are in
reality. 

Medium wide-angle lenses with equiva-
lent focal lengths between 24 mm and 35

29c’t Digital Photography 1 (2010)

Architectural Photography | Shooting Techniques

Buildings themselves are generally copy-
righted objects, but can usually be freely
photographed if they are visible from

 public places. Make sure you have the
 correct permissions before starting an
 exterior or interior shoot.

General Information

The ideal camera position for a 
shot depends on the situation and 

the photographer’s concept for 
the finished image 



mm produce realistic-looking photographs of
buildings and are among the lenses used
most frequently in architectural situations.
Ultra-wide-angles come into play if the pho-
tographer is extremely close to the subject or
is shooting in cramped indoor conditions.

Short focal length lenses make it possible
to take photos in places that medium-length
lenses simply don’t allow, but can produce
over-dramatic or unrealistic-looking per-
spective, especially in photos shot from
close-up. You can, of course, use these effects

deliberately to produce artistic or unusual ef-
fects in your images.

Be careful if you are using an ultra-wide-
angle lens for the first time. Even the smallest
horizontal deviations in camera position pro-
duce strongly converging lines, so keep an
eye on your exact camera position at all
times. Using a heavy, high-quality tripod will
help here.

Fisheye lenses are seldom used in an ar-
chitectural context because they always pro-
duce extreme barrel distortion. Fisheye len-
ses produce great effects for occasional crea-
tive use, but quickly lose their appeal if they
are over-used.

Shooting conditions
The success of most architectural photos de-
pends on how you handle a given situation,
yet photographer can only influence general
shooting conditions to a limited extent. The
most important external factors that an archi-
tectural photographer has to deal with are
shadows and reflections.
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Here, using a telephoto lens highlights details of the
building’s structure against the uniform background

Long lenses make buildings that are physically
far apart appear closer together

An example of the dynamic type
of image you can produce using
ultra-wide-angle lenses



Shadows and Reflections

Architectural photographers have to deal
with shadows cast by the subject itself as well
as those produced by other objects (see the
illustrations on the next page¥). Both types of
shadow are usually caused by light from the
sun. A building’s own shadow is always found
on its indirectly lit side. The edge of the sha-
dow—indicated by the dotted red line in the
illustration—also defines the edge of any
shadows cast on the building by other ob-
jects. These can distract the viewer from a
building’s aesthetic effects and make correct
exposure metering more difficult (see also
the illustrations at the bottom of the next
page).

On the other hand, hard shadows can
also be used as a compositional tool. Small
shadows cast by protruding or recessed
 features form an integral part of the façade
of a building..

Things get more difficult when the sun is
behind you, as this can cast an additional sha-
dow of the photographer and/or the camera
into the frame. If this is the case, try to positi-
on yourself within the building’s own shadow
or a shadow cast by another object. As a last
resort, you can always change your camera
position.

Portions of a façade that fall within a buil-
ding’s own shadow appear two-dimensional
and show less contrast, but more detail, than
elements lit by direct sunlight. 

Reflections can also have positive or
 negative effects on a building sappearance
and their prominence depends largely 
on the materials used in the building and
how they have been put together. Reflec -
tions of other buildings in modern mirrored
or glass façades are a good example of 
a building material that emphasizes its 
own nature.

Creative Tips

Here a few tips and tricks for taking creative
photographs of buildings:

Tilting the camera upward: human
beings generally view their surroundings hori-
zontally and “to the front”, keeping the hori-
zon in view. Viewing a scene looking upward
creates an unusual perspective on an otherwi-
se conventional scene. In this case, the general
context is not visible and the usual spatial rela-
tions between a building and its surroundings
become less clear. The sky—with its uniform
texture—becomes the dominant background
feature. Pointing your camera upward also al-
lows you to rotate it without having to precise-
ly define which direction is “up”.

Extreme crop: framing a shot to leave out
(or emphasize) certain elements of a building
is a great way to produce minimalistic or abs-
tract images. Images like this can be used to
capture multiple elements of a building in a
layered fashion that bears little relation to a
conventional photographic interpretation. In
extreme cases, a photo is no longer recogniz-
able as being of a building at all and fulfills a
purely graphical function.

Extreme use of reflections: reflections
can be used to produce a new view of a fami-
liar subject, introducing a second, completely
separate visual layer to an image. For exam-
ple, you can use this type of effect to symboli-
ze “old and new”, as in the image at below
right¥. Reflections can be used to create lay-
ering, bulking, or repetition effects and, espe-
cially at night, to create images with no clear
spatial dimensions.

Image sequences: another way to photo-
graph buildings creatively is to take a se-
quence of images that give multiple images a
mutual context. Our example shows a se-
quence with a “doors” theme. As long as the
theme is clearly recognizable, materials, co-
lors, lighting, and exposure can vary widely
from image to image. Selecting the right
images to display is another integral part of
shooting a successful sequence.
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Façade in its own shadow (area B: 
on the left in the image below) and in a
shadow cast by another object (area A: 

on the right in the image below)

Hard shadows are an integral part of the
composition of this image

Reflections can influence the aesthetic effects of a building
in positive and negative ways
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Shooting upward: the sky creates a broad, uniform background for the converging
lines of these skyscrapers

Image sequence: combining multiple images with a common theme
gives individual photos a new and interesting context

Extreme crop: detail shots can make buildings appear strange. 
In this image, the patterns and textures are more important than the actual building.

Extreme reflection: this reflection adds 
a second visual level to the image and
enhances the overall effect



33c’t Digital Photography 1 (2010)

Architectural Photography | Brief Guide

Once you have chosen your subject, you
need to analyze the situation and its specific
characteristics: 

– Which side of the building is best suited to
being photographed? Where are shadows
or backlight positioned? What is the
 weather like? What other structures
 characterize the surroundings?

– What specific physical structures does the
building have? Are there any interesting
(or irritating) reflections?

– How do you want to portray the building?
In a documentary or an artistic style? Static
or dynamic?

The next step involves a detailed analysis of
your subject's surroundings:

– Which camera angle best emphasizes the
building’s strengths?

– Which camera positions will deliver great
shots and which are less suitable?

– Which elements of the building’s surroun-
dings should you include in your shot, and
which should you leave out?

– Do you want to shoot in landscape or
 portrait format?

The final step involves selecting your
shooting settings and the accessories you
will use to make the shot:

–ˇWhich accessories (tripod, filter, remote
 release etc.) do you need?

–ˇWhich focal length lens is best for
 capturing your chosen composition?

–ˇHow do you want to compose your image?
With the subject in the center? Using the
“golden ratio”? Or with the subject positio-
ned toward the edge of the frame?

–ˇHow will you avoid converging lines?
–ˇWhich camera settings will produce a

 balanced exposure?
–ˇWhat is the right moment to release the

shutter? Which people, cars, or shadows
are you waiting for?

Photographing Buildings: A Brief Guide



Before we started processing we used a RAW
converter to adjust white balance, remove a
couple of dust spots in the sky, and optimize
the image a little using Fill Light and Recovery
tools, resulting in a 16-bit sRGB TIFF image.

We used Adobe Photoshop CS4 to perform
the following workflow on our sample image
of the German Historical Museum in Berlin. 

The lens we used produced no obvious
distortion, so no distortion correction was ne-
cessary. The image was, however, shot hand-
held and is not quite level, so we applied the
Photoshop Transform command to cure this.
First, we dragged some guide lines out of the
rulers (you can also use the Grid display in the
View menu). We then turned the background
layer into a transformable layer (called “Layer
0” by default) by double-clicking the layer

thumbnail in the Layers panel. We then used
the  Edit > Transform > Skew command to
level our horizon.

Next, we “cleaned up” the image, using
the Healing Brush, Clone Stamp, and Patch
tools to remove various flaws. The Patch tool
was ideal for removing the reflections from
the left-hand side of the façade and the lea-
ves from the street. It works by selecting the
area you want to correct and replacing this
with similarly textured pixels from neighbo-
ring image areas. Here, Photoshop automatic-
ally adjusts the brightness of the transitions
between old and new pixels.

We then adjusted brightness and contrast
using the Curves tool. Newer versions of
Photoshop create new adjustment layers for
all adjustment steps (the “Curves 1” layer in
this example), making it much simpler to 
 fine-tune or delete individual adjustments
without affecting the original image data. 
We brightened the midtones and darkened
the highlights a little in order to intensify the
effect of the sun’s reflection. You can make
these types of adjustments selectively using
layer masks.

Finally, we adjusted local contrast in the
glass façade by duplicating the background
layer (Layer > Duplicate Layer) and applying
the Unsharp Mask filter in the Filter > Sharpen
menu with a high Radius value. You can
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We used the Transform command to level the horizon

Image
Processing
Image processing tools can
significantly improve the overall
look of your images after shooting,
but require careful use in order to
avoid producing over-the-top 
or unrealistic-looking results.

Here, we used a black brush in a new layer mask to remove
the fringing caused by increasing local contrast

The Patch tool removed the unwanted
reflections in the left-hand side of the façade



 adjust the Amount slider according to taste.
The only disadvantage of using this tool is
that it tends to produce color smears at the
high-contrast edges of large, uniform surfaces.
You can, however, remove smears using the
Brush tool in a new layer mask (created by cli-
cking the button circled in red in the screen-
shot on the previous page). We reduced the
opacity of our new layer slightly to keep the
effect  subtle, as over-the-top adjustments can
quickly spoil an image. Once we had finished
these adjustments, we flattened the image to
the background layer before making some
color corrections.

The Photoshop Selective Color adjust-
ment tool can be used to make extremely
precise changes to individual hues. We used
the tool to reduce the slight red cast inhe-
rent in digitally-produced blue tones in the
sky. We also recommend that you sharpen
your image slightly once you have finished
making corrections. Photoshop’s Unsharp
Mask tool produces satisfactory results if you
set the Radius value to between 0.3 and 1.0
and the threshold value to between 0 and 3.
Later versions of Photoshop also include the
new Selective Sharpen tool. There are also a
number of more complex sharpening tools

and plug-ins available. We particularly like
the results produced by Focalblade.

We cropped some of the street out of the
finished image to keep the overall look clean
and simple. (jr)
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Tone curves are used to improve brightness
and contrast. In our example, we slightly
brightened the midtones.

The original image after RAW conversion
but before processing

The finished image is much “cleaner”

Adrian Schulz’ book Architectural Photo-
graphy offers both aspiring amateur and
advanced photographers a comprehensive
overview of the practical and technical
aspects of photographing buildings, and
provides the reader with all the necessary
knowledge for making great architectural
photos.

Published by
Rocky Nook,
Inc., July 2009,
224 pages, 
US$ 44.95

Book Tip

Specialized sharpening tools such as FocalBlade often produce better results 
than the built-in Photoshop tools c



Perfect Portraits | Composition
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H e
a dg a m e s

Successful portrait photos adhere to certain
compositional rules, but the emotional and 
visual impact of a portrait is largely determined 
by the skill used to light the subject and the
communication between photographer and model.



Photos: Thomas Saur
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An example of how to use the rule of thirds
in your composition. The subject’s eye is
positioned at one of the intersections in the
grid. The resulting proportions produce an
interesting overall look.

c’t Digital Photography 1 (2010)

Portrait Composition
Architectural and landscape photogra-
phers concentrate on their subject’s lines
and proportions in order to produce satis-
factory results, and portraits too can bene-
fit from the application of some basic com-
positional rules.

The Rule of Thirds

You have to frame your image before you
can further refine your composition. Try to
avoid placing your subject in the center of
the frame. If you are new to portrait photo-
graphy, the “rule of thirds” can help you to
achieve results similar to those produced
by applying the mathematically more
complex “golden ratio” rule. Imagine two
horizontal and two vertical lines that divi-
de the frame into nine equal sections, and
then try to place the most interesting part
of your subject (for example, an eye or a
hand) at one of the intersections. If your
image includes a horizon, this can be posi-
tioned on either of the two horizontal
lines, and you should try to orient the
edges of your subject to one of the vertical
lines. Many cameras allow you to superim-
pose a thirds grid on the monitor, and
image processing software often includes
a thirds grid for use during cropping. Once
you have gained some experience using
the thirds grid, you can begin to compose
images in other ways, using different pro-
portions within the frame.

Lines and Proportions
The photographic portrait has its origins in
the world of painting, so it is worth taking

a look at the composition of some classical
portraits as a guide. Early portrait photos
were often deliberately composed to look
like paintings, and it is interesting to note
that the overall look of a portrait is influen-
ced by the subject’s clothing as well as the
facial expressions and body language.

In the series of portraits shown here, the
clothing was a defining element in the
overall composition, with the jacket collar
and the brim of the hat providing a frame
for the subject’s face. The dominant diago-
nal lines create tension between the dark
and light areas within the image, and the
resulting contrast forms a counterpoint to
the finely textured face. 

Keep in mind the effects the shapes in your
image have. Opposed lines create tension,
while diagonal lines generally produce
strongly positive or negative feelings in the
viewer. Lines that lead the eye from bot-
tom left to top right are usually considered
to be ascending. In the image on the right,
a second diagonal line contributes to the
ascending feeling, assisted by the low ca-
mera position.

Choosing Your Position

Choose your camera position carefully.
Your position relative to your subject is an
emotional as well as a physical one. A low
camera position elevates the subject, while
a higher camera position means you are li-
terally looking down on your subject. The
portrait at top left show that these effects
can also be toned down by lighting effects
and the expression on the subject’s face, as
well as by dominant lines within the
image. Remember also, the shorter the
focal length of your lens, the stronger the

perspective effects in your image will be.
These rules are only intended as an aid to
composition, and it is always the photogra-
pher who makes the final decision as to
how the image should look. The most im-
portant rule to remember is that you are al-
lowed to break all the other rules if it helps
to produce a better image.

A low camera position was deliberately
chosen to give this image a “heroic” look,
and the effect is accentuated by the upward
diagonal of the subject’s jacket collar.
Check out the enclosed, red shape formed
by the subject, his hat, and his collar. The
tight crop helps produce tension in the
finished image.





Creating Texture with Light
The lighting for this shot was set up with a
“light soft, develop hard” idea in mind. The
simple setup consisted of a softbox close to
the subject on the left and an absorber on
the right to give the face a dark edge. We
used a normal reflector with a honeycomb

baffle to light the background from the
right, creating a graduated falloff effect 
in the opposite direction to that produced
by the main subject lighting. This helped 
to separate the subject graphically and 
texturally from the background.
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Crosslighting
This setup consisted of two main lights positio-
ned diametrically opposite to one another. The
flash on the left was fired through a white um-
brella and a softbox was placed to the subject’s
right. This type of setup is called “crosslighting”,
creates a highly defined look with fine textures
and skin imperfections showing up strongly.
Crosslighting should be used with care, as the
effects it produces are not always flattering! 

The Emotional Effect of Light

Light can be flattering, but it can also be
ruthlessly revealing.

The lighting in classic Hollywood movies
was always set up to enhance the effect of
the characters concerned. Stars were al-
ways bathed in an aura of glamorous, white
light, while the baddies were given much
harsher treatment. 

“Hard” light accentuates facial expressions,
and facial shadows can make a portrait
 subject look mysterious and inscrutable.
Crosslighting effects can make a character
appear ambiguous or shifty, and lighting a
face from below always produces a devilish
 effect. 
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Different Aspects of a
Subject’s Personality

Taking portraits is a way of getting to know
your subject more closely and, ideally,
helps a subject to learn about himself too.
The communication between photogra-
pher and subject is important, and can
only really function properly in a relaxed
atmosphere. Make sure you take enough
breaks and keep a close eye on your sub-
ject’s personal characteristics throughout
the shoot. Release the shutter without
 warning, ideally when the subject is not
expecting it. The best portraits are made
when the subject is no longer aware of the
camera at all.

Fake Shots
If your subject appears tense and your
photos look artificial as a result, it can help
to use the following technique: announce
your shot and release the shutter very
 obviously. Once your subject has relaxed
after the shot, you can press the shutter
button again immediately (and as casually
as possible) to catch him unawares. If you
practice this technique a little, you will
find that the second shot is often the
 better one.

Distract Your Subject
If your subject is too aware of the camera,
you can try some distracting tactics. Speak
to your subject while you are shooting or
ask questions that require him to think
about something other than being photo-
graphed. 

Change Positions
Long portrait shoots can cause visible ten-
sion in a subject. Instead of letting him
know that he looks tense, help him to relax
by getting him to move between shots.
Simple tricks like suggesting he drink a
glass of water can help a lot.

As for Tension in the Photographer
Closing your eyes and relaxing your shoul-
ders and arms can ease tension, and try
not to lose your sense of humor during 
a shoot—laughter is the best relaxation
therapy of all!

Deliberate Tension
Tension can also be a useful component of
a portrait if it is used deliberately to produce
expressive results. You can create tension
using eye contact or even by deliberately
provoking your subject. 

A successful portrait session often results
in a whole series of images that show
many different aspects of the subject’s
character.





Distinct Outlines
Here, the main light was pointed directly
at the subject. A black cardboard box 
was used to provide a distinct, dark
 background, and helped to underscore
the contrast in the subject’s face.

Give Yourself a Choice

Try to shoot a number of different variants for each shot.
This screenshot of a digital contact sheet clearly shows
the differences that slight variations in camera position
or the subject’s expression can make to the final image.
Sometimes it’s just as difficult to choose the right image
as it is to shoot your photos in the first place.

Many image management programs allow you to rate
your images during the sorting process. Try to remain
spontaneous while sorting, but also let a day or two pass
before making your final selection.



The Right Look
The hard, overexposed feel in this shot is
 reminiscent of a classic, cross-processed
 analog look.



Maximum Tonal Range
An example of a portrait with a broad range of tonal
 values: The original photos were shot in RAW format and
the RGB files were converted to black-and-white using
Photoshop Lightroom. The color values and the Darks and
highlights were adjusted successively until all the  gray -
scale tones showed good detail. Lightroom’s “Fill Light”

and “Recovery” sliders were particularly useful here. 
We tried to preserve as many tonal values as possible in
the mono chrome image by recovering the highlights
and lighten ing the shadows. We compensated for the
 resulting loss of contrast by shifting the black point a
 little to the right.

Gradation

Color, contrast, and tonal values are also important 
in creating the final look of a portrait. In the analog
past, the choice of film and development technique
 determined the look of the finished image. Nowadays,
the settings you make in your RAW editor or your
image processing software make the critical difference

to the look and feel of your results. Once you have
 decided whether you want to produce a color or mono-
chrome rendition of your image, you will also need 
to adjust the image’s tone curves. If the original image
is good enough, a little  manipulation can produce a
punchy, characterful  portrait.

About the Author:
Thomas Saur was born in 1966 and lives in Duesseldorf, Germany. He is an art director, photographer,
and image manipulator, and is responsible for the design of a number of magazines. He regularly
 contributes to various specialist magazines on the themes of photography and image processing.

Contact: foto@tsamedien.de, www.tsamedien.de/foto
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Reduction to the Minimum

This is a fine available light portrait, taken using a wide
aperture and lit using just a single modeling light.  Shifting
the black point and toning the shadows and highlights
produced an attractive, high-contrast look. This mono-
chrome portrait is punchier than the color version, in
spite of the loss of tonal values the conversion caused.



Thomas Saur

Digital Camera

Manual Lens
Autofocus lens performance is not keeping pace with advances in camera and
image sensor technology, giving manual focus lenses an unexpected new lease
of life. We tested some old (and some newer) manual lenses manufactured by
Zeiss and Leica, and compared them with Canon’s current autofocus offerings.
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Increasing numbers of advanced photogra-
phers are ignoring the autofocus functiona-

lity built into their DSLRs, preferring to focus
manually. Fast, fixed focal length, manual-
focus lenses attached to DSLRs using adapter
rings are capable of producing previously un-
dreamed-of image quality. Leica invented the
35mm format and Zeiss, whose customers in-
clude many Hollywood studios and NASA,
were the originators of modern lens geome-
try. Lenses from both companies have a re-
putation for high optical and build quality
and are once again enjoying widespread
 popularity.

Image Quality Depends on
Adapter Quality
The new wave of interest in manual lenses has
brought with it a rash of new adapters. Many

Chinese eBay items appear to offer better
value than their counterparts manufactured
by established companies like Novoflex,
Voigtländer, Panasonic, or Leica, with prices
starting at around US$15 compared with the
US$200 and more you can spend on better-
known brands. Because micrometer toleran-
ces can make an appreciable difference to the
quality of your results, high build quality is es-
sential in an adapter, and the cheaper adap-
ters we tested simply weren’t up to scratch.
Some didn’t allow us to focus a lens to infinity,
resulting in blurred sunsets and frustration,
while some cheaper adapters had so much
play that the lens was actually in danger of fal-
ling off the camera. Novoflex adapters produ-
ce consistently good results, so we used these
for our test. Using adapters also nixes automa-
tic aperture control, so you will have to meter
exposure in either aperture-priority or manual

mode. Adapters usually make it impossible to
transfer Exif data from the lens to the camera,
although some newer models have glued-on
programmable chips that work around the
problem. Again, we advise caution if you are
looking at cheaper adapters, as some chips
are not securely fixed and can end up falling
off inside the camera body. Some adapters
also have a focus-assist chip that causes the
in-focus light in your camera’s viewfinder to
blink when the correct focus distance has
been set. Not all lenses can be attached to all
camera bodies, but adapters are available for
most combinations (see table).

Which Lenses Can I Use?

A manual focus lens must have an image cir-
cle large enough to completely cover your
image sensor’s surface, which is always the
case if you use 35mm system lenses with a
DSLR that has a smaller than full-frame
image sensor. Your choice of lenses will be
limited by the depth of your camera’s lens
flange – i.e., the distance between the lens
mount and the image sensor. If the physical
thickness of your adapter does not compen-
sate for the flange depth of your lens, you
will not be able to focus to infinity. There is a
list of lens flange depths available at the
website listed at [1].

Many medium format lenses can be ef-
fectively adapted for use with various types
of SLR. Although they are large and unwiel-
dy, medium format lenses produce a large
image circle that makes them adaptable for
use as shift lenses with smaller format came-
ras. The Hartblei Company (www.hartblei.
com) specializes in adapting and modifying
Zeiss medium format lenses. The widest choi-
ce of adaptable lenses is available for came-
ras with relatively low flange depths, such as
the Canon range, where the flange depth
measures just 44 mm.

Micro Four Thirds – 
a Dream Format
Flange depth is an even shallower 20 mm in
mirrorless Micro Four Thirds (MFT) format
 cameras, making it (theoretically) possible to
mount just about any 35mm lens on an MFT
camera. The M-series lenses manufactured by
Zeiss and Voigtländer are especially popular
due to their compact size and uncompromi-
sing image quality. Remember, the 2x crop
factor doubles the effective focal length of a
35mm lens if you mount it on an MFT camera.
This reduces the number of effective wide-
angle lenses you can choose from, but opens
up a whole new world of combinations at te-
lephoto focal lengths. For example, the ama-
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zingly bright 50mm Leica Noctilux becomes a
100mm f0.95 telephoto when used with an
MFT camera. We will be testing this dream
combo in a future issue.

Using Leica Lenses

Steadily rising prices are a sure sign of the di-
gital revival that pre-owned Leica 35mm len-
ses are currently enjoying. One drawback of
some Leica lenses, especially wide-angles, is
the unusually long distance between the rear
lens elements and the lens flange. This can
cause serious damage to a DSLR mirror, so
check your measurements carefully before
using an untried camera/lens combination.
There is a Leica lens compatibility list availa-
ble on the Internet at [2].

If you want to use Leica lenses with a
Canon DSLR, you are safe in the medium to
telephoto range, and some of the older R-se-
ries wide-angles (see the test following this
article) can also be used without risking da-
mage to your camera. A few of the newer, op-
tically superior 21mm, 28mm, and 35/1.4mm
lenses don’t fit on the Canon EOS 5D Mark II
that we used for our test, making their extre-
mely high image quality the preserve of
Leica, Four Thirds, and Micro Four Thirds
users. For compatibility, please see link [2] in
‘Useful Links’.

Some photographers have been known to
modify their lenses or even their camera’s

mirror. For the brave, the reward is the op-
portunity to use some of Leica’s best lens
geometries with a modern DSLR, while the
downside of this type of tinkering is that mo-
difying your camera nullifies its warranty.

Another alternative is to permanently at-
tach an appropriate replacement mount,
such as those manufactured by Leitax [3], to

your camera. If you are unsure about using
replacement mounts or adapters, we

suggest you take a look at the new
Zeiss Z-series lenses, which are availa-

ble in various fixed focal lengths
with built-in Pentax (ZK), Nikon (ZF
& ZF.2), and Canon (ZE) mounts.
These specially-built lenses are ca-
pable of transferring data between
camera and lens, making it possible

to make full use of your camera’s au-
tomatic exposure and flash control sys-

tems. In April, Zeiss announced the new
Compact Prime (CP.2) series of interchange-
able-mount cinema lenses designed for use
with PL-system movie or Canon and Nikon
DSLR cameras. The available focal lengths
range from 18 to 85 mm and lens features in-
clude normalized bayonets, identical focus
and aperture controls, and extra-long focus
travel. Voigtländer, too, has recently expan-
ded its range of lenses to include some dedi-
cated DSLR models.

Tips and Tricks for 
Manual Focusing
Focusing manually using an optical viewfin-
der requires practice. In analog times, the
thickness of the film emulsion compensated
for fine focusing errors – a margin for error
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Lens Adapter Compatibility
Canon EOS Four Thirds Micro 

Four Thirds
Nikon Olympus OM Samsung NX Sony Alpha/

Minolta MD

Canon FD 2 (WL, FC), 
4 ( WL)

2 1, 10 (Ray) 1 2 (mL)

Contax/Yashica 2 (AFB), 8, 10 1, 2 (FC), 10 1, 10 (Ray) 1

Exacta 10

Hasselblad 1, 2 1 1 1 1 1 1

Leica M 1, 10 (Voi)

Leica R 1, 2 (FC), 3, 8,
10, 11 (FC)

1, 2 (FC) 1, 10 (Ray) 1 2

M39 2 (nN) 2 (CO) 2 (CO)

M42 1, 2 (FC), 3, 4,
10, 11 (FC)

1, 2 (FC), 3, 10 1 1 2 (FC)

Mamiya 645 1 1 1 1 1 1 1

Minolta MD 2 2, 10 1 1 2 (WL)

Nikon F 1, 2 (FC), 3, 8,
10, 11 (FC)

1, 2 (FC), 3, 10 1, 10 (Voi) 1 2 (WL)

Olympus OM 3, 10, 11 (FC) 1, 2 (FC), 3, 5 1, 10 (Ray) 1

Pentacon Six 2 2

Pentax 6x7 1 1 1 1 1 1 1

Pentax K 2, 10 1, 2 (FC), 10 1, 10 (Voi) 1 2, 7

Rollei QBM 2 10

Sony Alpha/Minolta AF 1 1

T2 2, 4, 6 1, 2 (FC) 1 2, 6 6 1 2, 6

1: Novoflex, 2: Enjoyyourcamera, 3: B.I.G., 4: Hama, 5: Olympus, 6: Soligor, 7: Samsung, 8: Zoerk (www.zoerk.com), 10: www.cameraquest.com, 
11: happypagehk on eBay,  WL: with lens, FC: with focus confirmation, CO: close-up only, Voi: Voigtländer, Ray: Rayqual

Lens
System

Camera
System
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Manual lens adapter rings



that is simply not available to digital photo-
graphers. Tactile feedback from the focus
ring on manual lenses makes focusing easier,
but judging sharpness using the standard fo-
cusing screen built into most cameras can be
quite difficult.

Many initial attempts at manual focusing,
especially using bright lenses, end in disap-
pointment. But don’t give up! The following
sections list a few useful tips and tricks to
help you focus precisely.

> Adjust your viewfinder
eyepiece
Make sure your viewfinder eyepiece is set to
the correct diopter value for your eye.

> Use a replacement 
focusing screen
The rise of autofocus has seen an equivalent
decline in the use of high-quality focusing
screens in DSLRs. A microprism or split-screen
focusing screen is a great aid to manual focu-
sing. Most quality DSLRs allow you to swap
out your focusing screen and most photo sto-
res carry a range of replacement screens for
Nikon and Canon DSLRs.

> Use the focus indicator
Zeiss Z-Series lenses and adapters with
built-in focus confirm chips work in tandem
with your camera’s autofocus systems. An
indicator light blinks when the selected
focus area is in focus. With a little practice,
you will be able to apply this technique
quickly and precisely.

> Focus using Live View

Live View displays the image data exactly as it
is captured by the image sensor, and is thus
the most accurate focusing reference. Live
View displays can usually be zoomed to pro-
vide further focusing accuracy. Some camera
functions are not available in Live View mode
(especially in Canon models), so we recom-
mend that you always update your camera
firmware to the latest available version in
order to take advantage of the latest features
and functionalities.

> CD magnifiers 

The LCDs built into most cameras have
 sufficient resolution to make using a magnifier
practical. The Hoodman HoodLoupe 3.0 
(US$79.99, www.hoodmanusa.com) is one of
the better models on the market. Once you
have got used to mounting and using a loupe,
it is probably the most effective way to judge
depth of field and ensure that you focus
 accurately.

> Eyepiece magnifiers

Originally designed for use in macrophoto-
graphic situations, most eyepiece magnifiers
crop the viewfinder image and only magnify
the inner image circle, making them less suit-
able for general focusing purposes.

The Bottom Line

It is now possible to use a great many older
and current manual focus lenses with a wide
range of digital cameras, but some questions
still remain: Does the difference to the results
justify the extra effort and expense involved?
Can high-quality European manufacturing re-
ally compete with mass-produced Asian
high-tech? Is there any truth in the rumors
that modern lens quality simply isn’t compa-
rable to that of older, manual lenses? We
compared 20 wide-angle, standard, and short
telephoto lenses manufactured by Zeiss and
Leica with their modern, autofocus counter-
parts. You can read our sometimes surprising
results on the following pages.
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Manufacturers:

www.zeiss.com > Camera and 
Cine Lenses

http://us.leica-camera.com/photography/

A comprehensive list of Leica lenses
that helps identify and combine serial
numbers with the year of manufacture:

www.overgaard.dk/leica_lens_
compendium.html

Websites:

www.mflenses.com

www.l-camera-forum.com/leica-forum/
digitalforum

www.imx.nl/photo/

www.pebbleplace.com

www.l-camera-forum.com/leica-wiki.en/
index.php/Main_Page

forum.manualfocus.org/

Various reviews, including some for
Leica and Zeiss:

www.slrlensreview.com/web/

www.stevehuffphotos.com/Steve_Huff_
Photos/STEVE_HUFF_PHOTOS__.html

Comprehensive Zeiss lens reviews
(some for a fee):

http://diglloyd.com/index.html

A thread that includes sample images
shot using manual lenses and DSLRs:

http://photography-on-the.net/forum/
showthread.php?t=644277&highlight=
leica+apo

Links mentioned in the article text:

[1] www.photoethnography.com/Classic
Cameras/index-frameset.html?Lens-
adapters.html~mainFrame

[2] www.pebbleplace.com/Personal/
Leica_db.html

[3] www.leitax.com/Leica-lens-for-
Canon-cameras.html

Useful Links
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The Hoodman HoodLoupe provides
an enlarged view of your camera’s
display, making precise manual focus
adjustments much easier



This image was
made using an old Leica

Elmarit-R 90mm f2.8 lens
bought very cheaply second-hand.

Note the high-contrast lion’s head door-
knocker in the foreground and the well-defined

background blur at top left. This is a very good example of
the famous, deeply three-dimensional Leica look.
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Lens Test
Manual vs. Autofocus

For our test, we compared Canon, Leica, and
Zeiss lenses mounted on a 21-megapixel, full-
frame Canon EOS 5D Mark II. We used a
 Novoflex adapter to mount the Leica lenses.
The Zeiss ZE-series lenses have built-in Canon
mounts. All test shots were taken from a
 tripod with the mirror locked up, and we
used a Hoodman HoodLoupe to focus via
Live View. We would like to thank Meister
 Camera Hamburg (www.meistercamera.com)
for giving us access to many of the Leica
 lenses we tested. 

Because some of the tested lenses are  
pre-owned, the results are not necessarily
 applicable to the entire lens series. Changing
lighting for the exterior shots made some
comparisons more difficult, and the manu-
facturing tolerances in some of the autofocus
lenses made using the manual focus ring a bit
of an adventure! Focus shift also hampered
our experiments with some of the brighter
lenses. All in all, we consider our findings to
be more of a field report made under realistic,
everyday shooting conditions than a  hard -
core, lab-grade test. At various points in the
test, we use additional photos to underscore
our evaluations. We have included all 105
 original test images in the Sample Images
 folder on this issue’s free DVD so you can
judge the  results for yourself.

Exterior shots: we used the front of 
the Hanover town hall as the subject
for our wide-angle shots, where the
backlit situation made the scene
quite difficult to shoot. We looked at
sample details from the edges and
the center of each image made using
the 21mm, 28mm, and 35mm lenses.

Our test scene: we shot our
artificially-lit test image uncropped

and used a range of details to judge
the quality of the test lenses
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This is an old lens, built in 1968. It is compact
and solidly constructed with a square  sun -
shade. Edge detail at maximum aperture is
basically unusable, but we didn’t have a
 second lens from the same series to check
whether ours was a dud. Reproduction is soft
and diffuse with severe vignetting and distor-
tion at the edges of the frame. At f8, center
detail is usable but edge detail is still poor.

Leica 21mm f4 Super-Angulon

Leica 21mm f4 Super-Angulon 

Center sharpness Edge sharpness Detail Center Edge Detail

A
t 

f4
.0

A
t 

f8
.0

This lens was not as good as the other Canon
wide-angles we tested, showing obvious
 vignetting at maximum aperture. It still
shows weakness even when stopped down
to f8 and cropped. The lens is compact and
well-constructed, and is suitable for less
 demanding applications. If you use a high-
 resolution, full-frame camera, you should look
for alternatives.

Canon EF 20mm f2.8 USM
Canon EF 20mm f2.8 USM

A
t 

f2
.8

A
t 

f 8
.0

Focal length 20 mm
Aperture range f2.8 – f22
Angle of view (horiz./vert./diag.) 84° / 62° / 94°
Construction 11 elements in 9 groups
# of aperture blades 5
Closest focus distance 0.25 m
Maximum reproduction ratio 0.14

Focal length 21 mm
Aperture range f4.0 – f22
Angle of view (horiz./vert./diag.) n/a
# of aperture blades 9 elements in 9 groups
Blendenlamellen (Anzahl) n/a
Closest focus distance 0.3 m
Maximum reproduction ratio n/a
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An excellent quality ultra-wide-angle lens that
shows very little distortion or vignetting at
 maximum aperture. Even when the lens is wide
open, sharpness is excellent in the center and
very good at the edges of the frame. Stopped
down sharpness and contrast are consistently
good over the whole frame. Floating element
construction ensures great close-up results. All
this and very good highlight handling make
this lens unrivalled in the wide-angle arena.

Zeiss Distagon T* 21mm f2.8 ZE

Canon 24mm f3.5 TS-E

Zeiss Distagon T* 21mm 
f2.8 ZE

Unfortunately, Canon sent us the old version
of this professional tilt/shift lens. Like all per-
spective correction lenses, this one is only
available in a manual focus version. Center re-
production is very good and edge reproducti-
on acceptable wide open. Stopping down im-
proves performance but this lens still isn’t
among the best of the bunch. Its geometry is
designed to produce a large image circle, but
edge performance was disappointing, even
stopped down. In general, this “pro” lens
didn’t live up to our expectations.

Canon 24mm f3.5 TS-E

Center sharpness Edge sharpness Detail Center Edge Detail

A
t 

f2
.8

A
t 

f8
.0

A
t 

f3
.5

A
t 

f8
.0

Focal length 21 mm
Aperture range f2.8 – f22
Angle of view (horiz./vert./diag.) 81° / – / 90°
Construction 16 elements in 13 groups
# of aperture blades n/a
Closest focus distance 0.22 mm
Maximum reproduction ratio n/a

Focal length 24 mm
Aperture range f3.5 – f22
Angle of view (horiz./vert./diag.) 74° / 53° / 84°
Construction 16 elements in 11 groups
# of aperture blades 8
Closest focus distance 0.21 m
Maximum reproduction ratio 0.34
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This is a good quality water and dust resistant
zoom lens. Center sharpness is fine at all aper-
tures, but quality tails off toward the edges of
the frame at maximum aperture. The 16mm
setting produces visible distortion, which les-
sens toward the 28mm mark. At f8 and smal-
ler, the lens produces consistently high-con-
trast detail over virtually the whole frame.
Only the extreme edges remain below Zeiss
standards at all apertures. The lens tends to
lose highlight detail in backlit situations.

Canon EF 16-35mm f2.8L ll USM
Canon EF 16-35mm 
f2.8L II USM

A
t 

f2
.8

A
t 

f8
.0

A
t 

f2
.8

A
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The top left corner of our test image at maximum aperture. From left to right: Canon 24mm TS-E, Canon 16–35mm,
Zeiss 21mm ZE. The superiority of the Zeiss lens is obvious.

Focal length 16–35 mm
Aperture range f2.8 –f22
Angle of view (horiz./vert./diag.) 98°–54° / 74°–38° / 108°–63°
Construction 16 elements in 12 groups
# of aperture blades 7
Closest focus distance 0.28 m
Maximum reproduction ratio 0.22 (at 35mm setting)
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Here, detail is patchy at full aperture, and
shows vignetting and slight diffusion. The
edges of the frame are soft and tend to wash
out. Center performance is good and edge
performance acceptable at f8. At a first glance,
the lens produces usable results, but a quick
comparison with the results produced by the
equivalent Zeiss model makes it clear how
much potential detail is missing. This is a
good lens for use with smaller image sensors.

Canon EF 28mm f1.8 USM

Zeiss Distagon T* 28mm f2.8 ZE

Canon EF 28mm f1.8 USM

This lens produces very little distortion and ex-
cellent overall results. Vignetting is visible wide
open. Center performance is really excellent at
f8, producing very fine microcontrast. Detail is
good, but some fringing is visible at backlit
edges. This lens is almost (but not quite) as
compelling as its 21mm cousin.

Zeiss Distagon T* 28mm 
f2 ZE

Center sharpness Edge sharpness Detail Center Edge Detail
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Focal length 28 mm
Aperture range f1.8 – f22
Angle of view (horiz./vert./diag.) 65° / 46° / 75°
Construction 10 elements in 9 groups
# of aperture blades 7
Closest focus distance 0.25 m
Maximum reproduction ratio 0.18

Focal length 28 mm
Aperture range f2.0 – f22
Angle of view (horiz./vert./diag.) 65° / – / 74°
Construction 10 elements in 8 groups
# of aperture blades n/a
Closest focus distance 0.24 m
Maximum reproduction ratio n/a
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This lens was built in 1973 and, like the other
older Leica lenses, is solidly built and has 
a square sunshade with rounded corners.
Center sharpness is excellent, while sharpness
drops off a little at the edges of the frame.
The exterior results are extremely good at
smaller apertures and again, only the extreme
edges show slight optical deficits. Detail and
definition are great, making this lens a real
 alternative to most of its modern, autofocus
rivals.

Leica Elmarit 35 mm f2.8
Leica 35mm f2.8 Elmarit
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This lens was built in 1968. It is compact and
solidly built with a square sunshade. Edge
performance at maximum aperture is poor
and is just usable at f8. The lens reproduced
our studio test shot best stopped right down,
but had difficulties producing acceptable
outdoor results. Outdoor contrast was weak
and backlit detail was diffuse. Our test lens
did not live up to its reputation.

Leica Elmarit 28mm f2.8
Leica 28mm f2.8 Elmarit
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Focal length 28 mm
Aperture range f2.8 – f22
Angle of view (horiz./vert./diag.) n/a
Construction 8 elements in 7 groups
# of aperture blades 6
Closest focus distance 0.3 m
Maximum reproduction ratio n/a

Focal length 35 mm
Aperture range f2.8 – f22
Angle of view (horiz./vert./diag.) – / – / 64°
Construction 7 elements in 6 groups
# of aperture blades n/a
Closest focus distance 0.3 m
Maximum reproduction ratio n/a
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Canon EF 50mm f2.5 Compact Macro
This Canon macro lens has trouble producing
adequate edge contrast and detail at maxi-
mum aperture. Things look a lot better at f4,
and at f8, the whole frame is reproduced
 nicely, especially close up. Performance is
only really adequate stopped down—an
 acceptable compromise in a macro lens.

Canon EF 50mm f2.5
Compact Macro

Center sharpness Edge sharpness Detail Center Edge Detail
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We made our standard and
telephoto test shots at the back
of the Hanover town hall. The
center, edge, and detail crops we
used to analyze the results are
framed in yellow.

Focal length 50 mm
Aperture range f2.5 – f32
Angle of view (horiz./vert./diag.) 40° / 27° / 46°
Construction 9 elements in 8 groups
# of aperture blades 6
Closest focus distance 0.23 m
Maximum reproduction ratio 0.5
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50/60mm
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100mm
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This lens is optically superior to its wide-
aperture cousin and is one of the few lenses
in our test that showed no real weakness at
all. Performance is good wide open and
faultless from f2.8 on. Stopping down further
increases sharpness and improves micro -
contrast over the whole frame. Build quality
is superb and the lens has suitably long focus
travel, making focusing precise, but not
 always fast enough for taking snapshots.
Color reproduction is warm and bokeh
 effects are very pleasing. The lens produces

clear, vivid images, even in difficult light, 
and we recommend it unreservedly.

Zeiss Makro-Planar T* 50mm f2.0 ZE

Zeiss Makro-Planar T* 50mm
f2.0 ZE
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Built in 1968, our test lens showed distinct
signs of wear but nevertheless produced
great test results. Edge sharpness was not
fantastic at maximum aperture, but overall
performance increased quickly just one or
two stops later. The lens produced pleasing
bokeh and convincing detail with very good
microcontrast. Color reproduction was excel-
lent at all but the largest apertures.

Leica f2.8 60mm Macro-Elmarit
Leica Macro-Elmarit 1:2.8 60 mm
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Brennweite 61 mm
Blendenbereich f2.8 – f22
Bildwinkel (hor./vert./diag.) 33° / 23° / 40°
optischer Aufbau 6 elements in 5 groups
Blendenlamellen (Anzahl) n/a
Naheinstellgrenze 0.27 m
größter Abbildungsmaßstab 0.5

Focal length 50 mm
Aperture range f2.0 – f22
Angle of view (horiz./vert./diag.) 38° / – / 45°
Construction 8 elements in 6 groups
# of aperture blades n/a
Closest focus distance 0.24 m
Maximum reproduction ratio n/a
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This is a light, compact lens made mostly out
of plastic, and looks appropriately cheap. The
focus ring has too much play and too little
travel for precise focusing. General repro-
duction is poor at maximum aperture and in-
cludes obvious vignetting. Performance is
much better at smaller apertures and  pro -
duces pleasing bokeh when stopped right
down. This lens is not up to Leica or Zeiss
standards, but acceptable for the price.

Canon EF 50mm f1.4 USM

Zeiss Planar T* 50mm f1.4 ZE

Canon EF 50mm f1.4 USM

This lens has the usual excellent Zeiss build
quality but produces soft detail and visible
 vignetting at maximum aperture, making it
inferior to the comparable Canon. This lens
is only really suitable for shooting portraits
and has to be stopped right down in order
to  produce edge definition better than that
of the competition. A paradoxical lens that
is weakest in the areas it was designed to
excel in.

Zeiss Planar T* 50mm 
f1.4 ZE
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Focal length 50 mm
Aperture range f1.4 – f22
Angle of view (horiz./vert./diag.) 40° / 27° / 46°
Construction 7 elements in 6 groups
# of aperture blades 8
Closest focus distance 0.45 m
Maximum reproduction ratio 0.15

Focal length 50 mm
Aperture range f1.4 – f16
Angle of view (horiz./vert./diag.) 38° / – / 45°
Construction 7 elements in 6 groups
# of aperture blades n/a
Closest focus distance 0.45 m
Maximum reproduction ratio n/a
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This is a big, heavy, high-quality lens that pro-
duces great detail right across the aperture
range. The slight chromatic aberrations it
 produces are acceptable, given the very wide
maximum aperture. All lens errors disappear
below f2.8. Set to f1.4, this lens is just as good
as its wide-aperture competitors and is directly
comparable with the Zeiss and Leica macros at
minimum aperture. The overall picture is  round -
ed out with excellent bokeh and the best
depth of field blur of all the lenses we tested.

Canon EF 85mm f1.2L II USM
Canon EF 85mm 
f1.2L II USM
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This lens disappoints when compared directly
with other Zeiss offerings. It produces obvious
chromatic aberrations, and edge sharpness is
only adequate at maximum aperture. Up to f2,
the soft look this lens produces is more suitable
for portrait shots, but performance improves
with smaller apertures and reproduction is
 generally excellent at f8. The differences
 between this lens and its much older Contax
equivalent are surprisingly small.

Zeiss Planar T* 85mm f1.4 ZE
Zeiss Planar T* 85mm 
f1.4 ZE
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Focal length 85 mm
Aperture range f1.4 – f16
Angle of view (horiz./vert./diag.) 24° / – / 29°
Construction 6 elements in 5 groups
# of aperture blades n/a
Closest focus distance 1.0 m
Maximum reproduction ratio n/a

Focal length 85 mm
Aperture range f1.2 – f16
Angle of view (horiz./vert./diag.) 24° / 16° / 29°
Construction 8 elements in 7 groups
# of aperture blades 8
Closest focus distance 0.95 m
Maximum reproduction ratio 0.11
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This old Zeiss-Contax lens with its adapter
seems to be just as good as the new Zeiss ver-
sion. It shows only slightly less edge sharp-
ness at maximum aperture, but produces
much less chromatic aberration. The lens has
the same soft look at wide apertures as its
newer cousin, but its performance improves
the same way with each further stop down
the scale. Performance at f8 is excellent. If you
are prepared to deal with its slightly more
complicated handling, a used lens of this type
is a great value alternative to the new Zeiss
version. If you own this lens, it is worth

 experimenting with different adapters to see
which produces the best results.

Zeiss Contax Planar T* 85mm f1.4

Canon EF 100mm f2.8 Macro USM

Zeiss Contax Planar T* 
85mm f1.4

Canon was unable to lend us the new, image-
stabilized version of this lens, so we tested
the older USM version instead. Performance
was fine at maximum aperture, showing only
slight chromatic aberration and slight image
quality drop-off at the edges of the frame.
These problems disappear at smaller apertures.
We can wholeheartedly recommend this lens
for use with full-frame cameras.

Canon EF 100mm f2.8 Macro
USM
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Focal length 85 mm
Aperture range f1.4 – f16
Angle of view (horiz./vert./diag.) – / – / 29°
Construction 6 elements in 5 groups
# of aperture blades 8
Closest focus distance 1.0 m
Maximum reproduction ratio n/a

Focal length 100 mm
Aperture range f2.8 – f32
Angle of view (horiz./vert./diag.) 20° / 14° / 24°
Construction 12 elements in 8 groups
# of aperture blades 8
Closest focus distance 0.31 m
Maximum reproduction ratio 1
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This is the current version, built in 1998. The
lens has excellent build quality, but is quite
heavy. It also has a built-in, slide-out sunshade.
The Apo-Elmarit still deserves its reputation
as a reference lens, producing sharp, high-
contrast detail throughout the whole aperture
range and across the entire frame. Image
quality deteriorates – although only slightly –
at very small apertures due to the unavoidable
internal refraction these cause. The  apo -
chromatically corrected glass completely
 eliminates color errors at all apertures.
 Focusing is reliable and extremely precise.

Leica 100 mm f2.8 Apo-Macro-Elmarit-R

Leica 100mm f2.8 
Apo-Macro-Elmarit-R
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This lens produces excellent detail and micro-
contrast across the whole aperture range.
Only the chromatic aberrations it produces
wide open spoil its otherwise excellent
 performance. We found slightly more color
errors than we did using the 100mm Leica,
but this doesn’t spoil the overall warm color
reproduction or the very pleasing bokeh.

Zeiss Makro-Planar T* 100mm f2 ZE
Zeiss Macro Planar T* 
100mm f2 ZE
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Focal length 100 mm
Aperture range f2.2 – f22
Angle of view (horiz./vert./diag.) 20° / 14° / 24°
Construction 8 elements in 6 groups
# of aperture blades n/a
Closest focus distance 0.45 m
Maximum reproduction ratio 0.5

Focal length 100 mm
Aperture range f2.0 – f22
Angle of view (horiz./vert./diag.) 21° /  – / 25°
Construction 9 elements in 8 groups
# of aperture blades n/a
Closest focus distance 0,44 m
Maximum reproduction ratio 0,5



Color Reproduction

The Leica lenses we tested all tend to produ-
ce somewhat cooler colors, while the Zeiss
lenses tend to produce a warmer overall look
than their Canon counterparts.

Wide-angle Lenses

Canon’s wide-angle lenses do not fully illumi-
nate the outermost corners of the Canon full-
frame image sensor, producing edge artifacts
that cannot be eliminated during processing.
We do, however, recommend the 16–35mm
zoom for use with smaller sensors.

We were disappointed that Canon wasn’t
able to lend us the current version of their
professional 35mm tilt/shift lens, although
the results produced by the Zeiss 21mm are
better anyway. Our tests showed that even
an interpolated, cropped detail of a Zeiss
image was sharper than the shifted Canon
version. We assume that the new version of
the Canon lens will produce better results.

Neither the 21mm nor the 28mm Leica
lenses did a convincing job with our 21-
 megapixel camera, and only the Zeiss really
did justice to the large, high-resolution sen-
sor. The 21mm ZE was a clear winner in this
segment, producing spectacular results with
great definition in spite of its very wide angle
of view. Our testers also liked the 28mm
Zeiss ZE. In the 35mm arena, the almost 40-
year-old Leica produced astonishingly good
results.

Standard Lenses

The differences in quality between manual
and autofocus standard lenses are not as
great. Only the near-perfect 50mm Zeiss, with
its excellent microcontrast and wonderful
bokeh, is a reason to cold-shoulder the auto-
focus option. For use at smaller apertures, the
good value 60mm Leica macro is a fine option
that produces images with their own unique
look. The f1.4 Canon performed better than
its cheap appearance led us to expect,
 although it only really starts to perform at f1.8
and lower.

Telephoto Lenses

We found the performance of the two bright
(f1.4) Zeiss telephotos disappointing. Both
lenses are well built and are certainly suitable
for portrait use, where the results depend on
soft bokeh rather than extremely precise
 detail. Performance improves dramatically
beyond f5.6. As already mentioned, a used
Zeiss-Contax makes a good value alternative
to a new Zeiss ZE lens. 

The 85mm L-Canon proves that you 
can produce high-quality images at wide
apertures. This lens is a great choice for 
available light photography, but comes at a
significant price. It is interesting to note that
the focus ring adjusts focus via the camera’s
autofocus system rather than directly. This
makes manual focusing smooth and fast 
but the absence of the tactile precision of a

 purely mechanical lens is very noticeable.
We recommend that you switch autofocus
on when using this lens.

All of the 100mm macro lenses we tested
produced great results. The bright, easy-to-
use Zeiss would have taken the prize had it
not had a tendency to produce chromatic
aberrations. In the end, the Leica’s  un -
compromising quality, even as a repro lens,
proves its supremacy and gives it the edge
over the others.

Conclusions 

Manual lenses are definitely the best
 alternative for demanding wide-angle
 photographers. In this segment, the Zeiss ZE
lenses are state-of-the-art. The manual
 advantage is less obvious in longer lenses,
but if absolute image quality is important to
you, we recommend you test some of these
lenses for yourself.

Apart from the older Leicas, most of the
manual test lenses performed better than
their autofocus counterparts. The exception
was the 85mm Canon, which produced
 clearly better results than its manual rivals. If
you plan to acquire an older lens for use with
an adapter, make some test shots before you
buy.
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Results

Taken with the Canon 24mm TS-E in its shifted position The same detail, shot using the Zeiss 21mm and subsequently enlarged
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This handheld shot taken with the Zeiss ZE
50mm Macro at maximum aperture displays
great microcontrast and very nice bokeh



The interior of the Hanover town hall,
shot using the Zeiss 21mm ZE
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Zeiss und Leica in everyday use

Various reports had led us to believe that
the 21mm and 28mm Leica lenses would
perform better than they did. We used three
different adapters to eliminate the dis -
crepancies a substandard adapter can pro-
duce, but neither lens met our expectations.
It is possible that we were just unlucky and
that our test lenses had suffered damage
that was not externally visible but that had
 nevertheless knocked some lens elements
off-center. Physical damage is a problem
that users of modern plastic lenses will have
to deal with more often than owners of
older, more solidly built lenses. 

Leica’s reputation for high build quality is
impressively underscored by the 35mm and
100mm Apo-Elmarit lenses, although some
Leica brand lenses—the 28mm in our test, 
for example—are in fact manufactured by
Schneider Kreuznach. The fact that older
 lenses were designed for use with the more
forgiving medium of film make them prone
to producing optical errors that image sensors
pick up more easily. If you are planning to
acquire a used lens, either make some test
shots before you buy or make sure the dealer
will allow you to return a lens if it produces
substandard results. 

The Leica R-system is no longer being
 developed and these lenses are now only
available pre-owned, so if you are lucky, 
you can pick up a bargain for use with an

adapter. We recommend the Novoflex Leica
adapter, in spite of its somewhat unstable
 locking lever. There is a wide range of Leica
focal lengths available, and many newer
 lenses—especially wide-angles—have new
geometries that make them at least as good
as similar Zeiss offerings. The problem with
many Leica lenses is that they are difficult to
mount on DSLRs without making serious
modifications to the mount, the camera
 mirror, or both. Compatible Leica telephotos
are easier to find. The legendary Apo 180mm
f2.0, Apo-Summicron 90mm f2.0 ASPH, and
the longer Apo-Telyt series still produce
 unparalleled results.

The compact Leica M-series lenses are
especially well suited to use with Micro Four
Thirds and other mirrorless systems. The Zeiss
ZE lenses are much easier to use than adapter-
based systems, and usually allow you to
 control the aperture via the camera and
transfer lens Exif data to the camera’s
 electronics. The Z-series lenses also support
viewfinder focus indicator functionality,
which makes focusing easier once you are
 familiar with the necessary hand/eye coordi-
nation. Zeiss Z-series lenses are not cheap,
but offer quality that justifies the expense.

The Manual Lens Look

Manual lenses really come into their own in
everyday photographic situations. The high
definition and precise detail that Leica and

Zeiss lenses produce cannot be reproduced
on a test bench. Some of our trickier test
shots underscore these qualities and some
of the resulting images are of a quality that
we would expect from a medium format
 camera.

Some reasons for this extremely high
quality could be the manufacturer’s own
build tolerances, the extreme efforts made
to reduce internal reflections, or reduced
lens play due to the lack of additional auto-
focus elements. Whatever the reasons, the
behavior of our test lenses in backlit situations
speaks volumes about the quality of the
 products. While the Canon wide-angles all
show washed-out edges, the Zeiss lenses all
produce consistently good edge detail,
 albeit with accompanying color fringes that
have to be removed at the image processing
stage.

Bokeh

The different ways lenses reproduce out-of-
focus background detail is another reason
why many digital photographers have begun
experimenting with manual lenses. We were
surprised—not only by the differences in
bokeh produced by our Leica and Zeiss test
lenses, but also by the amount of back-
ground detail that modern lenses obviously
miss. Today, manual lenses are helping to
realize the true photographic potential of
large, high-resolution image sensors

The Zeiss 21mm ZE produces great
detail across the entire frame. The
highlights in the window frames and
the chandelier are detailed and not at
all washed out. Edges and fine textures
are reproduced cleanly, even at the
outermost edges of the frame.

Reasons to “Go Manual”
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Once again, this detail enlargement from a shot made with
the 21mm Zeiss shows extremely fine detail. The child’s
hair and the leaves in the background are extraordinarily
well defined in spite of the strong backlight.

“Taking photos with manual lenses was a
lot of fun once I got used to the different
working style. The whole photographic
process slowed down and the view
through the viewfinder forced me to look
at my subject more carefully, and to take
more care framing and focusing my
shots. All in all, the manual aspect turns
taking photos back into a considered
creative act.”

(The author’s opinion after spending three
months using manual lenses)

c
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Thomas Saur

Creating Your
Own Preset Looks 
in Photoshop Lightroom

In the past, the optical or chemical tricks that professional photographers and
camera operators used to create their own special look were often their best-kept
secret. Nowadays, modern image processing software—such as Adobe’s
Photoshop Lightroom—gives ambitious photographers all the tools they need to
create their own, highly personal looks.





Creating a Look Using
Photoshop Lightroom

The current version of Photoshop Light-
room includes a wide range of tools for
manipulating RAW image files in ways that
go far beyond the possibilities offered by
an analog photo lab. Used creatively, the

software can help create familiar or com-
pletely new looks for your images.

Shooting Formats

The basis of every finished image is the
 original photo, and I strongly recommend

that you always shoot in RAW format.
Strictly speaking, the steps I am going to
describe can just as well be applied to JPG
image files, but the results will be of much
lower quality. 

At a first glance, RAW images generally
appear somewhat bland and lifeless, but
they can nevertheless be manipulated in 
a much more targeted fashion than JPG
images that have already been pre-processed
by the camera’s firmware. JPG images are
intrinsically lossy, especially if you use the
camera’s built-in functionality to adjust con-
trast or sharpness, or if you apply camera
presets such as ”Retro“, ”Monochrome“, or
”Vivid“ while shooting. Any pixel information
or tonal values that are manipulated during
shooting cannot be recreated in their
 original form using software.

RAW format image files are the best
choice, as they contain virtually all the
 information captured by the sensor during
the exposure. If your camera doesn’t
 support RAW shooting, setting the camera
to shoot neutral, non-sharpened, low-
 contrast images will provide you with the
best material for subsequent optimization
on your computer.

One of Lightroom’s best features is that
all processing steps are non-destructive.
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The Blacks slider can be used to quickly and simply increase
the contrast and general impact of your image

Navigator
window with

real-time
image

preview

Presets panel Image window Library Develop module with
tool panels



This means that, should you make a mistake,
you can undo every individual processing
step without affecting the quality of your
image. The original image file also remains
unchanged, and you can even save your
processing steps separately in an XML file.
This saves disk space and ensures high-
quality results.

The Lightroom Workspace

The Lightroom user interface is divided into
five modules called Library, Develop, Slide-
show, Print, and Web.

On the following pages, we will be con-
centrating on the Develop module. When
the Develop module is activated, you will
see two vertical palettes arranged to the
left and right of the image preview window.
These can be shown or hidden using the
Tab key, leaving more space on the
 desktop for the image preview. The left-
hand palette contains a small preview
window for quick image navigation and
the Presets panel, where we will be saving
and adjusting the looks we are going to
create during this workshop. The Snapshot
and History panels are located beneath the
Presets panel. 

The right-hand palette contains various
image processing panels with countless
tools for manipulating your images. 
Let’s start by looking at the Basic panel.

Exposure and Brightness

The sliders in this panel do exactly what
they say. Once you have set global bright-
ness, you can adjust the contrast in your
image. You can also give your image a little
more brilliance by shifting the Shadows
 slider in the Tone Curve panel slightly to
the right. This not only increases luminance,
but also intensifies the colors. If this
 doesn’t fit with your intentions, you can
 always reduce saturation slightly to com-
pensate.

If you want to emphasize shadow and
highlight detail, you can also extend the
contrast range of your image, but you will
probably then have to shift the Fill Light
slider a little to the right in order to preser-
ve shadow detail. The Recovery slider can
be used to restore burned-out highlights,
such as an over-bright sky. These correcti-
ons are all very similar to the standard ad-
justments often made in analog photo
labs.

Unfortunately, Lightroom tends to
 produce some edge artifacts when you
 adjust contrast for high-contrast subjects.

We know Adobe can do better, and the
Shadow/Highlight slider in Photoshop
 produce cleaner results. An additional
 radius adjustment (like the one built into
Photoshop) could help to regulate these
types of anomalies.

The distribution of tonal values can also
be adjusted using the parametric curve in
the Tone Curve panel. This tool is basically
identical to its Photoshop cousin, although
its handling is slightly different. Here, you
can adjust the curve using four sliders cal-
led Highlights, Darks, Lights, and Shadows.
This approach is very useful in certain
 situations and, by adjusting only the Lights

and Darks sliders, allows you to increase
image contrast without losing shadow or
highlight detail. It requires a lot more
 experience and know-how to make similar
adjustments using Photoshop’s point-
based Curves tool.

Using Clarity Settings to
Optimize Portraits
The Clarity slider provides a fascinating
way to influence the look of an image, pro-
viding functionality similar to that of a
wide-area “Sharpen” or “Soft Focus” filter.
The tool also uses a larger radius than the
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The dynamic range in this image was too broad. We used the Fill Light and
Recovery sliders to counteract this, resulting in the building appearing brighter
and the clouds looking more dramatic and three-dimensional.

This highly magnified detail of the image above shows the edge artifacts
that a significant increase in contrast can cause.





Sharpen and Detail filters, leaving fine
 detail virtually untouched. If you shift the
Clarity slider all the way to the left, you
produce a soft, overexposed effect that is
great for portraits. The further you shift the

slider to the right, the harder the contours
become and, at the extreme right-hand
end of the scale, your image can end up
looking almost like a woodcut print. If
combined with a grayscale effect, this filter
produces images with hard edges that
look a lot like push-processed monochrome
prints. You need to be careful when
 applying this effect in large doses, and it is
best suited to highly detailed landscapes
or character portraits. Be warned—high
Clarity values emphasize skin imperfections,
and low Clarity values are much better 
for producing flattering portraits or for
 glamour work. Slight shifts to left or right
of center produce effects similar to those
produced if you use a soft focus or a
 particularly sharp lens while shooting. The
contrast slider produces a different effect,
due to the fact that it functions globally
and doesn’t just affect edge detail.

Colors

Lightroom includes so many different ways
to manipulate colors that to describe them
all would go way beyond the scope of this
article. I hope to whet your appetite with
the small selection described here. You can
adjust color temperature (essentially white
balance) in the Basic panel using the drop-
down list of presets located to the right of
the “WB” symbol. Most users select either

“As Shot“ or “Auto“, but you can also select
settings for most other conventional light
sources (such as “Daylight“, “Cloudy“,
“Tungsten“ etc.).

You can use the White Balance Selector
tool located in the upper left corner of the
panel to select a color to use as a reference

77c’t Digital Photography 1 (2010) 

Analog Film Looks | Creating your own Looks

The Clarity slider can be used to change the look of a portrait from a soft glow right up to a hard-edged,
almost solarized look.

Negative Clarity values can make candid
portraits more flattering too

The “Before/After” button in the toolbar
allows you to quickly judge the effects your
adjustments will have



white point, and it is definitely worth expe-
rimenting with different reference colors
to see what new looks you can produce. If
you deliberately select a non-white color
as your white balance reference, all colors
in the image will be shifted accordingly.
You can then fine-tune your results using
the Temp and Tint sliders.

The lower part of the Basic panel
 contains the global Saturation slider, which
adjusts all colors to the same degree,
 irrespective of whether they are more or
less saturated to begin with. High color
 saturation values can cause saturation
overflow and tonal clipping. The Vibrance

slider is located above the Saturation slider
and offers a slightly less severe way to in-
crease image saturation. This tool increases
saturation for highly saturated colors 
less than for less saturated colors, and is
especially kind to skin tones. Using Vibrance
intensifies colors in a balanced way.

Targeted Color Manipulation

The adjustments we have addressed so 
far all have a global effect on the color
temperature and overall color balance in
an image. If you want to target and adjust

individual colors (for example, the blue of
the sky) you will need to switch to the
HSL/Color/Grayscale panel. The color panel
can be used to adjust hue, saturation, and
luminance for each major color channel.
The HSL panel offers the same adjustments
approached from a different angle,
 allowing you to adjust hue, saturation, and
luminance separately for each individual
tone.

The HSL panel also includes the very
useful Targeted Adjustment tool. Clicking
on the circle symbol in the upper left
corner of the panel activates the tool, which
you can then drag to the part of the image

78 c’t Digital Photography 1 (2010) 

Analog Film Looks | Creating your own Looks

We created this blue look by experimenting with the White Balance Selector
tool. A little additional manual correction completed the new image.

The Targeted Adjustment tool allows you to adjust individual colors—here the blue of the sky—by dragging
the mouse up or down through the appropriate part of the image.

Fake colors, great look



you want to adjust. In our example, we
want to adjust the blue of the sky. Clicking
on the color you want to adjust selects
exactly that color automatically. Dragging
the cursor up or down then adjusts the
hue of all similar colors within the image,
and the panel sliders are adjusted auto -
matically to correspond with any changes
you make. You can adjust saturation and
luminance of individual colors in the same

way. This is an intuitive and simple way to
try out alternative colorways. Once you
have finished making adjustments, a single
click on the Targeted Adjustment symbol
deactivates the tool.

Grayscale Images

A black-and-white photo is more than just
a de-saturated color image. The emulsions

that classic monochrome films are made of
have differing sensitivities to different
parts of the visible spectrum. The different
sensitivity of panchromatic and ortho -
chromatic films combined with the use of
various color filters enhances the multi-
 facetted effects black-and-white images
can have.

A bland color photo often makes an
 interesting and impactful monochrome
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Here, we altered the colors using the Targeted Adjustment tool. This a simple way to create really impressive effects,
as a comparison with the original image (above) shows.



image once it has been converted. While
you are working in the HSL/Color/Grayscale
panel, pressing the “V” key toggles bet-
ween grayscale and color versions of the
active image. In order to perform targeted
adjustments to a grayscale image, it is best
to switch to the Grayscale Mix tool in the
HSL/Color/Grayscale panel. Once selected,
the panel displays the sliders for adjusting
the individual grayscale channels. This is

where you can control how the individual
colors in the source image are converted
into grayscale tone values, similar to the
way a monochrome film records different
color tones.

This panel also displays the small but
marvelous Targeted Adjustment symbol.
If we activate the tool in a part of our
sample image that contains sky, dragging
the cursor downward reduces the bright-

ness of original blue color. This action
also reduces the sensitivity for all blue
tones within the image, as you can
 confirm by looking at the Blue slider,
which automatically moves to the left.
Our sky is now darker and provides a
much more dramatic backdrop for the
clouds. In the old, analog world, using an
orange filter on the camera lens caused
the same effect as the one we have just
produced, with subtractive color mixing
making the filter’s complementary color
appear darker.

You can adjust the other tones in an
image (such as the greens of vegetation
or skin tones) in the same way, although
the new mood that the image takes on
might require you to make additional
 adjustments to exposure, brightness,
 contrast, or clarity. The interplay between
the settings we have described provides an
almost inexhaustible range of possibilities
for changing the look of your image. It is,
however, a good idea to periodically
zoom into a 100% view to check whether
your more extreme adjustments have
produced any unwanted image artifacts.
The individual color channels in a camera’s
sensor can produce different levels of
noise which can affect the look of your
image. You can use the Noise Reduction
tool in the Detail panel to counteract
some noise effects if you adjust both the
Luminance and Color sliders. Sensor noise
can even produce a grain-like effect in
black-and-white mode but, if this is the
case, I recommend that you experiment
with higher Amount and Detail values
(with lower Radius settings) in the Sharpe-
ning panel rather than applying noise
 reduction.

Home-made Grain

Monochrome conversions of low-sensitivity
digital images often appear somewhat
bland. You can counteract this blandness
by applying an analog grain effect to your
image during post-processing.

Unfortunately, a grain tool is only due
to be introduced in the next (3.0) version
of Lightroom, so we have included some
grain-based Photoshop actions for you to
experiment with on this issue’s free DVD.
The actions can be found in the Film
Looks folder and are compatible with
Photoshop version CS2 and later. You can
load the actions into the Action palette
using the “Action > Load” command and,
once you have loaded your image in
 Photoshop and applied the action, you
can regulate the intensity of the grain
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A monochrome look with low Clarity values



 effect by adjusting the transparency of
the grain layer. You can also apply a scan
of a real negative to an image using a
Photoshop “Overlay” layer or using one of
the programs or plug-ins described in the
article on page 90.

The Split Toning Panel

This panel is also a great tool for creating
your own color and grayscale photo looks.
The panel allows you to adjust shadow
and highlight color independently and 

it is definitely worth spending some time
familiarizing yourself with the different
effects that differing shadow and highlight
tones and saturation values can have. The
Balance slider also helps you to strike the
right compromise between your shadow
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The Targeted Adjustment tool is also available in grayscale mode and allows you to adjust the color sensitivity
of individual grayscale tones in a very intuitive way.

For this image, the conversion to high-contrast monochrome is a great improvement.



and highlight settings. When applied 
to color images, Split  Toning can produce
very pleasing color casts that are often
 reminiscent of retro-style film looks. 
If you use Split Toning on grayscale
images you can produce just about any
tone you can imagine as well as more
 familiar toning effects such as sepia, cyan,
or selenium.

Using Vignettes to Create 
a Retro Look

In addition to using color shifts and  gray -
scale tones to produce retro looks, you can
also use the Vignettes panel to give your
images a nostalgic look and feel. Negative
vignette values darken the edges of your
image and produce an effect similar to
those caused by old, non-corrected lenses,
while positive values brighten the edges of
the image area.

Selective Processing using Brushes 
and Gradients

You can use the Adjustment Brush and
Graduated Filter tools (located in the Tool
Strip above the Adjustment Panels) to
 selectively apply adjustments to exposure,
brightness, contrast, saturation, clarity,
sharpness, and color to your image. The
brush strokes and gradients you draw
serve as masks for the effects you apply,
and you only need a little painting skill 
to achieve some really fascinating effects.
For example, applying negative clarity
and sharpness values to the edges of 
an image simulates a look very much 
like that produced by old photographic
lenses.

Saving and Managing 
Your Own Looks

The Presets panel is located beneath the
Navigator window, and clicking on the “+”
symbol in the upper right corner opens the
New Develop Preset dialog which you can
then use to name and save your current
settings. If you don’t select a new folder
when saving a preset, the program auto-
matically saves your preset to the “User
Presets” folder. 

In order to retain an overview of your
work, we recommend that you create
new folders with meaningful names for
each new project. It is also important to
activate appropriate settings for inclusion
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Sharpness and noise can be adjusted in the Detail panel. Photoshop is better
than Lightroom for performing targeted sharpening.

Both positive and negative vignette effects produce a pleasing
nostalgic feel.



in your preset. If you want to duplicate
your look exactly for other images, click
the “Check All” button, but you can also
uncheck certain parameters if you want to
keep particular settings flexible in future
images. Once you have clicked the “Create”
button, your look will appear in the
 Presets panel in the folder you selected
above. 

The Navigator window above the
 Presets panel shows a real-time preview
of your look, applied to the active image.
This allows you to quickly get an idea of
how each preset will affect your image
before applying it. 

You can also import the looks included
on this issue’s free DVD by right-clicking
(or for Mac, Control-clicking) on one 
of the Presets folders and selecting the
“Import…” command from the context
menu that pops up. You can import
 multiple presets, but not multiple folders. 

If you want to import multiple folders,
you can do this by copying them to the
“Ligthroom > Develop Presets” folder
using operating system commands.

Using Your Preset Looks

Experienced Lightroom users keep a stock
of useful presets loaded so that they can
quickly and easily apply the appropriate
virtual emulsion to a shoot. You can also
apply a look to multiple images by
selecting them in the Library and applying
the appropriate preset using the
 “Develop Settings” command in the
 context menu. 

The context menu also includes a “Create
Virtual Copies” command that allows 
you to save and manage different versions
of your image without using extra disk
space.

Conclusions

Today’s creative photographers will revel in
the almost unlimited image manipulation
options offered by Lightroom 2.6. It is 
well worth spreading your wings a little,
especially in light of the fact that many
well-known analog film looks such as

cross-processing or pseudo-solarization
were discovered by accident in the lab. 

And remember: the program’s non-
 destructive architecture means you needn’t
be afraid of making mistakes.

Our Preset Looks on DVD

The Film Looks folder on this issue’s free
DVD includes more than 100 Lightroom
Develop Presets for you to try out. These
presets were created for images shot
using various cameras and can produce
varying results, depending on the image
size, the RAW format used, and the
 subject of your image. Our presets are 
all open source, so you can use them as 
a starting point for your own experiments
too. 

If you create a particularly interesting
version for your camera or image type,
please feel free to send it to me at
foto@tsamedien.de. We will present the
best looks at www.tsamedien.de/foto and
offer them to our readers for down  load.
The following pages include samples of
some of the looks you can find on the
free DVD. (ae/rez)
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The base color in this image is determined by the balance between
the split highlight and shadow tones.

The Adjustment Brush and the Graduated
Filter tool can be used to “paint” settings
directly into the image.
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01_TSA_Classic_bw 02_TSA_Cross_green 03_TSA_Dia_color_magenta

04_TSA_Dia_vivid 05_TSA_old_Dia_green 06_TSA_Old_sepia_BW

07_TSA_Retro_Vignette 08_TSA_Soft_BW 09_TSA_soft_color

TSA_Filmlook_Essentials:
A selection of some of the most useful looks and presets, some of which
also appear in the collections that follow
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01_TSA_Filmlook_colorS 02_TSA_Filmlook_colorS 03_TSA_Filmlook_colorS 04_TSA_Filmlook_colorS

05_TSA_Filmlook_colorS 07_TSA_Filmlook_colorS 08_TSA_Filmlook_colorS 09_TSA_Filmlook_colorS 10_TSA_Filmlook_colorS

11_TSA_Filmlook_colorS 12_TSA_Filmlook_colorS 13_TSA_Filmlook_colorS 14_TSA_Filmlook_colorS 15_TSA_Filmlook_colorS

16_TSA_Filmlook_colorS 17_TSA_Filmlook_colorS 18_TSA_Filmlook_colorS 20_TSA_Filmlook_colorS 21_TSA_Filmlook_colorS

22_TSA_Filmlook_colorS 23_TSA_Filmlook_colorS 24_TSA_Filmlook_colorS 25_TSA_Filmlook_colorS 26_TSA_Filmlook_colorS

TSA_Filmlook_colors:
A collection of different combinations of (realistic) color and
contrast settings

The source image
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The source image 01_TSA_Filmlook_coloFX 02_TSA_Filmlook_coloFX 03_TSA_Filmlook_coloFX 04_TSA_Filmlook_coloFX

05_TSA_Filmlook_coloFX 06_TSA_Filmlook_coloFX 07_TSA_Filmlook_coloFX 08_TSA_Filmlook_coloFX 09_TSA_Filmlook_coloFX

10_TSA_Filmlook_coloFX 11_TSA_Filmlook_coloFX 12_TSA_Filmlook_coloFX 13_TSA_Filmlook_coloFX 14_TSA_Filmlook_coloFX

15_TSA_Filmlook_coloFX 16_TSA_Filmlook_coloFX 17_TSA_Filmlook_coloFX 18_TSA_Filmlook_coloFX 19_TSA_Filmlook_coloFX

TSA_Filmlook_colorFX:
Extreme color effects, including cross-processing, neon, pop art etc.
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01_TSA_Filmlook_BW 02_TSA_Filmlook_BW 03_TSA_Filmlook_BW 04_TSA_Filmlook_BW 06_TSA_Filmlook_BW

09_TSA_Filmlook_BW 10_TSA_Filmlook_BW 11_TSA_Filmlook_BW 12_TSA_Filmlook_BW 13_TSA_Filmlook_BW 14_TSA_Filmlook_BW

15_TSA_Filmlook_BW 16_TSA_Filmlook_BW 17_TSA_Filmlook_BW 18_TSA_Filmlook_BW 19_TSA_Filmlook_BW 20_TSA_Filmlook_BW

22_TSA_Filmlook_BW_
sky01

23_TSA_Filmlook_BW_
sky02

24_TSA_Filmlook_BW_
dark_sky

28_TSA_Filmlook_BW_
TryX_Standard_dunkel

The source image

24_TSA_Filmlook_BW_
TryX

25_TSA_Filmlook_BW_
TryX_hell

26_TSA_Filmlook_BW_
TryX_HighKontrast

27_TSA_Filmlook_BW_
TryX_Standard

TSA_Filmlook_BW:
A selection of black-and-white looks with differing color 
sensitivity and contrast, as well as differing degrees of shadow
and highlight detail.
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The source image 01_TSA_Filmlook_Retro_BW 02_TSA_Filmlook_Retro_BW 03_TSA_Filmlook_Retro_BW

04_TSA_Filmlook_Retro_BW 05_TSA_Filmlook_Retro_BW 06_TSA_Filmlook_Retro_BW 07_TSA_Filmlook_Retro_BW

08_TSA_Filmlook_Retro_BW 09_TSA_Filmlook_Retro_BW 10_TSA_Filmlook_Retro_BW

TSA_Filmlook_Retro_BW:
A selection of retro-style monochrome emulations, some
of which include heavy vignette, edge, und glow effects
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The source image 01_TSA_Filmlook_Retro 02_TSA_Filmlook_Retro 03_TSA_Filmlook_Retro 04_TSA_Filmlook_Retro

05_TSA_Filmlook_Retro 06_TSA_Filmlook_Retro 07_TSA_Filmlook_Retro 08_TSA_Filmlook_Retro 09_TSA_Filmlook_Retro

10_TSA_Filmlook_Retro 11_TSA_Filmlook_Retro 12_TSA_Filmlook_Retro 13_TSA_Filmlook_Retro 14_TSA_Filmlook_Retro

15_TSA_Filmlook_Retro 16_TSA_Filmlook_Retro 17_TSA_Filmlook_Retro 18_TSA_Filmlook_Retro 19_TSA_Filmlook_Retro

20_TSA_Filmlook_Retro 21_TSA_Filmlook_Retro 22_TSA_Filmlook_Retro 23_TSA_Filmlook_Retro 24_TSA_Filmlook_Retro

TSA_Filmlook_Retro_Color:
Color retro-style effects including radical color shifts, simulated bleaching, and faded
Polaroid, vignette and glow effects. Some of these looks include Brush and Gradient
filter effects, so please reset these in the context menu (reached via a right click) before
applying a different preset to your original image.

c

Analog Film Looks | Film Look Presets
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Sascha Steinhoff

Software-based 

Analog Film Emulation
The time will probably come when we have all had enough of the super-polished look
of our digital images. This is the right moment to revive the aesthetics of the analog
past and use software plug-ins to emulate the look of legendary Kodak, Ilford, Orwo, 
or Polaroid films.



In the past, a photographer’s choice of
film had a strong influence on the look 

of an image but today’s digital world 
has, in contrast, become almost drearily
monotonous. Many photographers hanker
for the times when every change of film pro-
duced a new and exciting look—although
the love of all things analog seldom stret-
ches to actually taping up the bathroom
windows and once again splashing about
with chemicals in a home darkroom. With
the right software you can give your digital
images an analog look in an environmen-
tally and user-friendly way.

Image editing programs, such as Adobe
Photoshop and Nikon Capture NX2, include
filters for adding grain to images during
post-processing. The Nikon filter is actually
called Add Grain/Noise and does exactly
what it says, although it doesn’t include
profiles for individual film types. Photoshop
doesn’t provide individual film profiles
 either, and the effects produced by its
 Texture > Grain and Stylize > Emboss filters
don’t really look like analog film grain at all.

If you have the time and the know-how
you can, of course, use Photoshop to pro-
duce just about any effect you can imagine
(see also page 68), but specialized software
is an easier alternative,  and there are a
 surprising number of film simulation tools
available. The ones we describe here are 
all capable not only of adding grain to
images, but also of reproducing the specific
color characteristics of individual film
types. Many of the programs on the market
support either grain or film-type effects,
but Grubba Software’s TrueGrain (US$49.95),
Alien Skin’s Exposure 2 (US$249.00), Nik
Software’s Silver Efex (US$199.95) and 
Color Efex (US$299.95), and DXO’s FilmPack
(US$99) are the only ones we could find
that do both. The freeware program
VirtualPhotographer also provides some
film looks to experiment with.

TrueGrain – 
Real Scanned Grain instead of
Digitally-generated Noise

Grubba Software’s TrueGrain takes the
 unconventional step of forcing its users to
download six files which then have to be
installed in the correct order! The program
itself is only 2MB, but the five additional
film packs use up a whole gigabyte of 
disk space. You will need a broadband
connection to acquire a copy of TrueGrain
as it is only available via download.

TrueGrain is a standalone program and
doesn’t integrate into the operating

 system or other programs like a plug-in,
making it fast and easy to use. The
 program’s simplicity is also due to the
 relatively small number of film profiles
and options it offers. Compared to DxO’s
50-odd films, TrueGrain’s range of just 
16 black-and-white profiles is a little
 disappointing. TrueGrain only supports
monochrome profiles and, while it offers
a profile for Fuji’s Neopan 400, it doesn’t,
for some reason, include Kodak’s much-
loved T-MAX 100. 

TrueGrain uses a unique approach to
producing authentic-looking film profiles.
Its grain structures are not generated digi-
tally, but are instead based on empirical
information collected from scans of real
analog images made using the original
films. The program even includes individual
profiles for the different formats available
for each film type—for instance, for
 Kodak’s T-MAX 400, you can choose
 between six different grain profiles,
 ranging from 110 pocket format right up
to 6 x 8 medium format, and, of course,
 including the classic 35mm stock. These
individual profiles are, however, all based
on scans taken from the same 6 x 9 original,
with the smaller formats simply using a
cropped detail from the original in order
to ensure that the grain size remains
 correctly proportioned. The Ilford Delta
3200 profile is, unfortunately, based on a
slightly damaged negative. The resulting
irregularities in the grain structure can
actually increase the authenticity of an
 individual image, but might be irritating
to a more observant viewer if they showed
up in consecutive images of a batch. 
The Delta 3200 profile was the only one in
our test that displayed such anomalies,
and—it has to be said—even those were
quite  difficult to spot.

TrueGrain is easy to use—there is not
much to select except film type, film
 format, and grain intensity. The program
does include sliders for adjusting curves
and colors, as well as various color filters,
but you can just as well make these kinds
of adjustments using Photoshop’s own
tools. One slightly irritating bug switches
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High-end photo editors such as Nikon
Capture NX2 already include generic grain
filters, but the results are not as good as
those produced by the specialized tools
tested here

TrueGrain is a specialized, pure monochrome tool with a fairly well balanced choice
of film profiles.



the emulated image view back to the
 original image if you try to shift a detail
view using the computer mouse. Even the
fastest dual-core processors took a couple
of seconds to redraw the preview image,
so I quickly learned not to scroll around my
images too much. On the plus side, the
program’s batch processing mode is very
intuitive to use, making processing large
numbers of images a snap. 

TrueGrain’s strength lies in its simplicity
and its extremely authentic, slightly grubby-
looking results, which are better than
those produced by all of its rivals. The
 relatively low number of available profiles
and concentration on monochrome film
types limit its usefulness, but the low price
makes it extremely good value for what it
does.

Exposure 2 – Weakness in the
Monochrome Department

Alien Skin’s Exposure 2 consists of two
Photoshop plug-ins for emulating mono-
chrome and color film types. The mono-
chrome module has 12 different film
 profiles, including such exotics as Polapan
instant film and Agfa’s Scala monochrome
slide film. Each profile is available in vario-
us forms (with or without additional grain,
with or without color filters), making it
 easier for less experienced users to find
 appropriate settings. The program also
 includes a range of standard sliders and
curves functions for making various manual
image adjustments, but only the Color tab
has an Undo button for automatically
 reverting to the original unchanged image.

The effects in the Tone, Focus, Grain, and IR
tabs all have to be undone manually if you
make a mistake. On the plus side, the
 program scores with such goodies as the
preview/original split screen, which allows
you to check the effects your selected
 filters will have before applying them. None
of the standard monochrome film profiles
look really authentic, due largely to the pro-
gram’s synthetically produced grain effects.
Nor are its special effects, such as Tri-X Salt
and Pepper, particularly impressive. 

You can switch from monochrome to
color mode during processing, and the
broad choice of color film profiles includes
negative, slide, and Polaroid film types.
You can choose from about 30 basic
 profiles, all of which have a number of
 variants. We would have liked to see more
high-speed film types; the fastest on offer
here is the GAF 500 (ISO 500) profile. This
film is a real rarity and was one of the very
first high-speed slide films to hit the mar-
ket. GAF 500 was developed using the E-4
process that was superseded by E-6 in the
mid-seventies. The quality of the various
profiles is variable. The Velvia profile pro-
duces images that look as if the saturation
slider was simply turned up to maximum,
but the Kodachrome 64 profile was the
best we tested.

We couldn’t find any reference to batch
processing functionality in the PDF manual,
but Exposure 2 is a Photoshop plug-in, so
batch processes can be performed using
Photoshop actions anyway. The program is
generally not well suited to processing
large numbers of images quickly. In order
to open a new image, you first have to
close the plug-in and return to Photoshop,
which is laborious and time-consuming.
The same is, however, also true of the
other plug-ins (Silver Efex and Color Efex) in
our test. The standalone apps (TrueGrain
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In addition to its film profiles, Exposure 2
also offers a huge variety of additional
filters, settings, and effects, as well as a
flexible split screen mode

Scans of original negatives form the basis of
TrueGrain’s grain tool. Slight negative
damage and inconsistent grain structures
add to the authentic look of the images the
program produces. 



and DxO FilmPack) are much simpler to use
in this respect.

Exposure 2 does not produce very
 realistic grain structures, and the quality
and functionality it offers make it difficult
to justify the US$249.00 price tag.

Silver Efex Pro – Lots of Choice
and Chopped-up Histograms
Nik Software’s Color Efex Pro includes a
number of monochrome film profiles but,
if you need a greater choice of authentic-
looking profiles and a broader range of set-
tings, Silver Efex Pro is a better choice. Once
installed, Silver Efex can be found in the
Photoshop Filter menu, and includes 18
monochrome profiles, each with a large
range of individual settings. In addition to
standard color and tone value settings,
there are also color filters, an edge-burning
tool, and even an Ansel Adams-style zone
mapping system built in. 

The U Point® Control Point technology
that many readers will know from Capture
NX2 is also included, and is a great aid to
processing targeted image areas, especially
for less experienced users. Control points
are a unique Nik feature and are a real boon
with no Photoshop equivalent. Most of the
plug-in’s other settings can be just as easily
made using Photoshop’s own filters and
tools. The only real difference is in the inter-
face, with Nik just taking the prize for
 elegance. The plug-in includes so many
 options that I often had to scroll through
the palettes, even when using a 24-inch
monitor, which makes it slightly less user-
friendly than I would have liked. On the other
hand, the ability to show/hide and undo the
individual processing steps (film type or color
filter, for example) is extremely useful. The
overall look and feel will be familiar to Cap-
ture users and is a great aid to retaining an
overview of complex chains of adjustments.
The plug-in also includes easy-to-use, folder-
based batch processing functionality. 

The 18 monochrome film profiles are the
core of the plug-in’s toolset, and cover most
well-known film types, although we would
have liked to see a profile for Agfa’s Scala
monochrome slide film too. Our first few
conversion attempts produced unexpected
results, with the histograms for our T-MAX
3200 and Ilford FP4 images ending up
 skewed and unusable. Increasing the grain
filter increased the effect, although it didn’t
appear to be directly related to the actual
grain algorithm. The Kodak Panatomic
images weren’t affected by this problem.
Instead of just overlaying the existing image
with a filter, Silver Efex produces its grain

 effects by producing an entirely new 
image based on the original film’s silver
 halide crystal structure. Unfortunately, the
resulting effect is too symmetrical and
 therefore less authentic than the looks
 produced by other programs that use
 scanned originals to emulate grain. 

At the end of the day, Silver Efex offers a
good range of settings, although some of
these are superfluous as they are already
available in Photoshop. Exceptions here are
the excellent Control Points and the zone
mapping system, which both represent
 genuine advances in functionality. Silver
Efex is fine for batch processing, but the
nuts and bolts of the built-in tools aren’t 
as good as the glossy user interface 

might lead you to expect. The inaccurate
histograms and artificial looking grain
 effects are not worth the US$200 asking
price. One bonus is the edge-burning tool,
which offers a unique way to add analog
characteristics to your digital images.

Color Efex Pro 3.0 – 
A Universal Tool with a Large
Range of Film Profiles

Nik Software’s Color Efex Pro is available 
as a plug-in for Capture NX2 and Adobe
Photoshop. We tested the Photoshop
 version. Color Efex doesn’t include any
monochrome film profiles, but is able to
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The scrambled histograms that Silver Efex produces are more than just
a cosmetic error

Alien Skin produced
the best-looking

Kodachrome simulation
in our test.



convert color images to black-and-white,
albeit without applying the characteristics
of any particular film type. As its name
suggests, this plug-in is squarely aimed at
producing color film effects, and the Pro
version includes a good range of useful
color filters. For this article, we limited
ourselves to testing the profiles designed
to reproduce the look of particular films. 

The Film Effects filter (available only 
in the US$300 Complete Edition) offers 33
different film profiles based on information
taken from the original film, adjusting
color, contrast and grain intensity accor-

dingly. The Complete Edition of Capture
NX2 costs US$179.95. The plug-in also
 includes Film Grain, Cross Processing,
 Infrared Film, Infrared Thermal Camera,
Old Photo, and Vignette filters, none of
which are based on particular film types.
The individual film effects mostly include
enough individual settings to achieve
 satisfactory results without having to
 resort to the use of additional filters. 

The majority of the slide and negative
profiles emulate Fuji and Kodak films,
while Optima 400 is the only Agfa film on
offer. We would have liked to see a Polaroid

profile or two, and Fuji’s Velvia is only
 available in the ISO 100 version, even
though the ISO 50 film has a much more
individual look. The plug-in’s film profiles
are all packed into a single drop-down list,
but we would have preferred to see
 separate lists for slide, negative, and other
film types. Color Efex is more complicated
to use than Silver Efex and does not allow
you to undo or hide individual processing
steps, although the split screen function is
flexible and really quite useful. The built-in
zoom tool has only three slightly clunky
steps, and the Zoom to Fit setting didn’t al-
ways select the correct zoom factor during
our test, leaving parts of the desktop
 unused and displaying the image at an
 unnecessarily small size. Zooming manually
to 100% didn’t help either and only
 displayed a small image detail, even when
viewing relatively small 6-megapixel files.
The PDF manual doesn’t mention batch
processing but, as with all other Photoshop
plug-ins, batch tasks can be performed
using Photoshop actions anyway. 

The color reproduction in some of the
film profiles was slightly odd, with Fuji
 Velvia 100 and Kodachrome 64 images
 looking surprisingly similar. If you have
 worked with both types of film, you will
know how different Fuji’s candy colors are
from Kodak’s strong but subtle tones. 
The differences between the individual Fuji
films types Velvia, Provia, and Astia were,
however, consistent. The plug-in’s grain
 effects suffer from the same malady as all
the others in our test (except TrueGrain) and
look artificially uniform. Real film  always
shows some anomalies, either in the form of
slight damage to the film  surface or incon-
sistent distribution of silver halide grains,
and emulated grain simply can’t reproduce
such inconsistencies  authentically.

DxO FilmPack – 
Great Colors but Weak Grain
DxO’s FilmPack can be installed either as 
a Photoshop plug-in or as a standalone
 application, although the plug-in’s small,
Windows 95-style interface is not  par -
ticularly attractive and is quite difficult to
use. We much preferred the standalone
 version. The program’s biggest drawback
was the lack of a split screen mode,
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Silver Efex is the only program in our test
that includes an Ansel Adams-style zone
mapping system

Old for new: Side-by-
side Preview (for
comparing “before”
and “after” images) 
is one of the more
useful features in Nik
Software’s Color Efex



 although you can revert to the original
image view using a single mouse click.
Just like TrueGrain, FilmPack automatically
switches views when you select a new
image detail.

FilmPack offers the largest range of film
types in our test, and includes more than
50 slide, color negative, monochrome
 negative, and cross processing profiles.
But even this huge choice has omissions,
and we would have liked to see  Agfa’s
Scala included. We liked the user interface
although, like TrueGrain, it has only a
 limited range of settings. Unfortunately
there is no online help available, and the
PDF we found at the DxO website turned
out to be a quick start guide. The stand -
alone version does not seem to have batch
processing functionality, making proces-
sing a large number of images  tedious and
time-consuming. Here too, you can use
the plug-in version in conjunction with
Photoshop  actions to perform batch tasks.

FilmPack takes a similar approach to
producing grain effects as TrueGrain, using
scans of film originals as the basis for 

its profiles, although the actual grain
 effects are produced by superimposing the
 sampled grain patterns on existing images.
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Like Silver Efex,
Color Efex also

tends to break up
the histograms it

produces, but less
severely than its
sister program.

It is difficult to judge the color characte-
ristics of photographic film objectively,
and even a “typical” Velvia look isn’t
 always consistent. Although Velvia is
 always developed using the same, stan-
dardized E-6 process, the slides that
come back from the lab by no means
 always look identical. The film’s well-
known magenta cast doesn’t appear on
every film. Different production batches
can also produce differing results. Color
negative films developed using the C 41
process are even more prone to anoma-
lies, as not all photo labs account for the
orange mask built into C 41 films during
the development process, and varying
results are almost guaranteed. 

The sheer number of monochrome
 development processes is confusing. 
Most large labs simply use the same
 chemical “brew” for developing all
 monochrome films; knowledgeable
black-and-white photographers shudder
at the thought. 

In short, there are a huge number of
factors that influence the final analog
images, making our opinion of the au-
thenticity of the looks produced by the

software in our test extremely subjective.
We judged the test software to the best
of our ability, and using all our  collective
experience.

In-camera Film Simulation? 

If you want to apply analog-style filters to
digital images, well exposed, noise-free
image files are the best source material to
use. Source images should also be free of
color casts and shouldn’t display too
much contrast. JPEGs need to be shot at 
a high quality setting, and the fewer
 compression artifacts a source image
 displays, the better the test results and
final images will be. 

Although digital cameras have many
great qualities, producing analog film
looks is not part of their everyday reper-
toire. Japan’s Fuji corporation manu-
factures analog film stock and digital
 cameras, and its S5 Pro DSLR, FinePix
F70EXR compact, and FinePix S100FS
bridge cameras are exceptions to this
rule, and have built-in emulation tools
that apply a film look (Velvia slide film, for
example) to images during exposure.

This functionality is not, however, a real
alternative to the software programs we
tested, as it only affects a shot’s color and
contrast and does not include any form
of grain simulation. Some photographers
recommend increasing ISO speed in
order to produce grainier images, but the
resulting images normally only display
increased noise, not authentic-looking
grain.

Our Test Methods

The Fuji S5 DSLR has built-in film emulation
functionality designed to imitate the colors
of classic Fuji slide films
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This approach means that FilmPack uses
much smaller files, but the results never-
theless end up looking too smooth. The
flaws and authentic-looking grain distribu-
tion that TrueGrain produces are lacking in
the finished FilmPack images, although
some users will see it as an advantage that
inconsistencies that are not present in the
first place cannot then be reproduced
throughout a whole batch of images. The
default settings produce results that are
much too weak—the soft grain attributed
to Kodak T-MAX 3200 is not at all like the
original film.

The grain preview function in the
 standalone version didn’t work on our
Windows 7 test system. The Zoom to Fit
setting (the one we use most often)

 doesn’t display the selected grain, 
and the effect only becomes visible if 
you zoom into the image—an irritating
 limitation for regular users. The colors are
consistently good, and the Fuji Velvia 
50 results were particularly convincing,
even if DxO fails to emulate the magenta
cast that the real film often displays. The
FilmPack Kodachrome look was not one
of the better ones in our test. 

We like the program’s intuitive hand-
ling, which is easy to learn for beginners
and experienced users alike. The need for a
split screen preview, the grain preview
problem, and the lack of a batch  pro -
cessing mode might make FilmPack less
 attractive to regular users, although the
colors were very good. The grain effects, 

in spite of being scan-based, didn’t blow 
us away.

FilmPack is great for adding historical
colors to digital images. The grain effects
are a lot better than the poor-quality Silver
Efex offering, but nevertheless look a little
too sterile for our taste. If you are more
 interested in applying monochrome profiles
to your images you will be better off using
TrueGrain, but FilmPack is nevertheless a
good value all-rounder.

Conclusions

The artificial grain effects produced by
most of the test programs were, to be
 honest, not great. The only one that
 produced a convincing emulation of the
unique, irregular look of real analog 
film was TrueGrain, with its scan-based
emulation system. 

The color film effects were a mixed bag,
and all the programs tested produced
 inconsistent results. If you want to produce
images for a specific film type, you are well
advised to install a test version of your
 chosen software before buying in order to
check whether you can satisfactorily repro-
duce the look of your favorite film type. All
of the film profiles we tested produced
 better results than standard Photoshop
tools, and we can certainly recommended
any of the test packages to less advanced
Photoshop users. Grain is less of a concern
in color film profiles (especially the slower
ones) and all of our test candidates
 produced acceptable results in this category.
All of the color grain effects were better
than the standard grain tools included with
Capture NX2 or Photoshop.

Observant viewers can tell when digital
images are tweaked to look old or are
overlaid with scans, especially in the case
of monochrome images, due to the fact
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DxO’s FilmPack produces grain effects
that are much more realistic-looking
than the results you can achieve using
standard Photoshop filters, but even
these are not as authentic as the look
produced by TrueGrain.

FilmPack is designed primarily for applying
film profiles to digital images and includes
only a few, limited image processing tools.
Photoshop is a better alternative when it
comes to general image manipulation. 



that digital images always look more uni-
form than real slides. Film cannot be kept
absolutely flat in the camera, and long
 periods of storage combined with the
 inevitable loss of image quality during the
scan process produce the anomalies and
inconsistencies that native digital images
simply do not have. Digital images are too
clean, and lack the scratches, blotches,
creases, tears, and blurry patches that
even the most carefully handled slides
usually have. Working with large, flatbed
scans the way TrueGrain does is a great

step toward producing a better analog
look, but we really need to be able to
choose between multiple scans for each
film type in order to produce an authentic
analog look for multiple images taken
from a single batch. We would also like to
see more specialized tools and plug-ins for
producing artificial ageing and analog
image anomaly effects. Silver Efex was the
only program in our test that already has
these types of tools built in.

All of the programs tested are available
as fully functional trial versions. Due to the

huge number of film profiles on offer, we
were only able to make a limited number
of test images, and our judgments
 regarding color reproduction are, of course,
subjective. None of the trial versions  pro -
duced watermarks or other unwanted
 markers, and we were able to save all our
test images without complications. If you
are simply fed up with the super-consistent
colors in your digital images, the tools in
our test can help you to reproduce the
 fascinating look of the analog past.

All photos by Sascha Steinhoff (jr)
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Most people either love or hate grain
 effects. Grain has been an unavoidable
side-effect since the analog photogra-
phic process was invented, and it is up to
the viewer to decide whether to simply
accept grain as part of the deal, or to
 elevate it to the status of its own art
form. Some photographers see grain as
having its own intrinsic artistic value,
while  others consider it to be a  pre -
historic image error that can, thanks to
digital technology, at last be eradicated.
Interestingly, such discussions are usually
centered around “grain” in a global
sense,  although grain is a multi-facetted
phenomenon that is influenced not only
by the photographer’s choice of film but
also by a large number of other factors
too. One thing is certain: “classic” film
grain plays an extremely minor role in
our contemporary, digital times. 

Different types of film display vastly
 differing grain structures, although all
film types generally become less grainy
during processing. The more sensitive a
film, the grainier it will be—this effect is
especially obvious if you compare diffe-
rent members of the same film family.
For example, Kodak’s T-MAX 100 grain is
almost invisible in normal enlargements,
while T-MAX 400 has visible grain at just
about every magnification. The high-
speed T-MAX 3200 stamps an unmistak -
able high-grain look on every photo. The
“higher ISO = more grain” rule is not ab-
solute, however, and a modern ISO 400
film can have finer grain than a slower
film manufactured in the sixties or
 seventies. Grain quality can also vary

from batch to batch, and some film 
types are even available in cheaper
amateur and more expensive professional
versions. In the case of “professional”
film stock, the manufacturer guarantees
that grain and color reproduction remain
constant by ensuring that the film is
 subject to stringent production and
 storage quality control.

Exposure and development also influence
grain structures, as these only take on
their final form in the lab. Shorter expo-
sures increase grain, and an ISO 100 film
that is exposed and developed as if it
were an ISO 400 film will display more
obvious grain than if it is handled accor-
ding to its nominal sensitivity. A film’s
definitive grain structure is fixed once

the development process is complete,
but most consumer-level photographers
never get to see a film’s “true” grain in
unadulterated form anyway. 

The best way to produce a genuine-
 looking print from a classic monochrome
negative is to make an enlargement
 either in your home darkroom or at a
specialist lab where the entire workflow
still takes place using analog equipment.
In order to keep costs down, most con-
temporary prints are made in large,
mass-production labs that use digital
machinery to scan negatives before prin-
ting them. This means that all negatives
are subject to the inevitable loss of
image quality that scanning causes.

As soon as you view a scanned negative
or slide on a monitor, what you are
 seeing is a second-generation digital
 interpretation of the original grain
structure. Purists only really get to see a
film’s true grain structure if they view
 slides in the traditional fashion using a
high-powered magnifier and a light
table. Even projected slides display addi-
tional optical noise that increases with
the projector’s distance from the screen. 

All these factors contribute to the
 regrettably subjective nature of our test.
The testers’ experience compensates to
some degree for this subjectivity, but
 doesn’t alter the fact that true grain is 
an inconsistent, illogical phenomenon.
This fact alone means that even grain
emulated by randomized algorithms still
tends to appear artificial.

The Problem with Grain

Since its introduction in 1990, Fuji’s Velvia
slide film, with its bright, almost garish
colors, has helped redefine the look of slide
photography
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Test Images for different Fuji Velvia Filters

Fuji Velvia’s typical color reproduction separates it from the
slide film crowd. Although its candy colors have often been
slated as having a “Disneychrome” look, Velvia (especially the

ISO 50 version) has achieved the status of a modern classic
since it was introduced in 1990. We tested the authenticity of
each program’s Velvia filter using the default settings.

Our source image was shot using a Nikon D70s and displays
neutral colors and modest contrast. The blue sky, the white hull 
of the boat, and the dark water make it ideal for trying out the
strong colors associated with Fuji’s Velvia film. 

Alien Skin takes Velvia 50’s “Disneychrome” nickname a little too
literally, and turns up color saturation too far. In this case, less
would have been more. This doesn’t look like a classic Velvia image. 

Color Efex only has a Velvia 100 filter. Nik Software’s
programmers seem to have given their film profile even brighter
colors than the Alien Skin Velvia 50 filter in spite of the original
film’s more subtle color reproduction 

We liked DxO’s Velvia 50 profile best. The colors are strong but not
over-saturated, producing a well-rounded Velvia look. Purists might
wish for a little more of the well-known Velvia magenta cast. 
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Comparing the Effects of various Film Profiles

The Color Efex Fuji Superia 1600 Profile The Color Efex Kodachrome 64 profile The DxO Filmpack Polaroid Polachrome profile

The Silver Efex Kodak Panatomic X 32 profileThe DxO FilmPack Rollei IR 400 Profile The Silver Efex Ilford FP4 125 profile

The Alien Skin Agfa Optima Cross Processing profile The Alien Skin Lomo Fuji Cross Process profile

The source image was shot in the late
afternoon, and the setting sun produced a
slight yellow cast

The cross processing profile included with
Exposure 2 displays strong color shifts

The color shifts are even stronger in
Exposure 2’s Fuji Provia Cross Process profile

DxO’s Polachrome filter even includes the
original film’s famous distinctive stripes

DxO’s Rollei IR 400 profile simulates the
look of a fairly sensitive and extremely
grainy infrared film

The Silver Efex ilford FP4 profile produces
virtually no midtones

Kodak’s Panatomic X, with its extremely 
low ISO value of 32, displays virtually no
grain at all (Profile: Silver Efex)

The Color Efex Kodachrome 64 filter
faithfully reproduces the classic look of
seventies magazines

High-speed film generally displays more
grain, shown here in the Color Efex Fuji
Superia 1600 look

The images on this page show just how different the results of applying various profiles to the same source image can be

The RGB source image (Nikon D70)
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Simulation of Film T-Max3200 with TrueGrain and Silver Efex

Comparing Grain for Different Film Speeds

The RGB source image

The TrueGrain Kodak
T-MAX 400 profile with

additional grain dialed in

Converting a colorful source image using a medium 
speed monochrome film profile produced a completely 
different mood. Even though it is subtle, the grain 
effect still changes the overall feel of the image.

The TrueGrain T-MAX 3200
profile with added grain

Detail Enlargements
The TrueGrain T-MAX
3200 profile without

added grain

Grain contributes strongly to an analog film look. The coarse grain of
a high-speed film, such as Kodak’s T-MAX 3200, give even monotone
image areas (such as a blue sky) a life of their own. The loss of some
image detail is the inevitable result of applying a coarse grain
structure to the image.

Different programs
produce widely differing
results from the same
source image, especially
when using monochrome
film profiles.

The Silver Efex
T-MAX 3200 profile

The RGB source image

Here, you can see that the 
Silver Efex T-MAX 3200 profile is

almost useless if used with its
default settings. Fine textures

disappear completely and 
many parts of the image are

simply washed out. The broken
histogram helps to underline the

poor quality of this profile, and
the effect is just as evident if the

grain filter is deactivated.
TrueGrain and Silver Efex T-MAX 3200
looks

TrueGrain handles the same
image much more gently. The

histogram is clean and the fine
skin textures have been retained

in spite of the coarse grain effect.
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Test Images for Different T-MAX 3200 Filters

Because monochrome
conversion algorithms
tend to manipulate
the image curves
anyway, we de liber-
ately left the contrast
in this source image
unchanged.

Silver Efex produces an overly strong grain effect, resulting in too
much loss of detail and a washed-out overall look. This is not an
authentic analog look. 

TrueGrain produced the best test results, with the size and
structure of the grain closely resembling the original. If you want
to print your images or view them on a monitor, we recommend
you adjust the curves too. 

The image still displays a typically smooth, digital look, even after
applying the Capture NX2 grain filter

The conversion to monochrome using Exposure 2 worked well, 
but the overall look is not convincingly analog.

FilmPack produced generally pleasing results, although the
grain structure is too fine and too consistent to really compare
with the original T-MAX 3200 stock 

Our test programs had to demonstrate their abilities on a range
of everyday subjects. Here, we used each program’s default
settings applied to a photo of a baby elephant. In order to keep
the results as genuine as possible, we also avoided using any
additional (USM or similar) filters. 

c



Adobe describes the introduction of CS5 as the most important 
update in the company’s history and is calling the event a “milestone”. 
We grabbed a copy of the new Photoshop release and took a look 
at what it can and can’t do and who it is aimed at.  
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Ralph Altmann

More Than Just 
an Update
Photoshop CS5



It is 20 years since Adobe released the first
version of Photoshop. The program led the

way from the start and quickly became the de
facto worldwide image processing standard.
Today, its name is synonymous with digital
image editing. 

Photoshop’s popularity among non-com-
mercial users was hugely increased by the
fact that, up to version 7, it could be “freely”
(if not legally) copied. With the release of the
first Creative Suite in late 2003, Adobe put
an end to rampant copying by introducing a
hardware-based registration process of a
type now used in many up-market software
packages, including Windows. Full versions
of the program are expensive, but regular
users know that they get their money’s
worth. If you already own an earlier version,
Adobe’s moderate upgrade prices (see
table) make it easier to get to grips with the
latest CS5 release. User-friendliness and the
range of correction tools included with the
package have improved enormously since
the release of the oldest upgradable CS2
version. Photoshop’s traditional strengths lie
less in spectacular editing effects (other
companies are more innovative in this
 respect), but more in its overall interface
 design, which is squarely aimed at use wit-
hin a professional digital image processing
workflow. Full color management, 16-bit
and 32-bit color depth support, and com-
prehensive non-destructive image editing
functionality (using layer masks, adjustment
layers, and Smart Objects) are just some of
the professional-grade features that make
Photoshop stand out from the crowd. Most
of the improvements in the CS5 version are
incremental, but some distinct advances
have also been made to its selection tools,
image content manipulation functionality,
and the range of optical error correction
 features, which now includes profile-based
lens corrections.

Color, Color Spaces, 
and Color Depth
Photoshop CS5 no longer includes a No Color
Management option. This serves to ensure
that all your digital image processing takes
place in a color-controlled environment, but
makes it more difficult to create your own
color profiles or to print neutral color targets.
If you don’t want to do either of these things
(and most users don’t during normal proces-
sing), this shouldn’t cause problems, and
Adobe has promised to solve the dilemma
with a new plug-in anyway.

For advanced users, Photoshop’s color
 management systems are—in spite of their
complexity—exemplary in their usability and

reliability. Photoshop is also one of the few
image processing programs that fully sup-
ports 16-bit color depth and images saved in
the L*a*b* color space. 16-bit processing is 
a must if you shoot with a modern, RAW-
 capable camera that captures tonal values at
full color depth. Today’s standard RAW color
depth is 14-bit, equivalent to a range of
16,384 tonal values, while some high-end
 cameras can differentiate between more
than 65,000 tonal values. Today, the 32-bit
color depth already available in HDR images
is starting to become commonplace. Photo-
shop CS5 offers a range of 32-bit tools, inclu-
ding a new one for adjusting HDR tones,
which we will discuss in more detail later.

Adobe has improved color selection and
mixing functionality and you can now opt to
have a color picker appear directly where you
click in an image. A freely accessible online
database of color styles (called “Kuler”) that
has been around since CS4 was launched is

now directly accessible from the CS5 inter-
face—a boon for graphic artists.

Correcting Images

Photoshop CS5 still uses Adobe Camera Raw
to perform its demosaicing (i.e., to interpolate
and assign RGB colors to the grayscale tonal
values that make up a RAW image file) as well
as for making a range of other adjustments to
RAW images.

Since the introduction of CS4, Adobe
 Camera Raw (ACR) has also been capable of
processing JPEG and TIFF images. The 6.0
 version and the new 6.1 version include im-
proved interpolation algorithms for RAW
conversion. ACR cannot be updated separa-
tely, so you will need to purchase either
Photoshop CS5 or Photoshop Elements 8 (as
standalones or as part of a suite) in order to
enjoy the advantages of ACR 6.1. ACR is often
capable of producing more dynamic range
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Photoshop CS5 Guide Prices
Update from/to (in US$) Photoshop

CS5
Photoshop CS5 
Extended

CS5 Design 
Standard1

Photoshop CS5 Extended 
”Students and teacher“

CS5 Design Standard 
”Students and teacher“

Full version 1010 999 1299 299 449
Photoshop CS2, CS3, CS4 or 
Photoshop Extended CS3, CS4

296 349 899

Photoshop CS5 – 349 849
CS4 Design Standard – – 499
Photoshop Elements 6,7,8 (Windows)
Photoshop Elements 4,6,8 (Mac-OS)

599 899

1Contains Photoshop CS5, Illustrator CS5, InDesign CS5 and Acrobat 9 Pro

“Non-destructive editing” means that any
adjustments you apply to your image do
not affect the original image data, and that
the adjustment parameters are instead
 stored separately within the image file.
Smart Objects apply the same concept to
all Photoshop filters and tools, with the
 exception of the Brush tools. Filters that are
not  available as adjustment layers (such as

Sharpen) can be applied to layers that have
been converted to Smart Objects. This
even works for the Transform, Crop and
Image Size tools, and is a great advantage
if you are working on images that are
 shared between multiple Adobe programs
or users. A RAW image that has been opti-
mized in Lightroom can be seamlessly in-
tegrated into a Photoshop file and passed
on to DreamWeaver or InDesign for publi-
cation while preserving the original image
data and allowing you to fine-tune your
adjustments later. All Smart instances of 
an image are adjusted automatically if
changes are made to the original. The main
disadvantages of Smart Objects are the
large size of the image files they produce
and the fact that Adobe hasn’t fully integ -
rated the Smart idea into its overall inter-
face concept, making some Smart steps
quite tricky to perform.

Smart Objects and Smart Filters



(and thus providing more detail) in RAW
images than can ever be provided by JPEG
images shot using the same camera. In con-
trast to camera manufacturers’ proprietary
RAW converters, ACR supports a wide range
of RAW formats that is constantly being
 updated. It also includes tools for correcting
color temperature, brightness, contrast, sharp-
ness, vignetting, and chromatic aberrations.
Lens error correction tools were introduced
with the 6.1 version in June this year. 

ACR’s noise reduction tool bases correcti-
ons on a file’s Exif metadata and has three
new sliders that combat detail softening
when you adjust color or brightness and pre-
serve contrast when you adjust brightness.
Photoshop has a similar tool that can be
found under Filter > Noise > Reduce Noise.

The ACR Adjustment Brush is, however,
unique. You can use the tool to mask image
areas that you can then modify using one or
more of the seven adjustment types: Expo -
sure, Brightness, Contrast, Saturation, Clarity,
Sharpness, or Color. Each effect is marked
with a pin icon at its application point and
you can select the Show Mask option to show
the effect of your adjustment in the image
preview. These changes are non-destructive,
and you can adjust the size of the area cov -
ered and the strength of the effect later. This
tool is really fun to use! The only way to make
similar adjustments in Photoshop is to use
Smart Filters or large numbers of adjustment
layers and layer masks. 

The Targeted Adjustment tool works in a
similar way, but has no brush function and
therefore cannot be applied locally. Once
you have activated the tool, you need to
 select a mode (Hue, Saturation, Luminance,
Grayscale Mix, or Parametric Curve) from the
context menu in the preview window. Click -
ing on your image then imports the color
and luminance parameters at the current
cursor position into the tool and uses these
as a basis for subsequent corrections. Drag-
ging the mouse then performs a context-
sensitive adjustment—for example, clicking
on a blue sky in Saturation mode auto -
matically opens the Saturation tab in the
HSL/Grayscale panel and activates the Blues
slider. Grayscale Mix mode is designed for
making precise adjustments to the grayscale
values in color images that have been
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Content-aware scaling allows you to 
protect important image details from 
adjustment during image resizing by 
saving selected content in an alpha 
channel. Other adjustments to the 
protected content are not possible.

Does this mean we can at
last save JPEGs as 16-bit
files? Unfortunately not.
Images are still converted
to 8-bit before they are
saved, as indicated by the
warning at the bottom of
the dialog.

You can not only remove unwanted vignettes, but also apply your own vignetting effects in
Adobe Camera Raw (ACR)—even to images that have already been cropped. The illustration
shows the ACR 6.0 interface. The 6.1 version also includes distortion correction functionality.

Direct color selection: 
pressing Alt+Shift+Right 
click (Windows) or
Control+Alt+Command
key (on a Mac) opens 
the color picker at the
current cursor position.
The circle on the 
right appears if you 
select a color using 
the eyedropper.



 converted to black-and-white. You can also
make this type of adjustment directly via the
slider panels, but Targeted Adjustment is
more intuitive to use. The same is true of the
ACR Graduated Filter tool, which produces
more balanced contrast, just like a physical
graduated filter mounted on a lens, and can
be applied using most programs that sup-
port layers. There are also Color and Sharp-
ness sliders built into the filter for fine-
 tuning your results. The ACR version of the
tool requires you to set start and end points,
angle, and any additional fine-tuning para-
meters for the filter. Selected correction
 parameters are saved in the program’s data-
base or in a separate XML sidecar file,
 making all adjustments non-destructive,
even if you save your results in JPEG format.
Adjustments are then applied on the fly
when you open your image in Lightroom or
Bridge, while non-Adobe programs can only
open the original version of images that
have been adjusted this way. 

The CS5/ACR 6.1 package introduces
long-awaited profile-based lens correction
tools for removing converging lines and
 barrel or pin-cushion distortion, and further
underlines Adobe’s encroachment into
 terrain previously occupied by specialty pro-
grams such as DxO Optics Pro. The same tools
are also due to be included in Lightroom 3.0.
The Lens corrections dialogs and, surprising-
ly, the results they produce are not identical
in Photoshop and ACR. ACR has an additional
Amount slider while Photoshop includes a
grid that you can superimpose on the image
preview to help you judge your adjustments
effectively. In order to achieve satisfactory
results, all profile-based adjustments require
you to install the correct profile for the lens
used to take the photo you are correcting.

Lens type and other lens information are
extracted from an image’s Exif metadata.
Lens Profiles are saved in the Adobe\Camera-
Raw\LensProfiles\1.0 folder. At the time of
testing, there were more than 300 profiles
available, mostly for Sigma zoom lenses,
iPhones, and a handful of other lenses from
various well-known camera manufacturers.
Adobe intends to continually expand the lens
profile database and has created its Lens Pro-
file Creator software to enlist the help of its
users. You can use the software, together
with a printable test chart, to create profiles
for camera/lens combinations that have not
previously been profiled.

Making Image Adjustments
using Photoshop CS5
Up to and including the CS3 release,
Photoshop included only the Extract tool for
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Photoshop’s Black and White mode helps to preserve fine tonal differences that would
normally disappear when you convert a color image to grayscale. You can adjust the
grayscale values of each individual color channel simply and directly using your mouse.

We used ACR to level the horizon and intensify the blue of the sky with the Targeted
Adjustment tool. The original image is shown at top right. The settings we used 
are shown at bottom right. We also used the adjustment brush to mask the statue 
so that any further adjustments we made were limited to the statue area. 



making selections. The tool couldn’t compete
with specialty plug-ins such as onOne Soft-
ware’s Mask Pro, which Adobe still offers for
download although its own Quick Selection
and Refine Edge tools now perform the same
tasks just as well. In its CS5 incarnation, the

Refine Edge tool has been given Smart Radius
functionality that automatically adjusts the
radius setting to the type of edge you have
selected, and the Decontaminate Colors
check box that automatically removes color
fringes by replacing affected pixels with the

color from nearby pixels. With a little practice,
these tools—together with the various
 available view options—make complex
 selections much simpler. You can deal with
hair or other semi-transparent objects using
the Refine Radius brush included in the
 Refine Edge dialog. Photoshop is spookily
good at correctly recognizing which pixels
belong to a selection.

Photoshop has become extremely good
at recognizing edges, outlines, and patterns
within images, and is verging on achieving
true object recognition. This advanced
functionality has been further integrated
into the Spot Healing Brush tool and the Fill
command in the form of the “Content-
aware” option. Here, Photoshop analyzes 
the pixels surrounding your selection and
replaces them with any patterns it recognizes.
As an example, you can use the Spot Healing
Brush to simply and invisibly remove tele-
graph wires from an image. Larger objects,
too, can be quickly and simply removed
 without trace. The function even takes
image noise into account. The more easily
recognizable the patterns in your image, the
more reliable the results—the tool duplicates
backgrounds that consist of brick walls or
bushes almost perfectly. The function is,
 however, extremely processor-hungry and
quickly reaches 32-bit Photoshop’s 3GB
 memory limit if you try to replace large
image areas. This type of tool really requires
the 64-bit version of the program to function
smoothly.

Repositioning rather than simply dele-
ting objects often improves a composition.
Once you have selected an object and  re -
paired your background, you can place your
object anywhere you like within the image
and even use the Puppet Warp tool to mani-
pulate it separately from the rest of the
image data. This new tool lays a visual mesh
over your selection and allows you to
 drastically distort specific image areas, while
leaving other areas intact. Applications
range from subtle image retouching (such
as  shaping hair) to total transformations
(such as repositioning arms or legs). CS4
 already included the similar Content-aware
Scaling function, which allows you to scale
image backgrounds independently of im-
portant foreground detail. Puppet Warp was
supposed to deliver almost miraculous
 results, but requires a great deal of care if it
is to be  applied successfully. You can only
really achieve realistic-looking results if you
save your masked areas in a separate alpha
 channel and scale the rest of your image
moderately. Photoshop can automatically
mask skin tones, but cannot prevent you
from accidentally warping your subject’s
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The Quick Selection tool is great
at recognizing the basic shapes
of objects, but doesn’t pay any
attention to irregular outlines,
necessitating fine-tuning with
the Refine Radius brush.

Here, we used the Graduated Filter tool to darken the sky. This only works if the sky
isn’t overexposed. We used one horizontal and one diagonally positioned filter 
(shown in the small image in the center) with slightly different settings to achieve 
the result you can see here.



haircut or clothes! The tool is programmed
to protect complex patterns and distort
simpler ones, such as sky, grass, or water.
Photoshop is not yet capable of recognizing
people, but it won’t be long until it can.

Merging Multiple Images

If you are not able to capture your planned
image due to technical limitations related to
composition, depth of field, or dynamic
range, you can always take multiple photos
of a single subject and merge them together
into an optimized image later. The Photoshop
Photomerge tool (found in the File > Auto-
mate menu) analyzes the content of an
image sequence and generates a merged
image file based on the results. If you 
are  making a panorama, we recommend
 activating the Vignette Removal option, as
Photoshop then automatically adjusts the
brightness at the edges of the overlapping
images. You can, however, make the same
adjustments manually if you prefer. The tool
also automatically aligns the individual
images according to matching content and

automatically generates layer masks for 
each source image. The Photomerge dialog
includes a choice of five layout options, most
of which are suitable for panorama use. The

Perspective, Cylindrical, and Spherical pro-
jection types all distort source images where
necessary, while the Collage and Reposition
projections only rotate or scale, making it
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Photoshop is stable and crashes only rarely
but doesn’t, as yet, include the built-in back-
ground save functionality that is a standard
feature of many other image processing
programs. It is always better to press Ctrl+S
once too often than not often enough. Even
the best non-destructive correction tools
aren’t worth a penny if there is a sudden
power cut. Automatic saving of correction
parameters uses hardly any memory and is
simple to implement. Ironically, Photoshop
is already capable of (optionally) saving all
correction parameters in the History Log. 

There have been a number of occasions
over the years when we have lost all of our

settings due to unsaved correction para-
meters. Resetting complex corrections is
painstaking work and other paper format
or printer settings can be destroyed by a
crash too. Photoshop saves presets in the
Users\<name>\AppData\Roaming\Adobe\
Adobe Photoshop CSX\ folder and we
 recommend that you backup this folder
 regularly. The program settings are stored
in the \Settings sub-folder in the Adobe
Photoshop CSX Prefs.psp file, which you
can simply delete and replace with a saved
version if something goes wrong. If the file
is empty, corrupt, or missing, Photoshop
will automatically activate its default
 settings at startup.

Data Security Issues



 necessary to shoot for these two projection
types using a distortion-free lens and a tripod
with a panorama head. The Spherical projection
type produces 360-degree panoramas that
can be transformed into three-dimensional
views using the 3D functionality built into the
Extended version of Photoshop. 

The Auto-Align Layers command (in the
Edit menu) is another great aid to post-shoot
composition. The dialog is also an integral
part of the Move tool, but doesn’t include the

projection options that make it possible to
rotate, scale, and mask individual images.
These functions, along with the search for
 appropriate overlaps, are left to the Auto-
Blend Layers command in the same menu,
which is also capable of blending images to
include only the “best” (i.e., ideally exposed
and focused) pixels from each source image.
You can also use these tools to merge several
photos with shallow depth of field into a
 single image with much greater depth of field.

In this case, Photoshop automatically aligns
images that were not taken from precisely
the same position.

Creating HDR Images

Just as you can merge multiple images to
 increase your camera’s angle of view, you can
also merge several differently exposed
 photos to create an image with greater dyna-
mic range than your camera is designed to
capture. Photoshop has included High Dyna-
mic Range (HDR) functionality for a while
now, but CS5 has at last incorporated these
tools into a user-friendly dialog. Creating HDR
images with 32-bit color depth is relatively
simple, but the results can only be effectively
displayed or printed if they have been tone-
mapped for 8-bit or 16-bit output first. 

You can select your source images using
either Bridge or the Merge to HDR Pro dialog
in the Automate menu. There are three
 output modes: 8-bit, 16-bit, and 32-bit. If you
select 32-bit, Photoshop opens your image
using 32-bit color depth, but offers no further
user-adjustable settings. The White Point
 Preview setting only alters the appearance 
of the preview, but not of the image itself. 
We recommend always activating the
 Remove Ghosts option, as ghosting cannot
be repaired later.

The 8-bit and 16-bit output modes give
you access to various tone-mapping dialogs,
although Local Adaptation is the only one
that is of real interest for day-to-day HDR
uses. The dialog includes a number of useful
adjustment tools, including a reduced-
functionality tone curve dialog that allows
you to fine-tune the distribution of tonal
 values within your image more precisely
than you can using the sliders. The HDR
Curve dialog doesn’t show the position 
of selected pixels on the curve, and lacks 
the anchor point and the shadow/highlight
clipping functionality included in the
Photoshop Curves dialog. 

Photoshop irrevocably resamples your
tone-mapping settings into the image data
and displays the finished image at the
 selected color depth. You can, however, work
non-destructively if you open your merged
32-bit image and save it immediately. The
 resulting image won’t look particularly
spectacular, but does include all its original
pixel data and can be converted at any time
(along with any adjustments you make) to 
8-bit or 16-bit color depth using the Image >
Mode command. This method automatically
opens the HDR Toning dialog, which allows
you to zoom into the preview, and includes
all the same adjustments and tools as HDR
Pro and the more familiar Photoshop Curves
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CS5’s improved Lens Correction tool automatically recognizes the lens used and loads
the appropriate profile from the built-in database. The ACR Lens Corrections dialog
(shown in the smaller image) includes three additional sliders for adjusting correction
amounts. Both programs allow you to make fully manual lens corrections or to manually
fine-tune corrections made automatically by the software.

We used the new Puppet Warp tool to bend the whale skeleton. The original image, 
shot at the oceanographic museum in Stralsund, Germany is shown on the left



dialog. In future, we would like to see HDR
previews that can be zoomed to more than
200% and a Smart Object-compatible HDR
Toning tool. CS5 does allow you to open 
32-bit HDR images as Smart Objects, but the
reduction of bit depth that this involves
 automatically clips all “unnecessary” tonal
 values before you have even opened the
tone-mapping dialog. Maybe our wishes will
be implemented in CS6!

The HDR Toning settings are also available
in the Image > Adjustments menu, where
they can be applied to any open image. 
This allows you to apply surreal-looking 
HDR  effects to conventional 8-bit images.
 Surprisingly, you can apply HDR toning to 32-
bit images without affecting their native
color depth, but whether this actually has any
practical use remains to be seen. We can
 imagine using multiple, layered applications
to produce especially subtle or surreal effects.

Conclusions

The important changes in CS5 that we
 haven’t discussed here include support for
64-bit systems, which makes processing very
large image files faster and more reliable. 
3D and scientific functionalities are only
 available in the more expensive Extended
version of the program. CS5‘s many other fea-
tures also include interface customization,
new brush and color mixing tools, and the
new CS Review online team support system. 

Photoshop really is the “Swiss Army knife”
among today’s image processing programs,
and has a tool for just about any application
you can imagine. It includes many functions
that you would have to acquire separately if
you want to use them with cheaper programs
from other manufacturers.

For a working graphics studio, the US$999
list price for CS5 Extended is relatively easy to
justify, but hobby photographers will often
prefer to invest that kind of money in camera
gear. Nowadays, there are many full-featured
image processing programs available as
shareware or for free, while cameras and
 lenses still cost money! If you own an older
version of Photoshop, Adobe’s sub-US$200
upgrade price for any version since CS2
makes the decision to test CS5 a lot easier
and adds up to the equivalent of a US$40-
per-year subscription price. You can also
 upgrade from Photoshop Elements 6.0 and
higher (Windows) or 4.0 and higher (Mac).

Be careful if you buy an old, upgradable
copy of CS2. These are often not as cheap as
you might think, and you run the risk of
acquiring pirated or incorrectly licensed

 software if you don’t buy from a reputable
source. Adobe provides information on how
to recognize pirated software at www.
adobe.com/aboutadobe/antipiracy/.

There are significant discounts available to
students and teachers on all versions of the
program (see the table at the beginning of
this article). Adobe has recently begun to
allow educational software to be used
 commercially, but evening-class students no
longer qualify for discounts. Student versions
are only slightly cheaper than upgrades but
are themselves not upgradable. After the
 unspectacular CS4 update, which was ignored
by many regular users, the release of CS5 is an
important step for Adobe. Content-aware
 adjustments and profile-based lens corrections
are our favorites among the program’s new
time- and energy-saving tools. (keh)c
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Both Photoshop und ACR tend to chop the
tops off buildings if you use the Auto Scale

Image option in the Lens Correction tool
(see the detail image below right). To work

around this problem, uncheck the option,
select a lower scaling factor in the Custom

tab, and crop your image manually.

CS5’s improved tone-mapping dialog
now includes all the most important

HDR tools and settings. It is great 
to be able to use anchor points to

create “Corners” in the tone curve.



Photoshop Elements 8 can do much more than you think.
There are many ways to enhance its functionality, whether you
want to use layers, 16-bit processing, or additional plug-ins.
And all these extras are free!

Klaus Gölker, Jobst-H. Kehrhahn 

More Photoshop for Your

Elements
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Many digital photographers start their image
processing career using Photoshop Elements.
Photoshop’s inexpensive little brother offers
well-rounded, basic functionality for retou-
ching digital images and scans. 

However, the differences between the
two programs become increasingly obvious
the more experience you gain. Many retou-
ching functions can only be effectively ap-
plied using layers and layer masks. 

For more information on this topic see
also the How Layers Work section below and
the Elements 8 video tutorial included on this
issue’s free DVD.

The problem is that Elements cannot
 create layer masks on regular pixel layers the
way Photoshop can. However, masks are still
part of the Elements adjustment layer
functionality that you can use to make non-
destructive changes to image color and hue.
This makes it possible to use adjustments
layers and clipping masks to work around
the inherent limitations of Elements and to
combine them so that they behave just like a
Photoshop layer with its associated layer
mask.

Tip #1: Clipping Masks and
Adjustment Layers
This trick involves turning an adjustment
layer into the base layer of a clipping mask.
First, place your adjustment layer on top 
of the layer stack so that it influences all 
the layers below it. To change the effect
hierarchy, you can place the layer you want
your mask to influence above the adjust-
ment layer and create a clipping mask for it
by pressing Ctrl+G, which converts the
 adjustment layer into the base layer and
 determines which parts of the image layer
above “show through”. The following steps
describe how to apply the procedure to a
fill layer:

Step 1: Create a mask

– Open an 8-bit image file
– Create a copy of the background layer using

Ctrl+J or the Duplicate Layer command in
the context menu

– Create a fill layer (Layer > New Fill Layer >
Solid color)

– Click on Layer 1 (the new copy of the back-
ground) to activate it

– Shift-Ctrl (or Layer > Arrange > Bring to
Front) moves Layer 1 to the top of the layer
stack

– Use Ctrl+G (or Layer > Create Clipping Mask)
to create a new clipping mask for Layer 1

Step 2: Apply an effect

The clipping mask doesn’t yet affect the
image because the background layer and
Layer 1 are still identical. This is how to apply
an effect to clean up the skin tones in a
 portrait:
– Click on Layer 1 to activate the clipping

mask
– Because the Color Fill 1 layer is currently

white, the entire image appears in 
soft focus when you apply Filter > Blur >
Gaussian Blur

Step 3: Restrict the effect

– Click on the Color Fill 1 layer mask
thumbnail to activate it

– Use Ctrl+I to invert the mask. The previous-
ly white mask is now black, allowing the
original background image to show
through without the soft focus effect

– Select a white or gray brush and “paint” the
portions of the image that you want to
 appear softer. Only the non-black, masked
parts of the original image now show
through.

Get the Most from Elements
Many Photoshop Elements users have, at one time or another, considered
upgrading to a “proper” version of Photoshop. Two things make the move
less attractive: the first is the high price, and the second is the fact that a
number of important Photoshop features are now available for Elements.

Get the Most from Elements 111

SmartCurve and Elements+ 115

More Elements Plug-ins 118

Contents
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Tip #2: Cut & Paste a Dummy
Layer Mask

Photoshop Elements generally loads PSD files
without complaint, even if they contain ele-
ments that the program doesn’t support. 

The same is true for layer masks: if you
save a PSD file to include an empty layer with
a linked layer mask, Elements displays the
layer thumbnail and the link.

Step 1: Create a layer mask

– Open an 8-bit image and the layer_mask.psd
file

– Position the two images next to each other
(Window > Arrange > Tile) and click the PSD
file to activate it

– Drag the layer thumbnail to the image you
want to process, creating an empty layer
 linked to the layer mask

A layered image is constructed in a similar
way to old-fashioned stop-frame animations.
First, a background layer is drawn and  sub -
sequent layers are superimposed on the
background by drawing on transparent cels,
called “Layers” in the Adobe world. 

In an image processing context, “alpha-
channel transparency” ensures that image
layers can possess different degrees of opaci-
ty. Image layers remain separate and can be
individually processed using the Layers
panel (accessible via the Window menu). 

Elements saves multi-layered images in PSD
or TIFF formats. The Layers panel usually
opens automatically when the program
starts. 

The main advantages of working with layers
are:

– Multiple layers can be combined to form a
single image

– Layers can be partially transparent, allo-
wing you to cover or uncover selected
image elements. Transparent elements
have a gray checked background to help
you remember which they are.

– Layers can be independently positioned
on the image canvas

– Layers are freely scalable and transform -
able

– Layers can be linked, producing combined
images which can then be processed as a

unit. Linked layers can be unlinked and
processed individually at any stage.

– The order of layers in a layer stack can be
altered at will, allowing the user to deter-
mine which elements of an image cover
which others.

– Layer opacity is adjustable

– Layers can be duplicated at will

– Individual layers and combinations of layers
can be imported from other images

– Layer blending modes allow you to apply a
range of different color and light effects to
an image

Image data is always associated with a
 specific layer, but selections are not. This
 means that you can save selections and apply
them to other layers or images—for example,
to mask specific image elements. A layer has
to be active in order for a selection to be
 applied to it.

How Layers Work

The individual layers in an image:
1. Airplane 
2. Shadow
3. Hangar
4. Show-through layer with reflection effect
5. Background landscape The resulting image and its corresponding layers in the Layers panel
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Step 2: Fill the empty layer

– Activate the background layer
– Use Ctrl+A, Ctrl+C, or Select All; followed by

Edit > Copy to copy the background layer
– Click the chain icon to unlink the empty

layer and the layer mask
– Activate the unlinked, empty layer
– Use Ctrl+V to paste the copied background

layer into the empty layer
– Click between the layer and the layer mask

thumbnails to re-link them
– Use Ctrl+V to paste the background layer

Step 3: Apply and limit an
effect

Effects such as a soft focus filter are first ap-
plied to the image layer. You can then limit
the effects of the filter by painting the areas
you want to leave intact (here, the area
around the subject’s eyes) into a black fore-
ground layer. You can also invert the layer
mask using Ctrl+I and paint the areas you
want to adjust white or gray.

Adjustment layers are a mechanism that you
can use to select specific areas within an
image and apply a correction to them wit-
hout permanently altering the image, the
layer, or the selection. Adjustment layers
apply corrections to a separate, newly crea-
ted layer that is located above the layer you
want to adjust. The correction itself is su-
perimposed on the image, leaving the ori-
ginal image data untouched. This also me-
ans that you can undo any changes you
make at any stage. If you delete an adjust-

ment layer, your image will appear exactly
as before. An additional advantage of ad-
justment layers is that the correction itself
can also be fine-tuned. Layer masks are used
to exclude selected image areas from the
current adjustment without actually dele-
ting the pixels concerned.

Layer masks can be colored black to mask or
white to unmask selected pixels. Gray masks
partially mask the selected areas, but allow
the selected pixels to “show through” to the
image layer. Deleting or hiding a layer mask
makes all image pixels visible.

Layer mask functionality is available in Pho-
toshop Elements in the form of clipping lay-
ers or using the Elements+ plug-in. Some
tools, such as Smart Brush or Photomerge,
use internally generated layer masks to
achieve their effects. 

Because they don’t affect the original image
data, image adjustments performed using
adjustment layers are termed “non-de-
structive”. Elements is designed to make di-
rect adjustments that alter the image data
immediately when a correction is applied.
This “destructive” editing is not a problem as
long as you have a specific idea of how you
want your finished image to look. If your
changes don’t turn out the way you ex-
pected, the program allows you to undo in-
dividual steps and recall earlier image states
during a single session.

Adjustment layers and layer masks can also
be combined. The effect applied using an
adjustment layer can be adjusted by double-
clicking the layer’s thumbnail in the Layers

panel, while the layer mask acts like a se-
lection, limiting the area to which the effect
is applied. If you no longer want to apply the
change made by an adjustment layer, you
can hide the layer by clicking on the eye
icon at the left of the appropriate entry in
the Layers panel, or simply delete it. To save
adjustment layers and layer masks with an
image file, save them to PSD format. Saving
to other formats interpolates the changes
you have made into the image data, altering
it permanently.

How Adjustment Layers and Layer Masks Work

The adjustment layer menu in the Elements
Layers panel

The Layers panel, showing an adjustment
layer and the layer mask created
automatically by applying a Smart Brush
adjustment. The mask is superimposed 
on the image background and alters its
appearance without altering the image
data.
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Tip #3: Using Layers with 16-bit
Image Files

Photoshop Elements has only a few tools that
support 16-bit processing, and Layers
functionality appears to be switched off in
16-bit mode. For example, if you import a 16-
bit image using Adobe Camera Raw, the Du-
plicate Layer option is grayed out. Ctrl+J or
right-clicking the background layer does not
have any discernible effect either. But there is
a workaround:

Step 1: Create a new layer

If you use the Move tool and the Alt key si-
multaneously to shift your 16-bit image up-
ward, Elements creates a copy of the back-
ground layer in which the content is shifted
slightly out of frame.

Step 2: Align your image

To “un-shift” the background copy, activate
it and switch to Difference blending mode
in the menu at the top left corner of the
 Layers panel. You can now shift the copy
layer until it exactly covers the original
 background layer. The image preview will
then appear black. Now switch back to
 Normal blending mode to show your original
image.

Step 3: Process your image

Unfortunately, most of the tools that you
can use in 8-bit mode, including the brush
tools that are so important to the masking
process, are still not activated. It is also im-
possible to open 16-bit files that already
contain layers and adjustments. The tools
that do work are:

– Clipping masks (Ctrl+G)
– Rectangular Marquee
– Lasso, Magnetic Lasso, and Polygonal Lasso
– Quick Selection tool
– Most noise reduction, blur, and adjustment

filters
– Many commands in the Edit menu, inclu-

ding the Transform command, which is
useful for eliminating converging lines in
architectural photos

Instead of masking specific image areas using
a brush, you can use the Lasso and Fill tools
to make selections.
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If you use the normal Ctrl+C and Ctrl+V
commands to cut and paste image con-
tent in 16-bit mode, Elements requires you
to first convert your image to an 8-bit for-
mat. However, if you use Shift+Ctrl+V (or
Edit > Paste in Place) the program pastes
perfectly, even if you are copying content
from other 16-bit images.

How to Cut & Paste
in 16-bit Mode

Advanced tools like Elements+ or Smart-
Curve bring Elements functionality much
closer to the level offered by Photoshop,
although fundamental differences do re-
main. If you are no longer satisfied with
the Elements toolset and you are in full-
time education, either as a teacher or stu-
dent, you might qualify for an educational
license, which saves up to 80% on the
purchase price of a full Photoshop or Crea-
tive Suite license. Further details are avai-
lable at http://www.adobe.com/educati-
on/purchasing/qualify.html.

Educational
Discounts



Elements doesn’t include the familiar Photo-
shop Curves functionality, but does have its
own Enhance > Adjust Color > Adjust Color
Curves command. This command adjusts the
tone curve using sliders, but has no anchor
point functionality.

SmartCurve

This free plug-in, which is included on this is-
sue's free DVD, is simple to install. Unpack the
zipped file and copy it to the C:\Program
Files\Adobe\ Photoshop Elements 8.0\Plug-Ins
folder. SmartCurve is then available in the Fil-
ter menu under easy.Filter > SmartCurve
when you restart the program.

SmartCurve functionality is not available
as an adjustment layer, but this limitation is
simple to work around. Simply create a layer
mask as described above and edit the image
layer in the clipping mask using SmartCurve.
Use a white brush to de-mask the image
areas that you want to adjust. If you want to

brighten the whole image, all you have to do
is copy the background layer and brighten it
using SmartCurve.

SmartCurve also includes support for the
CMYK, L*a*b*, and HSB/HSV color spaces. The
L*a*b* model is perfect for brightening
images: simply selecting the Luminance color
channel applies all SmartCurve adjustments
to the luminance channel only.

Elements+

This Windows and Mac plug-in (more infor-
mation can be found at http://elementsplus.
net) includes a wide range of enhancements.
The extended demo version includes:
– Channel Mixer: a flexible tool for adjusting

colors and creating monochrome image
versions

– Curves: a powerful tool for adjusting
brightness, contrast, and color for a single
tonal range or combinations of tonal
 ranges.

– Layer Masks: Elements+ allows you to crea-
te, delete, and edit layer masks just like
Photoshop does, giving you full non-de-
structive editing functionality.

The demo version’s tools are divided into
four different categories:

Color & Tone: in addition to
the Curves and Channel
mixer functionality included
in the demo version, the full
version also includes tools

called Exposure, for performing fine adjust-
ments to brightness and contrast, and Vi-
brance, for adjusting the intensity and con-
trast of individual colors. The Black and White
Layer option can be used either to convert
color images to monochrome or to give them
an individual tint.

Selections: these options
allow you to switch between
selection and masking
modes, making selection and
editing of complex objects in

Elements much easier. Masking mode uses
brush tools to make corrections, and gives
you direct access to alpha channels, which
are here used as masking channels.

Masks: creates layer masks
with a range of editing opti-
ons that include vector and
filter mask functionality.

Scripts: includes various
scripts and function calls. The
Batch tool offers similar
functionality to the Photoshop
batch tools, although the

demo version doesn’t include as many opti-
ons as the full version.

The full version of Elements+, which costs
the princely sum of US$12, includes four
 further sets of tools:

Layers: functionality for
layer grouping and conver -
sion to Smart Objects, which
are extremely useful if you
want to edit objects and

images using multiple Adobe programs.
Smart functionality is also the basis for 
the application of Smart Filters, which allow
you to fine-tune or delete your corrections
after you have applied them. Elements+ 
has its own separate set of Smart Filter 
tools. You can also apply layer styles, such as
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SmartCurve and Elements+
These two plug-ins help to work around a number of Elements limitations:
SmartCurve implements full-featured tone curve functionality and
Elements+ enhances the basic Elements functionality to include a raft of
features that are normally only available in full Photoshop versions.
SmartCurve is included on this issue’s free DVD.

The free SmartCurve plug-in includes fully functional tone curves functionality for 8-bit
and 16-bit image files



drop  shadows or bevels, to individual
 layers—functionality that is otherwise only
available in the Elements Effects panel.

Smart Filters: the effects
produced by Smart Filters
are not resampled into the
original image data and can
be adjusted after they have

been applied.

Paths: this tool enhances the
Custom Shape tool, allowing
you to create and edit paths
in selections, text layers,
shape layers, or vector masks.

Paths are vector shapes that can be transfor-
med and filled. In contrast to selections, they
are independent, editable shapes and can be
selectively edited. You can move and positi-
on them at will using the shape tools, and
you can transform, scale, or distort them

using the tools found in the Image > Shape
menu. We would also like to see a Path tool
for creating custom shapes, but this is not yet
included in the Elements+ toolset.

Text: is a great enhancement
to the standard Elements text
tool and allows you, amongst
other things, to create text
that follows a curved path.

You can also adjust the width and height of
text without changing the size of the typefa-
ce—just like Photoshop—and fine-tune the
distance between individual letters.

Setting up Elements+

Once Elements+ is installed, you can find it in
the Effects panel in Full Edit mode. Select
Photo Effects and click the Elements+ menu
item. The Elements+ toolset icons will now
appear in the Effects panel. 

The default language is English. The Favo-
rites option in the Scripts window contains an
item called E+ Options, which you can dou-
ble-click to select language and appearance
options. 

Elements+ is controlled exclusively via the
Effects panel and does not add any tools or
menus to the Elements interface.Elements+ enhances the standard Elements Curves functionality

The built-in Elements
Curves functionality
(Enhance > Adjust Colors
> Adjust Color Curves)
includes several preset
styles. These are easier to
apply than Photoshop
curves, but are less user-
definable.

Photoshop Elements 8 | SmartCurve and Elements+
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16-bit processing with
Elements+

Elements+ supports 16-bit processing, but
only if you load an 8-bit image simultaneous-
ly with the 16-bit image you want to process.
You can then use the Elements+ Switcher,
which is found in the Files entry in the Scripts
menu, to switch between the 8-bit and 16-bit
images and make adjustments to both. The
necessary steps are as follows:
– Load an 8-bit image using Ctrl+N
– Open the 16-bit image you want to process
– Create a 16-bit layer as described above

(i.e., by moving the background layer while
pressing the Alt key)

– Select the 8-bit image and activate a layer
– Select the Elements+ Switcher and click the

Files entry in the drop-down menu. This
lists all open images. Select your 16-bit
image.

– Select the Masks toolset and click the
round green button at top left

– Elements+ will open a second window that
includes the Show All (white mask) and
Hide All (black mask) options. Select Hide
All.

You can now begin editing your image. Here
are the steps involved in smoothing skin tex-
ture in a portrait:
– Activate your 16-bit image
– Select the Background Copy thumbnail in

the Layers panel
– Apply the Filter > Noise filters > Median fil-

ter. The image appears not to change due
to the active black mask.

– Select the area you want to edit using the
Lasso

– Select the layer mask thumbnail
– Apply Edit > Fill Selection. Here, the fore-

ground color determines how strongly the
applied Median effect shows through. If
you don’t want to fine-tune the effect, sim-
ply invert the mask using Ctrl+I.

– Repeat the above steps for all critical image
areas until you are satisfied with the results

Who needs Elements+?

Elements+ goes a long way toward making
Elements as versatile as Photoshop at a fracti-
on of the price. Elements+ has slightly “wob-
bly” handling and its interface is not as
smooth as Photoshop, making it less suitable
for use with complex projects. The plug-in is
squarely aimed at enthusiasts and semi-pro-
fessional users who are generally happy
with the level of functionality offered by
Photoshop Elements, but who now and again
require extra tools or enhanced functionali-
ty.
Elements+ also has a couple of weak points.
The Exposure and Vibrance sliders stick to
the cursor as soon as you apply a correction.
Any adjustment layers you create using Ele-
ments+ cannot be subsequently fine-tuned,
as Elements itself interprets these as origina-
ting in Photoshop. To alter an adjustment
layer, you have to delete it and duplicate
your desired effects in a new layer.

16-bit Image: We wanted to smooth
the skin texture for selected parts of
the face in this image. Because brushes
are not active in 16-bit mode, we used
the lasso to make our selection.

8-bit Image: Elements cannot run scripts in 16-bit
mode, so we opened and activated a second, 8-bit
image, giving Elements internal access to our 16-bit
image.

Elements+ Scripts: The
Switcher, which is used for
creating 16-bit masks, can be
found in the Elements+
Scripts toolset.

Layer Masks:
The image areas that are not
masked in black allow effects
applied to the linked layer to
shine through.

Layer Thumbnail: We
edited this image using
the Gaussian Blur filter.

Switcher Window: Open documents are listed on
the left. This is also where you can switch between
the active 8-bit and 16-bit images.

Elements+ includes tools that allow you to
create and edit masks for 16-bit images

Photoshop Elements 8 | SmartCurve and Elements+
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virtualPhotographer by OptikVerve Labs
(www.optikvervelabs.com, Windows only) is
designed to boost the brightness, color, and
contrast adjustments included in the Ele-
ments Enhance menu. The tool includes
more than 50 one-click and adjustable filters
for applying soft focus, high-contrast, or
black-and-white effects to your images. This
is a versatile tool for giving your images a po-
lished finish.

AAA Options (8bf.net, Windows only) is a
collection of free filters with its own interface
window. The Fix tab includes color, focus,
and exposure adjustment options that allow
you to make selective corrections similar to
the ones you can apply using the Photoshop
color balance tools. The Filter tab offers vario-
us ways to produce grain and posterization
effects, while the Frame tab includes tools for
producing virtual frames. 

The Buzz tab includes options for smoot-
hing your images, and the Hue tab allows you
to adjust color and create duotone images.
The Blur tab produces amazing effects based
on layer modes and a Gaussian Blur tool. The
Simplify tool transforms images to look as if
they were painted or drawn. The Median fea-
ture includes radius, opacity, and a range of
blend mode settings.

Cybia Software (www.cybia.co.uk) manu-
factures commercial plug-ins for Photoshop,
Adobe Premiere, Bryce, Poser, and others pro-
grams. The company’s The Works package is a
collection of 8 freeware filter sets that includes
the ColourWorks plug-in, which modifies
image color values in different ways, from
subtle corrections to dramatic artistic transfor-
mations. The individual settings are all user-
adjustable. The Inverse filter allows you to in-
vert the colors of scanned color negatives—a
function that is not included in the Elements
menus, but that you can apply using the Ctrl-I
keystroke.

The following is a list of the freeware filters
included with The Works:
–ˇColourWorks is described above.
–ˇEdgeWorks creates dramatic edge and color

modifications and produces intense, highly
stylized photo transformations. This tool is
also useful for creating texture effects.

–ˇScreenWorks provides you with a quick
and easy way to add detailed or repeated
texture overlay effects to selected image
areas. Simply add the pattern to your
image layer, or color the layer background
white.

–ˇEmbossWorks gives you a choice of quick
and easy embossing styles. These are great

for adding a sense of depth to otherwise
flat-looking images.

–ˇSwapShop switches image color values,
and is great for experimenting with surreal
or artistic styles.

–ˇMasterBlaster is a simple effect for "blas-
ting" intense color into your images. It is
ideal if you need to add dramatic impact to
your work, or if you just want to give an
image a strong overall color cast.

–ˇMezzy allows you to create various grain
and mezzotint effects.

Cybia also manufactures the free Fotomatic
collection of eight plug-in filters for use with
Photoshop or other compatible host applica-
tions. These include a series of effects based
on traditional photographic equipment and
techniques. Cybia is also the maker of Image
Inc., a standalone freeware program desig-
ned for quick and easy image blending.

More Photoshop Elements
Plug-ins
In addition to Elements+ and SmartCurve, there are many other great free and
commercial plug-ins available to help you get better results with Photoshop
Elements. The following sections describe some of our favorites—the ones
printed in bold type are included on this issue’s free DVD.

AAA Options makes Photoshop-style color adjustments possible in Photoshop Elements

The virtualPhotographer program window showing the settings we used
to apply a color gradient to the sky in this photo
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Rather than extending the Elements tool-
set, some plug-ins simply produce better
 results than the program’s own tools. The
Elements Magic Extractor tool is very good at
selecting high-contrast objects with well-de-
fined edges, but is less effective when it
comes to selecting fine details, such as a por-
trait subject’s hair. The freeware GML Mat-
ting plug-in, produced by a team of graphics
students at the University of Moscow, produ-
ces much more detailed and consistent re-
sults. The tool’s interface is easy to learn and
includes comprehensive tooltips, making it
relatively simple to master complex selecti-

ons. The software is available (for Windows
only) at graphics.cs.msu.ru/ru/science/re-
search/imageprocessing/matting.

One example of the many free noise re-
duction plug-ins that are available is the Hi
ISO Noise Reduction filter by Alexander Be-
lousov (www.unicontel.com, for Windows
and Mac). The plug-in is simple to use and
has a limited range of settings, making it
ideal for image processing beginners. The
tool de-noised our test image extremely ef-
fectively without producing the softening
and graying effects that the Elements Reduce
Noise filter often produces.

Red Paw Media (www.redpawmedia.com)
offers a range of free plug-ins for Windows
and Mac, including Hot Pixel Noise Remover.
This is useful for selectively removing the
over-bright pixels that often result from
 shooting with long shutter speeds or high ISO
values.

There are many sharpening plug-ins avai-
lable, including High Pass Sharpening, which
is available from www.photo-plugins.com.
This plug-in works in a similar way to the Ele-
ments Adjust Sharpness tool, but its Hard
Light and Overlay settings produce very dif-
ferent results.

Photoshop Elements offers only the High-
light Skin Tones option and a number of Blur
tools for improving portraits. virtualPhoto-
grapher is a free alternative for producing
soft focus effects. Porcelain, SuperSmooth, Im-
prover, and Radiance are other free plug-ins
for retouching skin blemishes and producing
soft focus effects.

Xero Graphics (www.xero-graphics.co.uk/
freeware.htm, Windows only) also offers a fil-
ter called Clarity that emphasizes image de-
tails in a similar way to the Clarity filter in the
Elements Camera Raw editor. This is just one
of the interesting freeware plug-ins included
in the Xero collection.

You can produce effects similar to 
the ones produced by Xero’s plug-ins 
using the Red Paw Media Beautifyer (www.
redpawmedia.com). Face Control by Redfield
(www.redfieldplugins.com) uses a single slider
to gently adjust facial expres sions—for exam-
ple, to make faces appear younger. The
Photoshop Liquify filter offers similar, but less
radical ways to make a  subject’s lips appear

Extracting a portrait: The original image is
on the left. The selection produced by GML
Matting can be seen on the right

Inverting a scanned color negative using the ColourWorks Inverse tool



fuller or her eyes larger. The plug-in is availa-
ble for free download along with other filters,
including Water Ripples, which produces
more realistic-looking results than the Ele-
ments Ripple  filter.

The freeware Dreamy Photo filter by Auto
FX Software (www.autofx.com) is available as
a plug-in and as a standalone program, and
produces dream-like ghosting, soft focus, and
zoom effects.

Luce by Antonino Perricone blends virtual
radial or directional light sources into your
images (amicoperry.altervista.org/luce/index.
html).

Flaming Pear (www.flamingpear.com)
 manufactures commercial plug-ins for
 Windows and Mac systems, but also 
offers a range of free plug-ins, including
Ornament, ChromaSolarize, Tachyon, 
Ghost,  Solidify, Vitriol, RGB/HSL, Circle 
to Square, and Make Cube Tile. These
 simple slider-based and one-click tools
make it quick and easy to create interesting
and  unusual distortion, black-and-white,
and color effects. 
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Harry’s Filters offer a wide range
of image adjustment options

Reducing color noise with the 
Hi ISO Noise Reduction filter

The Porcelain filter allows you
to produce soft focus effects
and to make skin tones more
radiant
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The ZIP file on this issue’s DVD includes
32-bit and 64-bit versions of the plug-ins, so
be careful to copy the correct version to your
Elements Plug-ins folder.

Harry’s Filters is one of the best-known
collections of free distortion, color adjust-
ment and patterning plug-ins for Windows
and Mac. They can be found, along with
many other freeware and shareware offe-
rings, at www.thepluginsite.com.

Sinedots II by Philipp Spöth (www.philipp-
spoeth.de, Windows only) produces graphic
effects that are similar to the abstract screen-
savers included with some operating systems.

3D Shadow, by Lokas Software produces
3D shadows with correct perspective for

 objects and type (www.artistic-effects.com/3d-
shadow, Windows only).

Most of the filters we have mentioned are
available for download as zipped 8bf files.
8bf is the native Photoshop and Photoshop
Elements plug-in format. Once you have
 unzipped a file, all you have to do is copy it
to your Adobe program’s Plug-ins folder and
restart the application. You can also copy
 folders containing multiple filters to the
Adobe Plug-ins folder. The Windows path is 
C:\Program Files\Adobe\Photoshop Elements
8.0\Plug-Ins, and the Mac equivalent is [Local
Disk]://Programs/Adobe Photoshop Elements
8/Plug-Ins. ABR brush sets have to be copied
separately to the Presets/Brushes folder.

 Larger collections of filters are often supplied
as executable program files which include a
choice of target applications.

If you want to try out some of these  filters
you will need patience, as it can be tricky to
find the settings that best suit your images
and your personal work style. Many filters
produce widely differing results when they
are applied to different images, even if 
you use the same settings. Among the
 commercial plug-ins available from some of
the better-known software Manufacturers
are the Knockout masking and selection tool
and the KPT Effects filter collection by Corel,
as well as other plug-ins manufactured by
Akvis, Nik, or OnOne Software. Topaz Labs 
is a relatively new player in this arena. 
All of the manufacturers mentioned offers
Windows and Mac versions of their products
and serve the professional graphics market
and other high-end users who are not
 satisfied with options offered by the built-in
Photoshop toolset.

There are also professional-grade noise
 reduction, sharpening, exposure correction,
black-and-white, and scaling plug-ins avail -
able. These can, however, cost as much as
US$300, and raise the question of whether it
is worth spending more on a plug-in than on
your image processing program.

The Russian/Canadian Akvis company
 offers its products with deep discounts for
non-commercial users, and Topaz Labs’
 products are reasonably priced at between
US$30 and US$80. Older versions of the
Corel Knockout and KPT tools are available
more cheaply in bundles such as the
Photoshop Powerpills published by Franzis in
Germany (www.franzis.de).

Many plug-in manufacturers offer bundles
that are cheaper than the individual plug-ins
they contain and all manufacturers (with the
exception of Corel) offer free trial versions of
their software for download. Most manu-
facturers also offer video tutorials with useful
tips on how to use their products. These
 tutorials can also help you to decide whether
a particular plug-in is right for you before
 making a purchase. (keh)

Sinedots is great for producing 
graphic image backgrounds c

Luce helps you to add subtle 
lighting effects to your images
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Build Your ownLEDMini-Studio

LED flashlights are the best choice if you want to set up a flexible and reasonably
priced tabletop photo studio. They don’t need cords, they don’t radiate heat, and
they are bright, easy to use, and affordable. Our examples show you how to light
tricky subjects and create professional-looking photos. One typical application for
LED studio lighting is shooting images for use in online auctions.



You know the feeling—that gem has
been lingering unused in the basement

for ages and now you want to auction it off
online and make some money out of it. So
you grab the digital camera, pop up the built-
in flash and snap away. The resulting pictures
are disappointing, to say the least, which
means the auction probably will be too. At-
tractive pictures can catch the attention of
prospective purchasers, so they have to be
photographed as professionally as possible.

How are really good product photos
taken? Well, avoid using the flash from the
front as it leads to flat-looking, passport-like
images. Only an independent source of light
located separately from the camera, can
make the most of the three-dimensionality of
a subject and reproduce the texture of the
materials it is made of. 

The pros use flash equipment and various
light shapers to get excellent results, but for
financial reasons, amateurs usually have to

make do with a shoe-mount flash, which
lacks a modeling light to control the place-
ment of the light source. Construction site
lamps, which are popular and cheap, could
be a good alternative. However, you can only
control the light they produce to a limited ex-
tent, and they aren’t very energy efficient.
Moreover, much of the energy is converted
into heat, and it is dangerous to use hot
lighting equipment in a setting with flamma-
ble material. 
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LED flashlights are very bright, run
efficiently for a long time on one 

battery charge, and do not get hot—a
combination of features that makes 

them very attractive as a light source 
for your home mini-studio. The flashlights
we chose from the wide range offered by

LED Lenser are, from left to right: 
the X21, with automobile 

headlight brightness (US$299.95), 
the easy-to-handle P17 (US$109.00), 

the P14 (US$75.00)ˇ
and the compact P7 (US$89.00).

A light-emitting diode (LED) does not emit white
light, but radiates in a comparatively narrow
 wavelength range of 10 to 20 nanometers. In
 layperson’s terms, the light of the LED appears to
be of a single color, whereas the spectrum visible
to humans ranges between 430 nm (blue) and
670nm (red).

There are several different ways of producing
white LED light. In the LED flashlights used here,
the LEDs are blue and are covered by a fluorescent
coating. The blue-violet light of the LED transforms
the coating into a broad spectrum that comprises

the entire visible range with a maximum of 580 to
600 nm. When the flashlight is switched off, their
yellow layer makes these pseudo white LEDs easily
identifiable.

Cree Inc manufactures the LEDs used in LED Lenser
flashlights. The fluorescent layer consists of a yttri-
um aluminum garnet (Y3Al5O12), which you may
already have heard of in connection with YAG, the
laser technology of the same name, and which ab-
sorbs most of the blue light and emits it as a pho-
ton with less energy – in other words, with a larger
wavelength. Physicists call this effect Stokes shift.

The spectrum deviates from that of a light bulb.
There is a 450nm peak, followed by a local trough
and the broad-spectrum light of the YAG layer. De-
pending on the layer, the light appears blue, white
or warm white. With the flashlights we used, the
color temperature is between about 6000 and
8000 K. The LEDs’ color-rendering index (CRI)
 reaches 70 to 90 (compared to 100 for a light bulb).
However, in a photographic context, the charac -
teristics of the LED spectrum are more important
than the color temperature, which can be easily
corrected edited later during image processing. A
color surface that has many color components
around 450 nm appears very bright. Blue color sur-
faces around 480 nm, where the local trough lies,
appear darker than they do under ideal lighting. 

The combination of a blue LED and a YAG layer for
white light is especially favorable, because blue
LEDs have the highest light yield and because one
layer is enough to obtain white light. Other
 methods of creating white light consist of several
of these layers or of luminous, closely-spaced, red,
blue and green LEDs. The efficiency of the LEDS
built into the flashlights is about 13 percent, which
is clearly lower than a non-coated LED. Neverthe-
less, an LED in a battery-powered flashlight is
 extremely bright, at approximately 200 lumens.

Creating White Light using Blue LEDs

The 450nm peak of the blue
LED is clearly visible in the
spectrum of the light emitted
from the flashlight. It is over -
layed by the light emission of
the YAG layer, which coats 
the LED and absorbs much of
the blue light.



In any case, construction site lamps are far
from ideal for quickly setting up and dismant-
ling a home photo studio. They are not easy
to handle and positioning them can be quite
a fuss.

LED lamps: an alternative

In the search for the ideal light source for a
do-it-yourself mini-studio, the decision fell on
LED flashlights, which have become a popu-
lar choice now that they are affordable. As
LEDs do not radiate heat, they are very versa-
tile. They have enabled flashlights to reach a
luminous flux of a couple hundred lumens. 

Dealing with multiple sockets and wires
has become a thing of the past, so the mini-
studio can now easily be set up taken down
in different locations. LED flashlights can take
rough treatment and can even survive being
dropped. In comparison to mobile flash units,
LED flashlights allow better light adjustment,
so you don’t have to take endless flash shots
until you get your lighting right.

There are also LED lights with power
 cables. They cost less than heavy duty flash-
lights but are not as flexible in their use and,
in particular, don’t have the focusing mecha-
nism that is already integrated in the flash-
lights we have described here. Online dis-
count stores stock a range of flashlights,
from small ones that cost only a few dollars
but are not bright enough for our purposes
to ones that are 40 cm long and as bright as
car headlights.

For the photographs taken here we used
flashlights from LED Lenser (www.zweibrueder.

com). The somewhat large and unwieldy top
model X21 (for about US$299.95) can bring
on an illumination power of 1070 lumens,
which is almost as bright as a car headlight.
We used the cheaper P17 (195 lumens, at
about US$109.00) and P14 (210 lumens, at
about US$99.00) for our homemade photo
studio. The flashlight’s operating time is
 several hours; the operating time of more
than 100 hours stated by the manufacturer
refers to the first of several levels of bright-
ness. The smaller models fit into any jacket
pocket and are perfect for travel. We also used

the even smaller P7 for US$89.00 (200 lumens).
No matter which flashlight you choose, it
should have a variable light beam. 

These flashlights can produce illumination
with an intensity of between 400 and 800 lux
for a surface are of half a square meter. The
 illuminance drops considerably when it is
 reflected by light shapers. When 200-lumen
flashlights are used, the exposure times for
digital SLR cameras usually make it necessary
to use a tripod.

With the heavyweight X21 and its 1070
 lumens, no tripod is required. The hand-held
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A normal camera tripod came in handy for
larger objects

Retailers offer LED table lamps with a prac -
tical flexible neck. A pleasant back ground
light can be created with yellow card.

We used zip ties to fix the flashlight to a
mini tripod for our tabletop photo studio

Even the little P7 (at the bottom) can
be used as a mini-studio light source.
Its advantages are its low weight of
200 g (including batteries) and compact
size. In comparison, the X21, which weighs 
5 lbs and is 16 inches long, needs a more
stable mount for this type of use.
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Two LED flashlights allow you to light the background and the object (the P14 and P17)
separately. The main light reflects off a Styrofoam board to light the vase indirectly.
The beam of the second flashlight focuses a soft cone of light in the background. 

The tabletop studio for minimalists: an LED flashlight (LED Lenser P7) zip tied to a mini tripod
and a painted stretch-mounted canvas as a background are sufficient for simple lighting tasks.



flashlight can be used as a supporting light
source in outdoor photography. It is of little
use in bright sunlight (up to 100 000 lm) but
comes in handy on dreary days (about 3000
lm).

The lights used here are made of blue
high-performance LEDs with a yellow fluores-
cent coating. This layer is clearly visible to the
naked eye so this LED type is easy to identify.
The resulting curve (see Creating White Light
using Blue LEDs above) has a blue/violet peak
and a broad frequency spectrum from
blue/green to deep red with a slump in the
blue part of the spectrum. The result of this
unusual spectrum is that the light produces
strong blue tones even though the light
 appears to be white.

The deep blue in the portrait (see photo
on page 143) is due to this special LED char -
acteristic. These LED lights are not suitable for
photo shoots that require exceptional color
fidelity, such as when photographing food
and textiles, or art reproductions. However,
we had no objections to the color rendering
for the objects we photographed here.

The LED light is dazzlingly white and dis-
plays a color temperature of 6000 to 8000 K.
The resulting minor color cast can be com-
pensated by the camera’s automatic white
balance or at the post-processing stage. A
yellowish surface or even a handkerchief
 reduces the color temperature by 1000 or
2000 K. In contrast, cheap flashlights that cost
only a few dollars emit blue rather than white

light. If you want to use them as background
light, you should think about using color gels,
which can be bought cheaply in retail photo-
graphy stores. Otherwise, try reflecting the
light off a suitably colored surface.

The flashlight’s strongly focused light pro-
duces hard-edged shadows when applied
 directly. At close subject distances, image ar-
tifacts from the camera’s lens system and
caused by the LED can appear on the object.
These irregularities are distracting, especially
in background lighting. A light diffuser in
front of the light, for example a layer of tissue
paper, can resolve the situation but please do
this only with LEDs, as tissues are easily flam-
mable and should not be used with lamps
that get hot.

Fixing and Background

Flashlights are lightweight, so small lamp-
stands or tripods are all that is required to
 position the lights. For a few dollars you can
find what you need at yard sales, photogra-
phy flea markets, and online auctions. The
best way to attach the lamp is to tie it to the

pan-tilt head of the tripod with zip ties. The
advantage of zip ties compared to duct tape
is that they can be quickly removed. 

Microphone stands with flexible necks are
very practical. A medium sized flashlight fits
into the microphone clamp. You can then
 adjust the light beam with the flexible neck. By
the way, you will also find that microphone
clamps can easily be attached to the screw
thread of a camera tripod with an adapter ring.

A paper roll serves as a backdrop for the
mini-studio. For small objects, an inexpensive
15-inch wide paper roll will do the trick. 
The roll of paper can be attached to the wall
and rolled down over a table. For the basic
tabletop studio we still need black and white
cardboard and a roll of aluminum foil to
make a light shaper. It helps to build multiple
reflectors and absorbers before you get
 started so you can concentrate fully on your
photography.

Pure Minimalism

We used a variety of objects to test the LED
lights for their suitability as a light source in
mini-studios. A small LED light is enough for
quick photographs, as the picture with the cat
statuette shows. All we needed for this setting
was the handy P7 zip tied to a mini tripod and
a painted canvas background (bought at a
discount shop for a few dollars). 

All is still a long way from professional
lighting, but it is certainly better than just
pressing the shutter button. The result is
 considerably better than using flash.

Classic Sculptural Lighting

Just two or three LED lights are necessary to
create simple professional lighting effects in
your own mini-studio. The brightest possible
LED light should be used as the key light,
which illuminates the object either indirectly
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The black amplifier case is illuminated well enough to make the glow of the valves
clearly visible

Sample Budget
LED Lenser P14 US$99.00
LED Lenser P7 US$89.00
Second-hand mini tabletop tripod (e.g., on eBay) US$30.00
Additional items (styrofoam board, card) US$20.00

Total US$238.00

Standard Equipment for 
a Mini-Studio

LED Lenser www.ledlenserusa.com Manufacturer with a large selection of its own lights
CFR Lights www.cfrlights.com Shop for Olight, Fenix, EagleTac and TerraLux
Optics Planet www.opticsplanet.net Reseller with a large selection from various manufacturers
Lohenstein www.lohenstein.de LED lights

MagLite www.maglite.com MagLite LED models

Manufacturers and Suppliers of LED Lights



via a Styrofoam reflector or through a diffuser
made of white cloth or a handkerchief. This
ensures that the key light highlights the
 contours of the photographed object.

The second, medium-bright light (100 to
200 lumens) brightens the background from
a distance with a soft beam, emphasizing the
subject’s outline against the background.
This light should not produce any additional
shadows on the object, because multiple
shadows from various lighting angles can
create unrest in the image. The LED light’s
angle and position should be modified until
the ideal illumination is found. The colorful
vase was photographed in such a setting.
The vase is well defined stands out clearly
from the background.

If the object has both black and shiny
 reflecting surfaces, you can manage with just
two flashlights if you arrange them skillfully,
as shown in the picture with the Lumix
 camera. A further light source is not required,
but can be very useful for additional effect
lighting or brightening dark image areas. 

For the illumination to be completely
free of shadows, the subject should be illu-
minated indirectly by several light sources
or reflectors from various directions. Each
light source outshines the shadow of its 
opposite light source. To take pictures of 
reflecting objects, it is advisable to make 
a light tent of white cloth. This is another 
situation where the low heat factor in LED
lights is a great advantage, as a pillowcase

or duvet cover makes a cost-effective light
tent.

Professional Lighting with 
Light and Shadow
In order to figure out how well a low budget
lighting system meets professional demands,
we set ourselves the task of photographing
the previously mentioned valve amplifier in-
cluding two loudspeakers. The subtle sheen
of the loudspeaker’s varnish and the surface
of the amplifier are challenging for a photo-
grapher because of the discrepancy between
highly reflective and light absorbing surfaces.
We also wanted to show the warm, satisfying
glow of the amplifier’s valves.
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A P17 LED light is enough to put
the Lumix camera in the right light,

producing the soft main light by
reflecting the light beam off the

Styrofoam board, while the
reflector made of aluminum foil

serves to highlight contours on the
right side of the camera



A flash is out of the question—it would
outshine the glowing of the coils in the
 valves. As if this weren’t difficult enough, we
added an iPhone with its display lit to the
 ensemble, with the aim of capturing it with -
out any reflections in the final image. 

The first lighting attempts using the LED
lights were not very satisfactory. Illuminating
the components produced bad results be-
cause of the hard light of the LEDs. The con-
trast range was too great and image details
were lost. Only reflecting the light indirectly
with a Styrofoam board below the amplifier
and a soft light beam in background created
a balanced and dimmed lighting situation.
The exposure time had to be extended
 accordingly so that the glowing coils would

become visible. We adjusted the brightness
of the iPhone display to the exposure time.
The results speak for themselves. 

Portrait Photography using 
LED Light
LED flashlights can be used in portrait photo-
graphy. Please follow the manufacturer’s
safety instructions and never shine the light
beam directly into your model’s eyes. We eit-
her directed the light beam through a thin
cloth or reflected the light indirectly via a
 Styrofoam board or umbrella reflector to
create a soft diffused light. 

The very bright X21, with almost 1000
 lumens, produces enough light to achieve

an acceptable shutter speed or ISO setting
using an indirect flash umbrella. The slightly
cool to neutral color temperature can be
neutralized either by using the camera’s
white balance control or later using a Raw
editor. 

Incidentally, the umbrella is ideal for
brightening portraits when outdoors, due to
the LED flashlight’s portability. Alternatively,
a golden umbrella can be used to achieve
better skin tones. 

Conclusion

Flashlights have only become bright enough
for use in mini-studios since highly efficient
LEDs were introduced. They encourage

128 c’t Digital Photography 1 (2010)

Our first attempt at direct illumination failed: the hard LED light burns out too many details, the iPhone’s display
is overexposed, and the glow of the valves on the amplifier is not visible

Balanced lighting that brings out all the details was achieved once we used indirect lighting through the
Styrofoam surfaces below the amplifier together with a soft light beam in the background 



 experimentation with lighting and reflectors
because they are focusable, very robust and
practical, and inexpensive. The basic equip-
ment for a studio, consisting of three LED
lights, two or three small tripods and material
such as Styrofoam and aluminum foil, will
cost you a little more than US$130. For a top
class set up with 1000 lumens you may have
to spend US$400 or more.

Depending on the purpose, you can find
cheaper, though less mobile, alternatives.
Foldable table-top studios including halogen
lights are available at around US$100. These
portable mini-studios have a comparable or
even higher level of illumination but are not
as flexible as our tripod-based set-up and can
also get very hot. LED flashlights are better
for experimenting.

There are pitfalls to watch out for because
of the special light characteristics of LEDs.
The white looking light is good enough for
producing acceptable colors; however, it fails
to render images with absolute color fidelity
throughout the entire visible spectrum. The

intensely focused light makes home-made
reflectors and gels essential. After the few at-
tempts you will quickly get a feel for how to
illuminate an object correctly, which we hope
will also be reflected in the results of your
 furutre online auctions. (jr)
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P7 P14 P17 X21
Focusable v v v v

Lightdiameter in 3 feet distance 4.7"–31.5" 3.9"–47.2" 5.9"–51.2" 7.1"– 295"
Number of LEDs 1 (Cree) 1 (Cree) 1 (Cree) 7 (Cree)
Lumens 200 lm 210 lm 195 lm 1070 lm
Batteries 4x AAA 4x AA 3x D 4x D
Lengh / Diameter 5.5"/1.4" 8.5"/1.8" 13"/2.1" 16"/3.6"
Weight (incl. batteries) 7 oz 13.8 oz 27.9 oz 4.8 lbs

Retail price US$89.00 US$99.00 US$109.00 US$299.95

LED Lenser LED Lights

A powerful LED light reflected off a Styro -
foam surface to the left in the picture. Light
diffused this way has similar characteristics
to light from a softbox, producing finely
differentiated tonal values.

A flash umbrella, a powerful LED flashlight
and a helping hand, since there wasn’t a
tripod at hand, are enough to illuminate a
portrait picture. The portrait clearly shows
the excessive blue caused by the pseudo-
white spectrum that characterizes LEDs.

c
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